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Software License Agreement 
This Software License Agreement ("License Agreement") is a legal agreement between you (either an individual or a single entity) 
and Serif (Europe) Ltd. ("Serif") for the accompanying software product, which includes computer software and may include 
associated media, printed materials, and "online" or electronic documentation (the "Software Product"). By installing, copying, or 
otherwise using the Software Product, you agree to be bound by the terms of this License Agreement. If you do not agree to the 
terms and conditions of this License Agreement, do not install or use the Software Product; you may, however, return it to your place 
of purchase for a full refund.  

THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS IMPORTANT THAT YOU (THE "LICENSEE") READ THIS 
NOTICE CAREFULLY. THESE ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTS WITH RESPECT TO THE 
SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT 
TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES. THE SOFTWARE PRODUCT IS LICENSED, NOT 
SOLD. 

1. GRANT OF LICENSE 

Serif hereby grants to Licensee a personal, non-exclusive, non-
transferable license (a "License") to use one (1) copy of the 
Software Product, including any updates thereto, and 
accompanying documentation, if any, provided by Serif, according 
to the terms set forth below. If the Software Product is being 
provided to Licensee as an update or upgrade to software which 
Licensee has previously licensed (such software referred to as the 
"Prior Software"), then Licensee agrees to destroy all copies of the 
Prior Software within thirty (30) days after opening this package 
except for one backup copy of the Prior Software. 

2. SCOPE OF USE 

You may install and use one copy of the Software Product, on a 
single computer. The primary user of the computer on which the 
Software Product is installed may make a second copy for his or 
her exclusive use on a portable computer. Licensee may also store 
or install a copy of the Software Product on a storage device, such 
as a network server, used only to install or run the Software 
Product on other computers over an internal network; however, 
you must acquire and dedicate a license for each separate 
computer on which the Software Product is installed or run from 
the storage device. A license for the Software Product may not be 
shared or used concurrently on different computers.  

3. LICENSE PAK 

If you have acquired this LICENSE AGREEMENT in a Serif License 
Pak, you may make the number of additional copies of the 
computer software portion of the Software Product as authorized in 
the Serif License Pak, and you may use each copy in the manner 
specified above. You are also entitled to make a corresponding 
number of secondary copies for portable computer use as specified 
above. 

4. PROHIBITIONS 

You may not: modify, prepare derivative works from, translate, 
reverse engineer, decompile, disassemble or otherwise derive 
source code from the Software Product (except to the extent that 
such acts are expressly permitted by applicable law 
notwithstanding this limitation); copy the Software Product (except 
as provided above) or the accompanying documentation; rent, 
transfer, disclose, make available or grant any rights in the 
Software Product (including any accompanying documentation) in 
any form to any person without the prior written consent of Serif; 
remove any proprietary notices, labels, or marks on the Software 
Product (including any accompanying documentation); use the 
Software Product in any manner that infringes the intellectual 
property or other rights of another party; or use the Software 
Product to provide on-line or other database services to any other 
person. 

5. RETENTION OF RIGHTS; TERMINATION 

This License Agreement does not constitute a sale. All title, trade 
secrets, copyrights, patents and other intellectual rights to the 
Software Product, its accompanying documentation and any copy 
made by Licensee remain with Serif, and Licensee hereby agrees to 
preserve and acknowledges the foregoing. Licensee further agrees 
and acknowledges that the Software Product and all copies thereof 
are Serif's exclusive property and constitute a valuable trade secret 
of Serif. Licensee further agrees and acknowledges that 
unauthorized copying of the Software Product or the accompanying 

documentation, or failure to comply with any of the provisions 
hereof (each, a "Terminable Event"), will result in automatic 
termination of this License. In the event of a violation of this 
License by Licensee, Serif reserves and shall have available all legal 
remedies. 

6. TERM OF LICENSE FOR TRIAL VERSION SOFTWARE 

The License pertaining to a trial version of the Software Product (a 
"Trial Version") shall expire in accordance with the terms as set 
forth in the installation process for the Trial Version along with the 
designated trial period as set forth in the trial program.  

7. LIMITED WARRANTY AND DISCLAIMER 

Serif warrants that, for a period of ninety (90) days after delivery, 
the diskettes or CD-ROMs on which the software included in the 
Software Product is furnished will, under normal use, be free from 
defects that prevent Licensee from loading the Software Product on 
a computer. Serif's entire liability and Licensee's exclusive remedy 
under this warranty will be, at Serif's option, to (a) use reasonable 
commercial efforts to attempt to correct or work around errors, or 
(b) to replace the Software Product with functionally equivalent 
Software Product, on diskettes or CD-ROM, as applicable or (c) 
return the price paid for the Software Product, in each case upon 
return of the Software Product to Serif together with a copy of your 
receipt for the purchase thereof. This Limited Warranty is void if 
failure of the Software Product or hardware has resulted from 
accident, abuse, or misapplication. Any replacement Software 
Product will be warranted for the remainder of the original 
warranty period or thirty (30) days, whichever is longer. Outside 
the United States, neither these remedies nor any product support 
services offered by Serif are available without proof of purchase 
from an authorized non-U.S. source. The Software Product is 
licensed to you on an "as is" basis without any warranty of any 
nature. 

8. NO OTHER WARRANTIES 

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTIES, SERIF 
AND ITS SUPPLIERS MAKE AND LICENSEE RECEIVES NO 
WARRANTIES OR CONDITIONS, OR TERMS, EXPRESS, IMPLIED, 
STATUTORY, OR IN ANY COMMUNICATION WITH LICENSEE. TO 
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, SERIF 
AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES AND 
CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT, WITH REGARD TO THE SOFTWARE PRODUCT 
AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT 
SERVICES. LICENSEE SHALL BE SOLELY RESPONSIBLE FOR THE 
SELECTION, USE, EFFICIENCY AND SUITABILITY OF THE 
SOFTWARE PRODUCT AND SERIF SHALL HAVE NO LIABILITY 
THEREFOR. SERIF SHALL HAVE NO LIABILITY FOR, NOR 
OBLIGATION TO INDEMNIFY LICENSEE REGARDING ACTIONS 
ALLEGING THE INFRINGEMENT OF PROPRIETARY RIGHTS BY THE 
SOFTWARE PRODUCT. SERIF DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE PRODUCT WILL BE 
UNINTERRUPTED OR ERROR FREE OR THAT THE SOFTWARE 
PRODUCT WILL MEET LICENSEE'S SPECIFIC REQUIREMENTS. The 
Limited Warranty gives you specific legal rights. You may have 
others, which vary from state/jurisdiction to state/jurisdiction. 



 

9. LIMITATION OF LIABILITY 

IN NO EVENT WILL SERIF OR ITS SUPPLIERS BE LIABLE FOR LOSS 
OF DATA, CORRUPTION, LOST PROFITS, COST OF COVER, OR 
OTHER SPECIAL, INCIDENTAL, PUNITIVE, CONSEQUENTIAL, OR 
INDIRECT DAMAGES ARISING FROM THE USE OF THE SOFTWARE 
PRODUCT (INCLUDING ANY ACCOMPANYING DOCUMENTATION), 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS 
LIMITATION WILL APPLY EVEN IF SERIF OR AN AUTHORIZED 
DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. IN NO EVENT WILL SERIF'S LIABILITY EXCEED THE 
AMOUNT PAID FOR THE SOFTWARE PRODUCT. LICENSEE 
ACKNOWLEDGES THAT THE AMOUNTS PAID BY LICENSEE FOR 
THE SOFTWARE PRODUCT REFLECT THIS ALLOCATION OF RISK. 
Some states or other jurisdictions do not allow the exclusion or 
limitation of liability for incidental or consequential damages, so the 
above limitations and exclusions may not be applicable in certain 
instances. None of the above affects the statutory rights of 
licensees residing in the United Kingdom.  

10. NOT FOR RESALE SOFTWARE 

If the Software Product is labelled "Not for Resale" or "NFR," then, 
notwithstanding section 1 of this License, your use of the Software 
Product is limited to use for demonstration, test, or evaluation 
purposes.  

11. NO RENTAL; OTHER TRANSFERS 

You may transfer this License to another computer or workstation 
only on a permanent basis (that is, with no intent to transfer again) 
provided the computer, workstation, or other digital electronic 
device from which you have transferred this License no longer 
accesses or otherwise utilizes the Software Product, and the 
Software Product is used in accordance with the terms of this 
License Agreement.  

12. TERMINATION 

You may terminate this License Agreement at any time. Serif may 
terminate this License Agreement if you fail to comply with the 
terms and conditions of this License Agreement. In either event, 
you must destroy all copies of the Software Product.  

13. UPGRADE 

If this License is an "Upgrade," you must have a valid license for 
the Prior Software for this License Agreement to be valid, and this 
License Agreement must be used to replace such license for the 
Prior Software. The total number of license "Upgrades" you may 
acquire may not exceed the total number of computers, 
workstations, or other digital electronic devices that were licensed 
to access or otherwise utilize the Software Product at the time you 
upgraded the Software Product. 

14. GUIDELINES FOR THE USE OF DIGITAL CONTENT 

This product contains numerous clipart and photo images and/or 
video and audio media files (collectively referred to as the “Digital 
Content”) which are either owned by Serif or licensed from a third 
party. As a user of this product you are free to use, modify, and 
publish the Digital Content as you wish subject to the restrictions 
set out below. If you are uncertain as to whether your intended 
use complies with the guidelines set out below, we recommend 
that you seek the advice of your own attorney or legal counsel. 

A. YOU MAY, subject to any restrictions set out below: 

1. Incorporate any Digital Content into your own original work and 
publish, display, and distribute your work in any media. You may 
not, however, resell, sublicense, or otherwise make available the 
Digital Content for use or distribution separately or detached from 
a product or Web page. For example, the Digital Content may be 
used as part of a Web page design, but may not be made available 
for downloading separately or in a format designed or intended for 
permanent storage or reuse by others. Similarly, clients may be 
provided with copies of the Digital Content (including digital files) 
as an integral part of a work product, but may not be provided with 
the Digital Content or permitted to use the Digital Content 
separately or as part of any other product; 

2. Make one (1) copy of the Digital Content for backup or archival 
purposes. 

B. YOU MAY NOT: 

1. Create scandalous, obscene, defamatory, or immoral works 
using the Digital Content nor use the Digital Content for any other 
purpose prohibited by law; 

2. Use or permit the use of the Digital Content or any part thereof 
as a trademark or service mark, or claim any proprietary rights of 
any sort in the Digital Content or any part thereof; 

3. Use the Digital Content in electronic format, on-line, or in 
multimedia applications unless (a) the Digital Content is 
incorporated for viewing purposes only and (b) no permission is 
given to download and/or save the Digital Content for any reason; 

4. Rent, lease, sublicense, or lend the Digital Content, or a copy 
thereof, to another person or legal entity. You may, however, 
transfer all your license to use the Digital Content to another 
person or legal entity, provided that (a) you transfer the Digital 
Content and this License, including all copies (except copies 
incorporated into your work product as permitted under this 
License), to such person or entity, (b) that you retain no copies, 
including copies stored on a computer or other storage device, and 
(c) the receiving party agrees to be bound by the terms and 
conditions of this License; 

5. Use any Digital Content except as expressly permitted by this 
License. 

15. MISCELLANEOUS 

This Agreement shall not be governed by the 1980 U. N. 
Convention on Contracts for the International Sale of Goods; 
rather, this Agreement shall be governed by English law. This 
Agreement constitutes the entire agreement between Serif and 
Licensee and supersedes all prior agreements, understandings, 
communications, advertising, proposals or representations, oral or 
written, by either party. If any provision of this Agreement is held 
invalid or unenforceable, such provision shall be revised to the 
extent necessary to cure the invalidity or non-enforceability, and 
the remainder of this Agreement shall continue in full force and 
effect. This Agreement shall be amended only by an executed 
writing by authorized representatives of both parties. 

 



All Serif product names are trademarks of Serif (Europe) Ltd. Microsoft, Windows, and the Windows logo are registered 
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Welcome to Serif MoviePlus 4.0 

What is MoviePlus? 

Serif MoviePlus 4 is a powerful video-editing program for Windows®-
based PCs, offering easy and flexible ways to capture and edit your 
movies, add and blend audio tracks, apply video transitions and cool 
special effects along the way, and to export your creations in a number 
of possible video formats for sharing. MoviePlus 4 is a major leap 
forward for Serif's video-editing capabilities with every aspect of the 
program reviewed and rewritten since its last incarnation, allowing for 
impressive new features and unprecedented core technology 
improvements.  

What you'll find in MoviePlus 4...  

• Quick Sourcing of Video, Audio, Image Content 
MoviePlus makes it easy to gather content for your digital desktop 
studio! Capture video and audio directly from sources like a DV 
(digital video) camera, video capture card, mobile phone, even 
audio CD. Use the convenient Explorer tab to browse and preview 
video, audio, and image files from your hard drive and decide which 
clips to use. 

• 

the original 
file is left intact, not split into pieces by the process.  

• 

y 
is 

d in real-time with no pre-rendering of transitions or 
effects! 

Scene Detection 
Any movie captured from your video camera or sourced from your 
hard drive can benefit from scene detection. A simple slider allows 
adjustment of scene detection sensitivity, so individual clips can be 
used in your project in place of entire movie files—and 

Convenient Multi-Track Timeline Editing 
MoviePlus’s powerful Timeline approach lets you build your movie by 
arranging elements along an unlimited number of chronological 
tracks, using simple drag-and-drop, cut-and-paste techniques. It's 
easy to trim in- and out-points of your clips, adjust playback speed 
and direction, fade audio up or down, split a long clip into separate 
scenes, repeat individual clips or switch them on or off... and that's 
just for starters! It's easy to preview your movie-in-progress at an
time—MoviePlus's amazing core processing means your movie 
previewe
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• Cool Transitions 
Automatic Transitions between two video clips makes MoviePlus a 
breeze. MoviePlus offers dozens of built-in, customizable 
transitions... enjoy standards like wipes and cross-fades through 
stretches, pushes, and pixellation.  

to 

• 

adjustments... blur and sharpen... Chroma key, and greyscale... 
ny more! Mixback allows you to blend your 

• Key Frame Controls 

ht 

transforms to your clips! 

• 
e 

 
in movie, or tiling multiple videos together 

for a dynamic scene. 

• Animated Titles 
Create your own titles by using a series of customizable title 
presets... Transparent backgrounds mean titles "float" over your 
video. Even add optional animation by changing size and position 
over time. Use any font on your system and apply a full range of 
character formatting. 

Video Effects 
Drag and drop from the Effects tab to enhance your movies with a 
wide range of customizable video-image correction filters and special 
effects. Choices include basic brightness, contrast, and gamma 

colourization... and ma
effected video with the original, so in addition to adjusting the 
strength of the effect settings you can also control the overall 
blended strength of your effect in the mix! The powerful core video 
processing power of MoviePlus 4 allows you to apply multiple effects 
simultaneously and control the order in which they are applied. 

Transitions, effects, video motion, opacity, plus audio volume and 
stereo panning are now all "key-framable". You can specify changes 
over time and all the in-between steps are calculated for you. The 
changes themselves can also adopt different speeds or accelerations 
by changing the Key Frame properties. And all this can happen rig
in the Timeline! 

• Video in Motion 
Now your videos can move around on screen and have custom zoom 
effects... simply set start and end points by resizing or moving the 
video in the Preview window and MoviePlus calculates all the in-
between animation steps. The same feature allows you to rotate, 
skew, and add perspective 

Multiple Picture-in-Picture 
Create professional picture-in-picture effects easily using video clips 
or still frames... Easily edit the size and position of your video in th
Preview window. Perfect for showing supplemental visuals without
detracting from the ma
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• Transparent Overlays including Support for Serif ImpactPlus Scenes 
All of MoviePlus 4's video tracks support video transparency to 
superimpose not just titles but any 32-bit transparent image (or 
video) over your movie's action. Make portions of existing video 
transparent by adding a Mask (as you might in a bitmap-editing 
program like Serif PhotoPlus) or by picking a solid colour to become 
transparent. Use popular Blend Modes to adjust how your layered 
videos' pixels interact with each other. Add static or animated 
scenes you've created with Serif's ImpactPlus 4.1 or higher, for 
impressive special effects, 3D text, logos, credits, and intros. 

• 
t 

ats 
 

 with a different "spec" is as simple as 
changing a few settings. 

• 
l 

e entire 
 top or bottom of the interface to suit your 

preference. 

• 

ppreciate how MoviePlus 
puts all the options right at your fingertips! 

Versatile Movie Export 
When you're done assembling your movie on the Timeline, le
MoviePlus integrate all the elements and export the finished 
product! Save your enhanced movies to one of the many file form
or write to a DV camera. Use an export template based on your
project settings, or tweak the output options and save custom 
templates for later use. Since your original media files are intact, 
producing another version

Flexible User Interface 
Major enhancements in the new MoviePlus have allowed for a 
rethink of the user interface. You can now choose whether individua
resizable windows (or panes)—such as Video Preview, Explorer, 
Properties, Effects, Transitions—are floating or docked, share the 
same screen area, operate in a split pane view, or even use a multi-
monitor system... and combinations thereof. Even move th
Timeline to the

Serif Ease-of-Use 
From convenient media browsing to straightforward Timeline 
assembly to instant movie previews, with instant updates of mid-
preview edits, MoviePlus makes it easy to get started with digital 
video editing. Snapping simplifies aligning Timeline clips with each 
other... linking related events lets you move, repeat, or split them 
as a unit... the Properties window facilitates precise settings for all 
Timeline events. A sensible list of presets for capture and export 
keeps things simple. But there's plenty of power in reserve, too... 
even if things get complicated (say you need to apply some unusual 
combination of effects and settings), you'll a
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Registration, Upgrades and Support 
If you see the Registration Wizard when you launch MoviePlus, please 
take a moment to complete the registration process. Just call Serif toll-
free and provide the installation number and code shown. We’ll give you 
a personalized registration number in return. Remember, if you need 
technical support please contact us. We aim to provide fast, friendly 
service and knowledgeable help. 

Installation 

System Requirements 

Minimum, recommended, and ideal PC specifications 

MoviePlus 4 is engineered to work on a wide variety of Microsoft 
Windows-based PCs, but due to the nature of digital video files and 
digital video editing, some weighty demands are inevitably placed on 
your PC hardware. MoviePlus is speed-optimised for modern PC 
processors and takes advantage of MMX, SSE and SSE2 processor 
instructions, plus Hyper-Threaded and multi-processor systems. Please 
note the required system specifications listed below. 

"Minimum" requirements are those necessary for MoviePlus to work. 
MoviePlus and its features will all function but not at optimal speed. 
Meeting the "recommended" requirements will mean that you will enjoy 
smoother performance for typical MoviePlus projects. Fulfilling the "ideal 
PC" specification will allow you to achieve higher levels of performance 
with MoviePlus, achieving more fluid editing of complex projects and 
speedy movie exports. 

Minimum 

• Intel® Pentium® III or AMD Athlon™ XP processor (if other 
processor it must support the SSE processor instruction set1) 

• 128MB RAM 

•  required 
during the composition and export of video projects) 

• onitor capable of 800x600 display size and 

ble sound controller 

400MB hard drive space (2-5 GB of free space may be

Graphics card and m
24 bit colour depth 

• Windows-compati
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• DVD-ROM drive  

• Microsof t Windows® 98 SE, Me, 2000, XP 

s 4 

 

t. There are similar thresholds for 
t and full-
ur processor 

spec at

Reco e he items in the minimum specification) 

 

• Fast hard disk (7200rpm drive with dedicated ATA133 

768 display 

Ideal ey

• em architecture 

• M 

nitor display capable of 1280x1024 display size on 
primary screen 

• Microsoft DirectX 9.0b device drivers (included with MoviePlu
install) 

• Microsoft Windows Media Video support files (included with 
MoviePlus 4 install) 

1 To find out whether your processor supports the instruction sets 
MoviePlus is optimised for, download and run a CPU identification utility
such as the freeware CPU-Z from www.cpuid.com. Although the 
MoviePlus 4 system requirements stipulate a Pentium III or Athlon 
processor, some budget chips—like Intel's Celeron—have also adopted 
SSE support: in the case of Celeron chips, models designated 533A or 
higher (based on the Pentium III) do support SSE while speeds of 533 or 
lower, based on the Pentium II, do no
the introduction of other processor technologies in budge
feature processors, so be sure to take a virtual look at yo

ific ion with a CPU utility. 

mm nded (beyond t

• Intel® Pentium® 4 Hyper-Threaded processor 

• 512MB RAM 

connection or better) 

• Modern graphics card and monitor capable of 1024x
size 

 (b ond the items in the minimum specification) 

Multi-processor modern syst

1GB or more RA

• IDE, S-ATA or SCSI striped RAID (RAID 0) hard disk array for 
improved disk performance 

• Multi-mo
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In additi  
there are tional hardware items that may enhance your use of 
MoviePlus. 

Optional hardware 

analogue video 
sources 

Optimizing Performance 

re 

d 
Performance Notes on p. 167 for advice. 

ePlus 4.0, simply insert the Program CD-ROM into your 
CD-ROM drive. The AutoRun feature automatically starts the Setup 

swer the on-screen questions. If the 
AutoRun does not start the install, use the manual install instructions 

M (see 
e 

 part of the installation at a 
Windows Start menu (via the 

Settings item for pre-XP systems) and then double-click the 
ake sure the correct CD-ROM is 

inserted into your CD-ROM drive, choose Serif MoviePlus 4.0, and click 
ng 

on to the typical processing, disk, and graphics requirements,
 some op

• FireWire (IEEE1394) support for connecting DV cameras 

• Video capture card for digitising and editing 

If your hardware meets the requirements shown here but you a
experiencing stuttering playback of your project during preview, or 
are experiencing dropped frames during video capture, please rea
the 

First-time install 

To install Movi

process and all you need to do is an

below.  

If you’ve also obtained the MoviePlus 4.0 Studio Effects CD-RO
below), install it now following the same procedure you used for th
Program CD.  

Manual install/re-install 

To re-install the software or to change any
later date, select Control Panel from the 

Add/Remove Programs icon. M

the Install… button. You’ll have the choice of removing or addi
components, re-installing components, or removing all components.  
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Other MoviePlus Resources 

ing techniques are brought 
together from 10 diverse movie projects to help you understand the 

 project 
files themselves and the finished movies—experiment with any project 

aker. 

MoviePlus Studio Effects DVD 

The Studio Effects DVD, containing royalty-free audio and video 
samples, can be used to support you as you begin your first attempts at 
making your own movies. Think of your DVD as a digital gallery which 
you can call on to select source material for your MoviePlus project. Use 
your samples to fuel your imagination! 

Please contact the Serif Software Centre (see How to Contact Us at the 
start of this companion) if you would like to purchase this item. 

Online Help and Tutorials 

MoviePlus contains a comprehensive online help system and an easy-to-
follow set of tutorials. Once installed, go to the Help menu of MoviePlus 
and find out more about the program. 

MoviePlus Projects Guide 

This book provides an insight into the creation of movies using 
MoviePlus. Sketches, hints, tips and film

processes needed for stunning movie production. The book is also 
supplied with an accompanying DVD packed full of the MoviePlus

file to turn yourself into a Movie M

Please contact the Serif Software Centre (see How to Contact Us at the 
start of this companion) if you would like to purchase this item. 
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Visual Reference: A Guide to the Interface 
This section offers an introduction and links to in-depth explanation of 
each area of the MoviePlus interface. 

If you are new to movie editing or have not encountered an interface as 
rich as MoviePlus 4's, read on for an introduction to each element of the 
MoviePlus interface.  

 

Menus 

The Menu bar in MoviePlus offers a typical range of drop-down menu 
commands; some are standard to most programs, such as File>New, 
File>Open, File>Save, Edit>Undo and so on, and some commands are of 
course specific to MoviePlus functionality, such as Insert>Video Track or 
Tools>Capture. 

Toolbars 

The MoviePlus 4 tool buttons are organized on four separate toolbars—
Standard, Editing, Playback, and Seeking. Each of the toolbar's buttons 
offer ToolTips—a popup reminder of the tool's name when you hover the 
mouse over the button.  
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The toolbars can be dragged to reorder them, or to new locations—they 
can be free floating, or docked at the top, bottom, left or right of the 
MoviePlus window. 

Status Line 

Check the readout in the Status Line to see the time of your current 
editing operation or a hint about your currently selected tool. 

The Timeline 

MoviePlus's Timeline is a versatile tool and the crucial component of all 
your movie projects! From left to right it represents the flow of your 
movie from start to finish. From top to bottom it represents stacked 
layers of video, images, titles and other sources. It is a flexible area of 
the interface with which you can add and combine video and audio 
sources in a project, edit effects and transitions in conjunction with the 
Properties pane, and "scrub" the mouse along the top of the Timeline to 
play your project in the Preview window at a speed of your choosing. 

The Headers section at the left of the Timeline shows what each kind of 
track or strip is, plus it offers buttons to access a track's properties, 
effects and visibility status. It also presents simple sliders to control 
track opacity (in the case of video) or volume and balance (in the case of 
audio). You can drag the Headers up or down around within this area to 
organize your tracks in a more useful order. 

The Key Frame View below the Timeline is active when you click on any 
of the Show/Hide Envelopes/Effects/Transitions buttons below the 
headers. It allows you to add and edit properties for source/track/groups 
and their envelopes/effects/transitions. The Key Frame View and 
Headers regions can be "resized" using the Timeline splitters; note the 
double-headed cursor when you hover over a splitter. 

The Caret 

The caret can be considered as your "editing marker". It allows you to 
set a precise position for splits and trims, allows sources to be dragged 
to a specific point, and can be used along the Timeline Ruler to play back 
a preview of your project. The caret's position can be frame-accurate 
using Seeking toolbar controls. 

The Explorer Pane 

The Explorer pane is a window to your hard drive, CD/DVD drives, or 
network. It allows you to browse for, select, and incorporate video, 
image, and audio files into your movie project. 
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You can browse your network or drives using the tree-view in the left 
hand side of the Explorer pane as you would when using Windows 
Explorer itself, and supported content found in the selected folder will be 
displayed as thumbnails in the right hand side of the Explorer pane. 
From here you can drag and drop source objects onto your Timeline. 
Across the top of the Explorer pane you'll also find some quick shortcut 
buttons to help navigate to frequently-used locations and to access 
scene detection features.  

The Properties Pane 

This pane is another crucial component of the MoviePlus interface, which 
is used very frequently. The contents of the Properties pane will change 
depending on what you have selected or what you are doing with your 
Timeline. This versatile pane allows you to name the source objects used 
on your Timeline, to adjust source object attributes (such as the start 
and end times, video in and out trim points, play speed, the repeat mode 
and resizing behaviour), to adjust effect and transition properties, and to 
control key frame settings when adjusting effect, transition, opacity, or 
volume strength on your Timeline. 

The Effects Pane 

This area of the MoviePlus interface offers categorised previews of the 
video effects available for use in your projects. To apply an effect, drag 
and drop it from the right-side of the Effects pane onto a source object, 
track header, or group of tracks. Once the effect is applied, you can alter 
its setting using the Properties pane. 

See Applying Effects on p. 123 for more information. 

The Transitions Pane 

Like the Effects pane, this tab shows easy-to-use previews—this time of 
transitions. A simple drag and drop of a preset from the Transitions pane 
onto an area where two sources overlap will apply the transition to that 
part of your project. A transition can be selected with a click on its blue 
bar on the Timeline, so its settings can be modified using the Properties 
pane. 

See Applying Transitions on p. 131 for more information. 
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The Sources Pane 

This window pane offers ready-made computer-generated sources that 
you can drag and drop onto your Timeline. They include solid colours and 
text objects. They are always generated at the highest possible quality 
for all your project exports. Once you've dragged and dropped your 
Procedural Source onto a video track in the Timeline, you can use the 
Properties pane to edit it.  

The Preview Pane 

The Preview pane in MoviePlus is more than just a way to preview your 
project! First and foremost, this is the place where you will see your 
project being previewed when you click the Play button on your Playback 
toolbar. You can change the speed and direction of playback using the 
controls on the Playback toolbar or by "scrubbing" the Timeline caret. 

The Preview pane has another important function too—it's the place for 
adjustments to a video track's Transform Envelope, because you get to 
directly see the changes to the position or size of your selected source, 
track, or group as you use the Transform tool. When you click the 
Show/Hide Envelopes button on the track header, a Motion envelope 
becomes visible in the Key Frame View below the Timeline’s tracks. You 
can add Key Frames to the envelope, and can apply specific settings to 
each key frame using the Properties pane.  

The Edit Text Pane 

This pane allows you to edit a selected Text source (which you can add 
to your Timeline from the Sources pane). The text controls are typical of 
a simple word processor, lines of text can be created by typing then 
pressing Return, plus of course you can select text using drags of your 
mouse in order to change the font, colour, text alignment or size using 
the toolbar at the top of the pane. 

Changing the MoviePlus Screen Layout 

With all the video-editing possibilities MoviePlus offers, its interface 
needs to offer a great deal of content and control. The interface itself is 
customizable to suit your preferred method of working. You can grab and 
move the separators between panes, drag tabs out of groups of panes to 
make them free floating, or dock them against a side of the main 
window or into new groups with other panes. You can also split a pane 
region into two by dragging a tab to the edge of an existing pane.  
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Before You Start 
Movie editing can be both a serious business and a great deal of fun, 
depending on the nature of your project and whether you have deadlines 
to face or other critical requirements to meet... in any event you can 
help yourself before embarking on your projects by considering the 
following: 

Prepare your video, audio, and image sources 

Most projects are started with some intent—you are likely to already 
have a good idea of what video and audio footage you would like to edit 
and make into a movie. It will be worthwhile gathering the source 
components you'll think you'll need into a convenient location on a 
suitable hard drive, although this is not necessary it is merely a good 
idea. If you are to capture footage from a camera or other video device, 
read both Capturing From a Video Source and Performance Notes 
on p. 21 and 167, respectively, to achieve the best possible results. 

If you are yet to create your video footage, prepare a shooting plan 
before you start; this can save a great deal of time and effort and is 
likely to have a very positive impact on your results.  

Give your computer a performance check 

There are several performance checks you can perform to help optimise 
your computer for video editing. These will help overall speed, but in 
particular will help with data-intensive operations like composing and 
exporting a movie with MoviePlus! For more information, including Anti-
Virus security and disk defragmentation advice, see the Performance 
Notes on p. 167. 

Lastly, don't worry—dive in and enjoy yourself! 

You can get help with all of MoviePlus's features in the Help system, so 
don't be daunted. Whether you are new to video editing or just new to 
MoviePlus, its richness will be unearthed as you use the program and the 
possibilities available to you will be revealed. All of the terminology, 
buttons, cursors and more are all described so that you will learn how to 
edit your movies like a professional... 

...and of course there is always the Undo button (also available by 
pressing Control+Z) so you can tweak and experiment without limit. 
MoviePlus's editing functions do not damage the source media that your 
project uses so you can feel free to try a range of trims, stretches, loops, 
transitions, effects and more, safe in the knowledge that you can undo 
your experimental operations with the click of a button and start again. 
Remember to share your results by exporting your movie and 
distributing it to friends, family, colleagues, or the rest of the world via 
the Internet! 
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Starting a New Project 

The Startup Wizard 

 

The MoviePlus Startup Wizard offers easy access to the most common 
starting tasks after you launch MoviePlus (or when you click File > 
New). You can start from scratch (which will launch the Project Settings 
dialog shown below), open a project (browse your PC for saved 
MoviePlus 4 .MVP files), view tutorials (see tutorials aimed to get you 
started using MoviePlus) or view samples (open sample projects created 
in MoviePlus). 

The Use the startup wizard next time button gives you the option of 
either using the startup wizard the next time MoviePlus is launched or 
displaying the user interface directly. The startup wizard can also be 
switched on or off in Tools > Options > General at any time. 

Click the cancel button or press Escape on your keyboard to bypass the 
Startup Wizard and launch MoviePlus with an empty project. The type of 
project will match the last project you selected. 

MoviePlus Projects... 

MoviePlus bases its movie compositions around "projects". You can save 
and reopen your projects at any time for ongoing editing. A MoviePlus 
project file is a collection of project settings (the video size and shape, 
audio properties etc.) plus information about how all your video, audio, 
image, title and colour sources are arranged and edited on the Timeline. 
It's worthwhile choosing a project type before you embark on your 
movie creation, amongst other things the project settings will determine 
how your video looks when it is previewed. 
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Because the makeup of your project will determine the look of your 
video during the editing phase, take a moment out before you get 
started to define your project settings. You can access the Project 
Settings dialog via the Startup Wizard's Create new project link, the 
Project Settings button on the Standard toolbar, or the File > Project 
Settings menu item. 

The Project Settings dialog shows that there is a list of preset projects to 
choose from, encompassing all of the most popular types of movie 
production—DV presets for maintaining DV film quality, DVD presets for 
projects intended for ultimately writing to DVD disc for display on a TV, 
plus VCD and SVCD preset formats. Each of these major formats also 
offers NTSC/PAL choices for you to choose depending on your local 
standard, and a Widescreen variant in each case. The specific settings 
for each of these formats is fixed in order to maintain correct technical 
compatibility with the formats specified, but you can also edit the 
presets list for customised projects. 

As an example of choosing a project: if you live in the UK and have used 
a typical British digital video camera to record your movie, you could 
choose either a DV PAL or DV PAL Widescreen project in MoviePlus in 
order to edit your DV footage and maintain it in the DV format for writing 
back to your DV camera, or if you know it is destined for a DVD to be 
shared with friends and family, you should choose a PAL DVD or PAL 
DVD Widescreen project to complement this export format. You can 
export your project in a different format from those offered in your 
Project Settings dialog if you wish, but choosing a suitable project from 
the outset will make your previews look as intended. When your project 
settings match your intended output format, your previews will be closer 
to your intended output—and the preview is offered in real-time with no 
pre-rendering of effects and transitions. 
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Choosing Project Settings 

If you are concerned that you have not picked the correct project 
template or other project settings don’t worry. MoviePlus is very flexible 
and will allow you to alter these settings by selecting File>Project 
Settings at any time.  

In addition, if you want to change your project settings to match the 
settings of a video source in your project, click the source on the 
Timeline, right-click and choose Set Project Video to Match. 

NTSC or PAL?  

NTSC is the broadcast and recording standard used mainly in North and 
South American continents, plus parts of eastern Asia including Japan 
and South Korea. If you wish to export your project in a format suitable 
for sharing in these areas, your project and export settings should be an 
NTSC preset.  

PAL is used widely throughout Europe, Africa, the Middle East, Asia, and 
Oceania. If you wish to export your project in a format suitable for 
sharing in these areas, your project and export settings should be a PAL 
preset.  

What next? 

Now that you've started a new project and defined its settings, you will 
be presented with an empty Timeline ready for you to begin composing 
your movie project.  
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Adding and Capturing Media 
MoviePlus projects are your own compilations of video footage—trimmed 
or otherwise edited—perhaps with transitions between clips, video 
effects and picture adjustments, and of course accompanied by your 
choice of audio tracks. The Timeline at the heart of MoviePlus's interface 
is the heart of its editing power, so it and your projects would be totally 
worthless and empty if they did not have any media sources in them! 

For this reason MoviePlus makes it easy to capture your own video 
footage from DV cameras or analogue video sources, to store it on your 
PC, and to locate and add captured video or other media files to your 
Timeline. MoviePlus supports a range of media files including various 
types of video, audio, and image files, all browsable using the 
Explorer pane. 

Further information is provided in General Capture information on p. 
155. 

Capturing From a Video Source 

MoviePlus includes a Capture module that can "import" video footage 
and associated audio from DV and Mini DV cameras, USB Web cams, and 
analogue video sources via a capture card and to save it to a hard drive 
for use in MoviePlus or other video projects. 

 To open the Capture module, choose Capture from the Tools menu, 
or click the Capture button. 
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The Capture dialog 

 

This screenshot shows in-progress capture of digital video footage with 
associated audio from a DV camera (connected by FireWire). The capture 
settings are greyed out in this case, unavailable because capturing from 
a DV camera always uses the fixed DV standard format (and no settings 
can be changed during capture).  

The procedure to follow:  

Connect your camera or other video source 

If your camera is properly connected and supported (and is set to 
playback mode rather than record mode if appropriate), you should see 
a video preview in the window shown above when your video source is 
playing. Controls under the preview window allow you to play and pause 
the tape in your camera to find the footage you wish to capture—these 
controls are only applicable to DV and Mini DV cameras; for other 
sources you will need to control the device yourself, a remote control 
may be handy here. 

If you are using an alternate video source, ensure that it is connected to 
your video capture card (or a USB socket in the case of a Web cam). 

Choose an appropriate capture format 

If your source footage is on a DV camera, MoviePlus will automatically 
capture using the DV format so you will not be need to adjust the video 
and audio capture settings.  
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If your source footage is being captured via a video capture card or USB 
Web cam, you can choose a file format suited to your video type. For 
general information about video file formats, please see File Export – 
File Types on p 141. 

It is recommended that you capture at a resolution and quality as high 
as possible to achieve high-quality results—it is best to aim as high as 
the source footage resolution and quality. Even when you ultimately aim 
for your resulting video to be very compact, for instance to make it 
suitable for download from the Internet, you can defer the file-size-
smashing resizing and compression operations to final export time, don't 
compromise your captured quality! 

Set a suitable file storage location 

Captured video footage can occupy a large amount of hard drive space 
when it is transferred to your PC, so it is important to choose a drive 
location with lots of room when capturing video. The standard DV format 
occupies approximately 3.5MB per second of footage—that's 
approximately 200MB per minute, or 12GB per hour. DV camera footage 
is always captured as DV; analogue video sources allow you to choose a 
different format. We recommend you choose "none" in the Codec setting 
in the Video Details > Format section of the dialog if you are capturing 
your video to an AVI file. As an example of the size of raw captured full 
resolution video, if you choose to capture your video footage at DV or 
DVD resolution (720x576 pixels) and store it as a full quality 
uncompressed AVI, the file size would increase to 1.75GB per minute; 
105GB per hour.  

Your chosen hard drive location for storing captured video should have 
plenty of space to accommodate your chosen footage; preferably it 
should also be a fast drive to handle the large amount of data being 
transferred in a short amount of time. If you would like some advice 
about improving system performance, please read the Performance 
Notes on p. 167. 

When MoviePlus captures your video or audio footage, it will 
automatically name and number your files if you do not specify a 
particular filename. 
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Preview and cue your video footage 

If you have connected a DV or Mini DV camera to your PC via FireWire 
you will be able to cue your tape to the point at which you would like 
capture to start. Cue to a suitable start point for your capture by using 
the "tape transport" controls underneath the preview, or by using 
manual controls on your video device. You should capture additional 
footage either side of the specific sections you wish to capture so you 
can trim accurately once the capture is complete—it's better to capture 
too much footage and trim it later rather than have too little. 

Ensure that both Capture audio and Capture video checkboxes are 
checked if you want to capture both audio and video. 

 

If your audio level metre (shown above) regularly reaches level “0” 
during your preview, reduce the Volume level in the Audio Details > 
Control section of this dialog. Audio captured at this levels will quite 
likely sound distorted. 

Choose whether to capture scenes to separate files 

The Split files by scene checkbox at the bottom of the Capture dialog 
offers the chance for all your scenes to be saved as separate video files 
as part of the capture process. For DV, the default is for the box to be 
checked so that scenes are split by timestamp; for non-DV capture, the 
default unchecked box means that scene detection and sensitivity 
adjustment should be made via the Explorer pane (see Scene 
Detection on p. 31). 

Record 

Play your video source from at least a couple of seconds before the point 
at which you'd like capture to start (to allow the video device to begin 
playing smoothly) then click the Record button in this dialog to begin 
the capture. If there is a section of your tape that you would like to skip 
during capture, pause the process by clicking the Pause button, cue the 
tape to the point you would like to proceed from, then click Pause again 
to resume the capture. Again, it's better to capture too much footage 
rather than too little, it can always be trimmed later, so don't worry too 
much about exactly how much is captured if you are uncertain. 

When you are happy that the required footage has been captured, click 
the Stop button. You can begin recording to capture subsequent files, 
MoviePlus will name each captured file with an incremented number 
suffix. 
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Watch for dropped frames, maximum CPU usage, and peak audio levels during 
capture 

During the capture process it is recommended that you keep an eye on 
the CPU usage metre and Dropped frames count. You should aim for 
zero dropped frames for perfect capture. If your CPU (system processor) 
reaches maximum usage, it is likely that frames of video will be dropped 
(meaning that capture of your video footage is incomplete as some 
frames were not transferred to the PC quickly enough during the video 
playback and capture). You should also watch for peak audio levels and 
if they reach into the red then you can consider recapturing your source 
footage after adjusting the Volume level in the Audio Details > 
Control section of this dialog. 

Capturing Audio from CD 
Capturing Audio from CD is fully described on p. 157.  
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Browsing for and Adding Media Files 
Composing your own MoviePlus projects involves combining (or editing) 
existing video, audio and image files; your MoviePlus projects would be 
utterly bleak if you weren't able to add a selection of media files to 
them! 

The files you use for your project could have been obtained by 
Capturing From a Video Source (see p. 21), download from the 
Internet, digital camera, CD, hard drive, or network drive. Whatever 
method is used to derive your project input you will always have to 
select your files via the Explorer pane—let’s take a look. 

The Explorer Pane 

The Explorer pane is the key to being able to add media to your 
project—even media you capture from a camera yourself is stored on 
your hard drive and is "accessed" via the Explorer pane as shown below. 

 

Adding media to the Timeline 

Click the Explorer tab in your interface to display the contents of the 
Explorer pane. If your Explorer pane is not visible, you can enable it 
using the View > Panes menu flyout or by pressing Control + Alt + E.  

Browse the tree structure in the left side of the Explorer pane to switch 
between drives and folders to locate your media files. Adding media to 
your projects involves the simple task of clicking on your chosen media 
file in the right-hand side of the Explorer pane, holding the mouse button 
down and dragging the media file onto your Timeline. Release the mouse 
button when you are happy with the outlined "drop target". You can add 
video and images to video tracks and of course you can add audio files 
to audio tracks. 
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If the video you add to your Timeline already has an audio of its own the 
audio will be added to an audio track at the same time. The audio and 
video that originate from the same source will have a pink selection 
outline in the upper-left corner to indicate that these sources are linked. 
When you move, trim, or extend a linked source, other sources linked to 
it will also be edited. 

Choosing a drop target 

Where you drop your sources on the Timeline is up to you, the area is 
"freeform"; video and image sources must be located on video tracks, 
and of course audio on audio tracks. It is normal to place sources in an 
empty spot and manoeuvre them to the desired precise spot if necessary 
afterwards. In general terms remember that further left on the Timeline 
is closer to the start of your movie and further right is later in the movie 
project. Being placed on a track higher up the Timeline will mean your 
source could obscure underlying elements (sources higher up the 
Timeline are perfect as overlays or picture-in-picture sources) and 
underlying tracks are perfect as backgrounds behind video, image, or 
text overlays. 

Where sources on the same track overlap, MoviePlus's default behaviour 
is to add an automatic crossfade transition in the overlap region. You can 
drag and drop an alternate transition from the Transitions tab into this 
overlap region to replace the crossfade, or select and delete the blue bar 
representing the transition region (just hit the Delete key to delete 
selected components). See Applying Transitions on p. 131. 

If you hold the Shift key on your keyboard when your drop target is on 
a particular track, MoviePlus will constrain the drop target to that track 
only until the Shift key is released. This can help you make sure you 
drop your sources in the right place for multi-track projects. You can 
hold Shift to locate one of a pair of linked streams (e.g., audio and video 
from the same media file) on a track of your choice and then move your 
mouse to the other type of Timeline track to locate the second of your 
drop targets. 

Adding multiple sources at once 

It is possible to select multiple source files and drag them all onto the 
Timeline in one operation. This would typically be useful if you wanted to 
use some still images as part of your project or you wanted to add all 
detected movie scenes onto the Timeline. MoviePlus will add your 
sources in alphanumeric order with a default overlap (and an auto 
transition if this is enabled on the Editing toolbar). 
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Media with black bars displayed 

If your video or image sources are a different size and shape to your 
project settings, by default MoviePlus will keep your media the same 
shape and seemingly surround it with black bars (letterboxing/sidebars) 
to fill the available space. The black letterboxes or sidebars are only 
visible when there is no other video, colour, or image source underneath 
your ill-fitting source object. The shape of the video in the Preview pane 
is determined by your project settings; if your source media properties 
and your project settings are different, you will need to decide what to 
do about the variance. 

You can leave the media with letterboxes or use the Size mode pull-
down in the Properties panes to change the way MoviePlus handles the 
discrepancy. You can change the size mode to Stretch, which will stretch 
your video or image horizontally or vertically to match the project video 
size, or choose Crop to stretch the video to match the project size while 
maintaining the source’s current aspect ratio, allowing the taller (or 
wide) areas to be outside the visible project size. 

 

Letterbox mode 
(default) 

Stretch mode Crop mode 

 

You can always change your project settings to select a different video 
standard (e.g., switch from DV PAL Widescreen to DVD PAL which has 
different dimensions) or make the project settings match those of your 
selected video source (right-click your source to select the Set Project 
Video to Match option). 
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Other Explorer pane features 

Main buttons 

The row of buttons along the top of the Explorer pane allow you to 
control your project sources. On the left there is: 

 Navigate back and forward between different folders you 
have viewed 

 Bookmark your favourite folders or jump to some pre-defined 
folders on your hard drive. 

 Refresh your view 

The four buttons at the right of the row will fast-track you to: 

 Your My Documents folder 

 The MoviePlus Samples (sample media) folder 

 The default Capture folder 

 Your current Projects folder (where your current .MVP 
MoviePlus Project file is saved). By storing sources on the same 
drive as your project file the source paths will be stored in a 
“relative” path. This makes managing your sources and projects 
more straightforward. 

Scene detection 

  The Show/Hide Scenes button at the far right of the Explorer 
pane hides or shows the Scene panel within the Explorer pane. Click this 
button to reveal the scene detection panel now. Any video source, 
freshly captured or otherwise, can be virtually split into detected scenes 
by first selecting a source and then clicking the Detect scenes button. 
You can adjust the sensitivity of the scene detection process by moving 
the slider in this section of the Explorer pane—moving the slider to the 
right should result in a greater number of scenes. Scenes in the bottom 
section of the pane can be dragged onto your Timeline just as you would 
for other sources. See Scene Detection on p. 31. 

 You can cancel scene detection by clicking the Cancel button. 
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Supported file formats 

MoviePlus allows you to add a variety of media files to your PC. 
Supported import formats include: 

Video 

ASF Microsoft's Advanced Streaming Format 

AVI Microsoft Audio Video Interleave 1  

MPG and 
MPEG 

MPEG-1 and MPEG-2 video 

STV Serif Transparent Video (e.g. exported from Serif 
ImpactPlus)  2

VOB DVD video file 

WMV Windows Media Video 

   

Audio 

MP3 Compressed MPEG-layer 3 audio 

WAV Windows Waveform audio 1

WMA Windows Media Audio 

   

Images 

BMP Uncompressed Windows Bitmap 

GIF Palletised (256- or fewer colours) Compuserve bitmap 

JPG, JPE 
and 
JPEG 

Compressed JPEG bitmap 

PNG Lossless Portable Network Graphic (transparency 
supported) 
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A range of less well-known image file formats are also supported. 

1 A note about AVI and WAV files 

AVI and WAV files can be considered "containers" for all sorts of media 
stream types. For instance, an AVI file can contain any type of video 
interleaved with any type of audio, the AVI extension indicates how the 
streams are "wrapped up" together. Suitable decompressors for the 
specific video and audio contained in the AVI would need to be available 
on your PC for MoviePlus to be able to successfully import the video and 
audio streams. The same can be true of WAV files; they are normally 
uncompressed audio streams but a WAV file can contain compressed 
audio which would require a compatible audio decompressor as 
described for AVI files. 

2 A note about STV files 

STV files mentioned above are Serif Transparent Videos. If you don't 
have any STV files to call on, you may wish to consider trying or buying 
Serif's ImpactPlus—an easy-to-use 3D graphics program that can 
create 3D titles and images along with impressive particle systems like 
smoke, fire, water etc. for use as overlays in movies. 

Extending Explorer pane support for more file extensions 

You can modify the list of file types that MoviePlus's Explorer pane will 
display. You aren't likely to be able to extend the range of supported 
formats, but you can add to the list if you have some files in a supported 
format which use a variant of the normal extension e.g. an MP3 file may 
be unusually named songtitle.mpeg3; you could add mpeg3 to the list 
of file extensions and files of that extension name would be displayed in 
the Explorer pane. You can also remove items from the supported file 
types list if you do not want them displayed in the Explorer pane. Use 
the Tools>Options>File Types dialog to modify the supported file 
extensions list. 

Scene Detection 

How to detect scenes in a video file 

  MoviePlus can perform scene detection on any video file 
(including captured files) before you drag your video sources to your 
Timeline.  Click the Show/hide scenes button at the top right of the 
Explorer pane to reveal (or hide) the scene panel. For any selected video 
source you can click the Detect Scenes button to let MoviePlus analyze 
your video and create a series of smaller clips in the scene panel. 
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Your original video file is not damaged by this process because the clips 
generated are "virtual scenes"; they are real clips that you can drag 
straight on to your Timeline, but they are merely references to the 
original video file with separately-stored information about where each 
scene begins and ends. Even if your video file is moved or renamed, 
once the scenes have been generated MoviePlus will be able to show you 
the detected scenes for your media. 

Scene detection for non-DV video files 

For non-DV video files, MoviePlus detects scenes by searching for 
discontinuity between frames. If one frame is very different from its 
previous frame (based on changes to their colour histograms) it is likely 
to be considered to be in a separate scene and a scene break is made. 

Scene detection for DV video files 

For DV AVI sources, MoviePlus will attempt to use time stamps recorded 
by the DV camera to detect scenes. Where these DV time stamps exist 
and are valid, MoviePlus will base the scene detection process on them 
for crisp and accurate scene breaks. 

Scene detection sensitivity 

 You can adjust the sensitivity of MoviePlus's scene detection simply 
by adjusting the slider in the scene panel. This is something that should 
happen in real-time or thereabouts, you do not need to click the Detect 
Scenes button again. 
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Moving the slider to the left results in fewer scenes, moving to the right 
results in a greater number of detected scenes. Changing the number of 
detected scenes will not invalidate previously-detected scenes that you 
have already used on your Timeline. Each time you regenerate scenes 
based on new detection sensitivity, your scenes are named accordingly, 
e.g. yourmovie.avi (clip 2 of 12) could be generated initially and used 
on your Timeline, but if you later redetect scenes at different sensitivity 
the names would alter to yourmovie.avi (clip 2 of 20). 

This dynamic access to scene detection sensitivity is thanks to some 
information that MoviePlus stores about your media file—the information 
is not stored directly alongside your video file so it is safe to move video 
files from one folder to another without losing scene detection data. The 
scene detection information is compact and does not have any serious 
impact on the amount of hard drive space MoviePlus requires. As an 
example of this efficiency, a home-made vector animated music video of 
2 minutes 30 seconds in duration with approximately 50 "scene cuts" 
results in less than 4KB of additional information being stored on your PC 
after scene detection. 
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The Preview Pane 
The Preview pane will help you check that your movie editing is going 
according to plan... you can preview your project at any time; MoviePlus 
will begin playing your video, will compose a realistic end result from the 
contents of your all video tracks, and will incorporate all transitions, 
effects, and other envelopes on the fly. 

You can even continue editing your project while the preview is playing 
as your edits will be incorporated into the preview in realtime. 

To preview your project 

  Simply click the Play button on the Playback toolbar (shown 
below) or press Space to preview your project. The preview will begin 
from your current caret position. The caret is a vertical line which 
represents your current location on the Timeline (see p.46). To send 
your caret to the beginning of your project, click the Go to Start button 
on the Seeking toolbar (shown below). You can click at any point along 
your ruler during playback to make the preview continue from a new 
point. 
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    The Preview pane itself also offers zoom and pan 
facilities so you can focus on a particular area of your video. Custom Pan 
and Zoom controls are offered at the top left of the Preview pane, Zoom 
In and Zoom Out buttons are the first offered at the right of the pane. 
The Pan button lets you navigate around your “zoomed in” video preview 
with a hand cursor. This is not to be confused with panning for adjusting 
audio balance. 

 The AutoFit button ensures that your preview will fit to the best 
zoom level within the Preview pane. The pane can be resized and 
undocked from its default position; it is particularly useful to be able to 
locate your Preview pane on a secondary screen if you are running a 
dual monitor setup.  

 The next button along at the top of the Preview pane will affect how 
your preview is generated. Many types of project—VCD, SVCD, DVD and 
DV all use stretched pixels... the dots of light that make up the image 
are not square for these types of project, they are rectangular, whether 
the project is regular or a widescreen variant. The amount of stretching 
is described in your project's pixel aspect ratio setting, a number greater 
than one means that the pixels are wider than they are tall. Clicking the 
Stretch Pixels button will ensure that your preview is stretched by the 
same amount that your project is, according to its pixel aspect ratio 
setting. This button is recommended to be always left enabled. 

 The Copy Frame button copies the current frame of your project to 
your Clipboard. The image can then be pasted into other applications. It 
may be useful to copy a frame into an imaging program such as Serif 
PhotoPlus to export it as a still for your MoviePlus project or as part of a 
cover graphic. 

 The final button, Render Quality, determines at what quality your 
movie will be previewed and will determine how hard MoviePlus will work 
to draw your movie. Quality options range from Draft to Best—if you 
are experiencing stuttering playback, especially where transitions or 
effects are in progress, you can reduce the preview quality to improve 
playback speed without harming your project. You can still export your 
end results at high quality even if your preview render quality is set to 
Draft. 

Aside from being able to preview your current project, the Preview pane 
has another trick up its sleeve, too, as discussed in Transforming Your 
Video on p. 90. 
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Seek Controls 

Seek controls in the Seek toolbar allow you to zoom into areas of your 
video source or tracks and to navigate around the frames of your video 
source. For video previewing, the four caret transport buttons on the 
right of the toolbar are of particular importance.  

 

They allow you to move your caret around your timeline to various 
positions on your video track.  

Moving the caret 

You can of course click anywhere along the ruler at the top of your 
Timeline to set the position of your caret—the vertical line spanning the 
Timeline. Your caret position determines the point at which your preview 
will begin playback and the point at which some editing operations such 
as trimming will occur. The position of your caret is also indicated by the 
counter at the top left of the Timeline. 

 To start your preview from the beginning of your project, click 
the Go to Start button and then click Play on the Playback toolbar. 
The Go to Start operation sends the caret to the start of the 
Timeline, also useful if you wish to insert additional sources at the 
beginning of your project. 

  For fine tuning the position of the caret, for instance to 
perform a trim operation at a specific frame of video, you can use 
the Previous Frame and Next Frame buttons on the Seek toolbar. 
Your preview will update any time the caret is moved, so you should 
always use the preview in conjunction with your editing operations. 

 To quickly move your caret to the end of your current sources 
on the Timeline, click the Go to End button. You can then easily 
move objects and have them snap to the caret position conveniently 
located directly after your last Timeline source object. 

The caret position can also be used as a guide when aligning sources on 
different tracks of your Timeline, or to align effect or other envelope key 
frames. 

 



MoviePlus 4.0 Companion | 40 3. Previewing Your Project 

Trick Play and Scrubbing 

A "jog shuttle" function can be used during trick play to vary playback 
speed and direction. In addition, you can manually drag (“scrub”) the 
caret across the Timeline to preview at a rate of your choosing. 

Trick Play 

 

MoviePlus offers a jog shuttle bar that allows you to fine tune the play 
speed and direction by dragging the control arrow. 

Click anywhere along the shuttle bar (at a point matching the speed 
you'd like to preview your project) and then drag the pointer to change 
the speed if you wish, or drag to the centre of the slider to pause 
playback. The further right you click or drag, the faster your preview will 
play. If you click or drag left of centre the preview will being playing in 
reverse, increasing in speed the further left you drag. 

If your preview was already playing before you used the shuttle bar, it 
will continue playing when you release your mouse. If your preview was 
not playing before you used the shuttle bar, the preview will stop when 
you release your mouse and the caret will stay where the preview 
stopped. 

Scrubbing 

Scrubbing might seem an unusual term but it is an extremely useful 
feature! You may already know that clicking along the Ruler above the 
Timeline sets your caret position. The caret determines the start point of 
previews (and the point at which some editing operations will happen). If 
you click and drag along the ruler, MoviePlus will preview your project at 
the speed of the drag—as your mouse passes along the Timeline in 
either direction, the preview will show you the current frame. 

This allows you to pass your mouse over an area of the Timeline to 
preview a specific section without starting and stopping preview 
playback. 

Muting 

Any source can be muted at any time during video preview. You may 
want to temporarily switch off an audio track while you are editing and 
previewing the same track again and again. Equally, you may want to 
mute or “black out” a particular video source while testing your project. 

 



MoviePlus 4.0 Companion | 41 3. Previewing Your Project 

  Muting is possible by switching on or off the Mute buttons on a 
video or audio source, respectively. The buttons are located in track 
headers are illustrated on p. 46. This can also be applied to tracks and 
groups. 

Audio Preview 

 We’ve seen how video can be previewed in a dedicated Video 
Preview pane. Audio can equally be previewed at any time but without 
any dedicated preview pane. Any audio source, track or group can be 
selected and played using the Play button. The Gain (volume) and Pan 
(audio balance) can be adjusted for the duration of the object’s lifetime 
or can be altered over time. 

In terms of playback the audio source is treated as for a video source—
seek controls can be used, along with trick play and scrubbing. 
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Using The Timeline 
The Timeline in MoviePlus can be considered the editing heart of 
MoviePlus, a place where you can organize all your video and audio 
footage, trim or otherwise edit your media, sequence clips one after the 
other, add and edit effects and much more. The Timeline offers the 
equivalent of all the manual editing operations that regular film editors 
need to be able to carry out, and it allows for post-production 
alterations. 

The Timeline has two basic dimensions, height and length. Horizontal 
length relates to the duration of your project... your Timeline has 
markings along a ruler at the top to indicate the passing of time, starting 
with zero at the left of the Timeline. Video or other source media added 
to your Timeline will follow a playback sequence from left to right. You 
can position the start point for previews (or the point at which you'd like 
to perform an edit) using a vertical marker called the caret. During 
playback and some editing operations you will also see a scrolling 
preview marker to indicate the frame that is currently being displayed 
in your project preview. The height of the Timeline is related to the 
number of video or audio tracks used—simple movie compositions made 
from a sequential series of video clips or images with straightforward 
cuts or transitions between them can generally use a single video track; 
you may only need to introduce more tracks if tackling advanced editing 
techniques including overlays, masking, blue-screening etc. An empty 
Timeline may seem as daunting as blank canvas or a blank page, but 
once you have added some media your project is underway.... if your 
project only needs to be simple, then your Timeline can be simple too, 
but when your projects take on a level of complication, MoviePlus's 
Timeline can rise to the challenge! 
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Timeline terminology 

We'll describe some terminology used for various parts of the Timeline 
and your project so that understanding Timeline operations becomes 
clearer. 

 

Timeline elements 

Strips 
Strips are the horizontal "stripes" running the length of the Timeline (to 
the right of the headers section) that can store your 
video/audio/colour/text/image media sources to allow you to edit and 
arrange them, as well as being a place where you can edit effects, 
transitions, and envelopes. There are different kinds of strips—master 
groups, groups, video and audio tracks, and hideable strips for each and 
every source, envelope, effect, and transition. Each strip is accompanied 
by a header to its left. 
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Headers 
Headers are like little "control panels" for the strip they are attached to. 
In the case of tracks and groups, adjustments to the header can affect 
all the tracks in a group or all the sources on a track (or both). You can 
adjust sliders (double-click to reset to default values), Mute (and 
unmute) strips to disable or enable their contents in the project 
composition, Solo a strip (disables other strips of the same kind), and for 
video tracks you can adjust the video Blend Mode. 

Component 
Component is a general term for any part of your composition. It may be 
a source (video clip, audio clip, or image), track (video or audio), or  
group. Double-click a component's name in the Header area to rename 
it. 

Source 
A source is a media element; an "object" you can place on your Timeline 
for inclusion in your video project. Sources can include video files, audio 
files, colours, text, and images. It's important to appreciate the 
difference between sources, tracks and groups because MoviePlus will 
allow you to add effects, for instance, to each or all of them with 
differing results. 

Track 
A track is just a straightforward combination of a single audio or video 
strip and its header. You can add multiple clips to a track by dropping a 
multiple selection from the Explorer pane onto your track header and 
they will be added to the Timeline in succession with a default overlap. 
You can apply effects and envelope adjustments (like opacity or a 
transform) to tracks, which will have a resulting effect on all the clips on 
that track. MoviePlus supports multiple audio and video tracks so that it 
is possible to compose more complicated projects with "layers" of video 
using fades (or other methods of achieving transparency) to reveal 
underlying layers. Within the header region you can drag a track's upper 
or lower edge to increase its height for easier editing or to save space on 
your Timeline. 

Group  
MoviePlus supports audio groups, video groups and effects groups. They 
are not only a way of keeping complex compositions tidy, you can also 
choose for effects—including the partial revealing of video using masks—
to be applied to selected tracks only by placing them inside a group. The 
View menu also has an option for showing or hiding Master Groups, a 
top-level group to allow you to mute, apply effects to, or adjust 
volume/opacity for all video or all audio at once. See Using Groups on 
p. 60. 
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Key Frame View 

  When you add an effect to a source, track, or group, or when 
you click a Show/Hide Envelopes button, you will automatically be 
shown the Key Frame View at the bottom of the Timeline—the Key 
Frame View is a collection of one or more strips running across the 
bottom of the Timeline. Each strip allows you to induce change over 
time, whether it's a change in an effect, a change in opacity (or audio 
volume), a transition, or source properties. The points in time that you 
specify such change are represented on these strips by Key Frames 
( or  (darker) when selected). 

   You can change whether the Key Frame View is displaying 
envelopes strips, effects strips or transition strips for a given component 
by using the selector buttons at the bottom-left of the Key Frame View 
area. 

Key Frames 
Key Frames are points along an envelope strip, effects strip, or transition 
strip that allow you to specify envelope, effect or transition properties. 
The Key Frame stores your chosen settings for use at a specific point of 
time along your Timeline. Using more than one Key Frame along a strip, 
MoviePlus automatically (and gradually) changes from one Key Frame's 
settings to the next Key Frame's settings as time passes between them. 
On an opacity envelope strip, for example, a Key Frame at time zero 
with a setting of 0% opacity followed by another Key Frame two seconds 
later with a setting of 100% would cause a gradual "fade in" effect over 
a period of two seconds. The Key Frames can have their properties 
modified in the Properties pane when selected, they can be moved along 
the Timeline to different points, and you can alter the rate of change of 
values between Key Frames (right-click the Key Frame and choose a 
curve type). See Opacity Envelopes on p. 74 where Key Frame are 
described fully. 

Timeline Splitter 
The Timeline Splitter is a movable junction between the main body of the 
Timeline and the Key Frame View (when it is on show). You can drag the 
splitter up and down to dedicate more screen space to either the main 
Timeline strips or the Key Frame strips for envelopes, effects, and 
transitions. 

Caret 
The caret, the blue vertical line you can see spanning the height of the 
Timeline and its ruler, is most easily thought of as your editing marker. 
You can click in the ruler at the top of the Timeline to position your caret 
in order to perform an edit (such as splitting a source, allowing you to 
delete portions of your video or audio). Drag the caret along the Timeline 
to preview your project at the speed of your mouse drag. Click and drag 
sources to the caret to accurately position them in your project. 
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Ruler  
The ruler runs along the top of the Timeline and shows you the current 
time range for the visible part of your project. You can zoom in or out of 
the Timeline using a mouse wheel to display more or less of your project 
Timeline on screen. Dragging your mouse along the ruler will preview 
your project at the rate at which you are dragging your mouse; a single-
click on the ruler will position the caret marker for editing or playback 
operations. You can alter your ruler units using the View menu's Ruler 
Units flyout. The default setting shows Hours, Minutes, Seconds and 
Frames (of video). 

Counter  
The counter sits at the top-left of your Timeline and shows you the 
current preview position, which is often also the current caret position 
for editing operations. The default format for the counter is to display 
Hours, Minutes, Seconds and Frames (of video), but if you modify your 
Timeline ruler units as described above the counter will follow suit. 

Preview Marker (not illustrated) 
Like the caret, the preview marker is a vertical indicator of your playback 
position during playback. During playback, your caret, used for editing 
functions, remains in place until the playback is paused, while the 
preview marker scrolls along the Timeline to represent your preview 
position. 

Drop target (not illustrated) 
When adding media to your Timeline, the drop target is shown as a 
hollow grey box. It represents the current position of your media on the 
Timeline if you were to release the mouse button. You can hold Shift on 
your keyboard when a drop target is on your Timeline to prevent it 
straying up or down to other tracks. 

Selections and indicators 

Selections (not illustrated) 
MoviePlus naturally draws selected components differently to unselected 
components, so you know what you are editing when you perform an 
editing operation! Timeline sources (such as video and audio clips) are 
drawn with a red outline when selected, tracks and groups get their 
names highlighted when selected, Key Frames turn red... and while you 
are working with a component's Key Frames, the component you are 
modifying remains underlined in red. 

Source indicators and handles  
Sources have some useful features in addition to the preview-like "poster 
frames" running along their length. A green (or red) LED in the top-left 
corner indicates whether a source, track, or group is included in the 
composition or if it is temporarily disabled (muted). If you mute a track, 
the track header and each source on that track would show a red LED to 
indicate that they are not being rendered. 
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 If you have applied an effect to a source, track, or group, it will 
display an illuminated lightning bolt.  

Sources also have blue triangular handles at each end that can be 
dragged to introduce an automatic fade (the fade can be replaced with a 
different transition by dragging and dropping a transition preset onto the 
source's transition bar). 

View controls in headers 

 

The topmost circled control shown above either expands or collapses the 
contents of a track. As an example, the Main Video Track above is 
collapsed (click + to expand) and the Audio Track is expanded (click - to 
collapse); the two sources on the audio track (brass.wav and 
brass2.wav) now have their own strips and headers on view. You can 
hide all source strips by collapsing the header. The lower circled control 
minimises and restores the height of the track, to either allow more 
room for editing (or bigger poster frame previews along video sources) 
or to minimise to save space on the Timeline. As an example, all the 
strips above are standard height except for the brass2.wav source strip, 
which is minimised. 

The same control operations are used on headers for audio or video 
groups and master groups. 

Timeline Zoom and Scroll 

When you have sources on your Timeline it is important that you can 
view you project and sources at a suitable magnification. The Timeline 
zoom and scroll functions help you do this by button use, mouse scroll or 
keyboard shortcut. 
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 To see more detail on your Timeline to make it easier to perform 
fine edits, click the Zoom In button, scroll your mousewheel upwards or 
select Control and +.  

 To see more of your project in the Timeline area, click the Zoom 
Out button, scroll your mousewheel downwards or select Control and -. 

 There may be times when you would like to see your entire project 
within the available Timeline area—simply click the Zoom to All button. 

 If your caret is out of view due to a zoom operation or playback of 
your project preview, click the Scroll to Caret button. 

Selecting Objects 

When you are editing your movie and have already added a range of 
media clips to your Timeline, all your editing operations (including 
moves, trims, properties changes and other adjustments) are carried out 
on the selected object(s). So, let's cover how you go about selecting 
objects! 

Selecting single sources 

The good news is that you can simply click on components to select 
them. A regular single-click of the mouse! Whether it's a group, track, 
video source, audio source, image, text item, a click will underline the 
component's name in red (and outline the object in red if it is a source) 
to show you that it is selected. 
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Component or object 
appearance

Selection status

 

Source not selected 

 

Source object has been clicked and 
is selected. You can now modify its 
properties in the Properties pane, 
and if you click any of the editing 
function buttons (e.g. Set Start 
Time, Split etc.) the edit will apply 
to this selected object. 

 

The transition for this source object 
is selected. The underlined object 
name indicates that this source is 
associated with the specific item 
being edited (the transition). 

 A Key Frame on an envelope strip, 
effects strip, transition strip, or 
colour/text source strip. Selecting a 
Key Frame will change its colour 
from grey to red. 

 

A selected track. Other strip 
headers (source strip, effects, 
envelope and transition strip 
headers) follow the same look for 
selection; the name is highlighted 
and underlined. 

 

This track is having one of its 
properties modified. It's likely that 
an opacity or transform Key Frame 
is actually selected, but you can tell 
it is this track being modified 
because its name is underlined. 
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Selecting multiple sources 

You can select multiple sources on your Timeline (to move or otherwise 
edit multiple source objects at once) by two main methods: 

• Hold Control on your keyboard and click each source you would like 
to include in the selection. Control+click a source a second time to 
remove it from the current selection. 

• Hold your primary mouse button down and drag a rectangle on your 
Timeline—anything touc

 
hing (and also anything inside) the rectangle 

will become selected. 

 

ty, 
or move a few sources earlier or later along the Timeline. 

ture of your Timeline 
for continues easy editing, you can create a link. 

Selecting Linked Objects 

s 

election border as for selecting a 
single source, even when part of a link. 

ther 

ning, you will need to know something about arranging your 
sources. 

Multiple selections allow you to link items together for editing uni

To make your multiple selections a permanent fea

When any object linked to another object is selected, the linked item
adopts a pale red selection highlight. This pale red selection border 
means the linked objects are not actually selected but edits will affect it. 
The selected object displays with a red s

Arranging Sources 

Just like when you are arranging text and pictures in a printed 
newsletter design or when creating a Web site, arranging sources on 
your movie Timeline is crucial to building interesting projects—whe
you would like to drag and drop fifty photos onto your Timeline to 
quickly build a slide show or you would like to create a rich layered 
project with motion transforms, transparency masks or professional 
blue-scree
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Tips! 

Snapping 

Snapping is a design aid that helps you achieve neat layouts. When you 
are moving objects around on the Timeline (or trimming/stretching 
them), snapping makes your edit jump to the nearest object, to the 
editing caret, to the beginning of the Timeline, and to a default overlap 
value. 

To turn snapping on and off, click the  Snapping button on the 
Editing toolbar. To control which elements do and do not get snapped to, 
or to adjust snap sensitivity, visit the Snapping tab in the Tools > 
Options dialog. Hold down Alt during your editing operations to 
temporarily switch Snapping off (or on, if disabled). Note that when you 
are moving a multiple selection of sources, only the source dragged will 
snap to other Timeline elements. 

Naming source objects 

When you select a source, its name and some other properties are 
displayed in the Properties pane. You can rename any item here; it will 
only affect your MoviePlus project, not the source media files as found 
on your hard disk or network. Naming source objects this way in 
MoviePlus can make it easier to identify components in your 
composition; you may find this especially useful if working with detected 
scenes in the Explorer pane, as scene names originally all begin with the 
name of the file they were detected from. 

Simple arrangement—sources following one another 

When you want one clip—a video or image—to directly follow on from 
another clip, they need to butt against each other on the Timeline with 
no space in between them. When one "scene" follows another in this 
way, it's often referred to as a "cut" although you don't need to get the 
scissors out to achieve it with MoviePlus. 

 

Simply drag sources along on the same track so that they are positioned 
next to each other. When two sources are close together the one you are 
dragging will snap into place depending on how snapping is set. 
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Adding multiple sources one after the other 

MoviePlus supports the addition of multiple sources to your Timeline in 
one operation. All the selected sources will be added to one track and 
will overlap each other by a default amount (normally 1 second). With 
Auto Transitions enabled (see p. 132), each overlap will include an 
automatic cross-fade transition. You can drag and drop an alternate 
transition from the Transitions gallery pane to introduce some variety 
to your show. 

To alter the standard overlap value, adjust the setting on the Tools > 
Options dialog's Editing tab. 

Making one source appear on top of another 

MoviePlus uses multiple tracks in a similar fashion to the way photo-
editors (such as Serif's own PhotoPlus) use multiple layers. The question 
of whether you need to use multiple layers—or tracks in the case of 
MoviePlus—can be answered in the same way for both types of 
program... many compositions are perfectly fine with one "layer" but you 
can introduce some interesting effects by layering your images or videos 
on top of each other. 

MoviePlus composes your video based on Timeline content, working from 
the top downwards. If you have multiple tracks in your project with a 
full-size video on the top layer, it could well obscure all underlying tracks 
because you can't see through it... but if your top-most track (or sources 
on it) contains text sources, video or images with reduced opacity, 
resized video or images using a Transform envelope, video with a 
mask applied or a Chroma Key effect, you will be able to see through 
to underlying tracks.  

So, to make one source an overlay appearing on top of other sources, 
you need to add an additional video track. Use the Insert menu to add 
more tracks to your project. Place the video or image you would like to 
appear as an overlay on the top track. All tracks support images or video 
with transparency, and all tracks follow the same Timeline, so 
components are almost as easy to arrange when using multiple tracks as 
they are for single-track projects.  

Click the Samples button in the Explorer pane and select the Overlays 
folder to see a range of images that can be used as overlays in your 
projects. The MoviePlus Studio Effects DVD needs to be installed to see 
this folder. 
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Linking sources together 

Automatically-linked sources 

When you add a video file to your Timeline from the Explorer pane, you 
will normally find that two sources are added to your Timeline—one 
video source and one audio source, on a video and audio track 
respectively. This is because the video file contained both an audio and 
video stream that MoviePlus has separated for you for editing purposes. 
Because these two streams came from the same location, MoviePlus 
automatically links them together. When sources are linked, edits to one 
of the components will affect other linked components. If you select your 
video source and perform a Split, for instance, the linked audio source 
will split in the same place. 

Linked items that are on different tracks will still move to new spots on 
the Timeline providing there is enough space on each track for your 
sources to relocate to. 

Manually-linked sources 

You can manually create, edit, and destroy links of your own, too, to 
make a collection of sources easier to move or otherwise edit. The 
operations described below as being available in a right-click menu are 
all also available in MoviePlus's Edit menu. 

Creating a Link 
Select multiple sources as described in Timeline Zoom and Scroll on p. 
50, right-click over one of your selected sources and choose Create 
Link from the Link flyout. 

Adding or removing a source from a Link 
Right-click the single source object you would like to remove from the 
Link (or Control+select multiple items from the link) and choose 
Remove from Link in the right-click menu's Link flyout. 

Destroying a Link 
To dissolve or destroy a Link, right-click any source object in the link and 
choose Destroy Link in the right-click menu's Link flyout. 
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Temporarily disabling linking 

 There are occasions where you may find the need to temporarily 
disable Linking, for instance when trying to trim sources that are part of 
a link where other linked sources start or end outside the range of the 
source you are editing... in such instances some editing functions are 
unavailable because they cannot be applied to the entire contents of the 
Link group. In such instances you would need to switch Linking off using 
the Linking button on the Editing toolbar, perform your edit, then switch 
linking back on using the same button. 

Rippling 

 Rippling is a design aid that takes some of the headache out of 
making room on your Timeline, or taking up slack (empty) space on the 
Timeline, keeping your sources' relative positions constant when you 
make edits. Rippling saves you the effort of manoeuvring multiple 
sources for the sake of what is often a minor edit, perhaps to make room 
at the start of your project for titles or a new intro or the deletion of a 
section of video from the middle of a project. You can enable and disable 
Rippling using either the Rippling button on the Editing toolbar, or by 
using the commands on the Arrange menu. 

Moving sources 

Rippling affects other sources starting at the same time or after the 
source you are moving; when you move a source, those other sources 
that start at the same point or later on the Timeline will shuffle left or 
right to account for your move. 

When trimming or extending the end of a source 

Rippling only affects other sources that both start after your edited 
source starts and end after the end of your edited source. 

When trimming the start of a source 

Rippling affects other sources that start and end after the start of your 
edited source, and it also moves your edited source to the same "start 
time" it had before you trimmed its start, shuffling other affected 
sources at the same time. 

Ripple mode 

Rippling can be set to work in one of three modes: it can affect the track 
you are working on, all tracks of the same level (e.g., within a group), or 
all tracks on the Timeline.  
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Rippling with complex projects 

For complex multi-track projects, you might worry that Rippling won't 
manage all the necessary moves—don't worry, Rippling works regardless 
of the number and type of sources or tracks involved. Providing you 
have selected the appropriate ripple mode, you can move a large 
number of sources that span multiple tracks by having Rippling enabled. 
Be sure to select an appropriate Timeline zoom level when selecting and 
moving your sources—you may wish to use a low zoom level (too see all 
of your project) to make the move easy, but you might find that using a 
higher zoom level (seeing just a few small sources) allows you to more 
easily select and drag the correct source. MoviePlus will automatically 
scroll the Timeline in the direction of your drag until you centre your 
mouse to choose a "drop zone", but you could instead type a new start 
time for your selected source in the Properties pane—Rippling works 
however a source is moved. 

Adding and Arranging Tracks 

To get started quickly, MoviePlus is supplied with a single video and 
audio track already present on the Timeline by default. These empty 
tracks will allow a video source to be dragged onto them from the 
Explorer Pane. 

Adding more tracks 

To create new blank tracks in your project to accommodate layered 
audio, video, titles, or images, choose Video Track or Audio Track 
from the Insert menu. 
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Changing the track order 

To reorder your tracks to achieve the desired effect, drag the 
appropriate track header further up or down the stack of headers at the 
left of the Timeline. You will be shown a grey line where your track will 
be inserted when you are to release the mouse button. 

 

Modifying the track/strip height 

Track headers are accompanied by track strips along the Timeline, each 
header is next to its track strip. You can alter the height of these strips 
to either save space in your Timeline view, or to get a bigger view of 
your sources' poster frame previews along the track. Position the mouse 
cursor over the bottom edge of a track's header and drag your mouse to 
resize it. During a resize it will "snap" to its original height for ease of 
use. 

  You can also reveal "child" strips for any track by clicking the 
Expand button at the left of the header. In the case of tracks, this will 
reveal the source strips for each source on the track. Source strips aren't 
often required but can be useful for modifying source properties using 
Key Frames in the case of text and colour sources. Similarly you can use 
the Collapse button to hide these strips. There's also a Collapse 
shortcut in the View menu, as well as a shortcut to Minimize/Restore 
Tracks rather than using a manual method to alter track height as 
described above. 
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Using Groups 

Groups serve a couple of important functions in MoviePlus... firstly they 
can help keep related tracks—perhaps specific sections your 
composition—together for easy management. Applying an effect, for 
instance, to a video group means that all tracks and sources within the 
group inherit the effect. This is a very quick way to make an entire 
multi-track portion of your project greyscale or have a dream-like diffuse 
glow. 

The next main function for groups may be even more useful: limiting the 
range of a transparency effect or mask. Masks and the Chroma Key 
effect are both methods of achieving transparency. The Mask blend 
mode or Chroma Key Effect applied to the top-most track in your project 
will affect transparency on tracks below it; to limit which tracks are 
affected, store the track with blend mode or effect applied (and other 
tracks you want affected) within a group, leaving tracks you do not want 
affected outside the group, as shown below. Looking at the track names: 
in the example below, the Fast-paced Video is not subject to the oval 
clipping that the Mask Track is performing because it is outside the video 
group—the mask’s effect is limited to tracks within its video group. 

 

Only the track containing the image of the girl is in the same group as 
the mask; here the Image track is masked but the video track outside 
the group is unaffected. 

Adding Video or Audio Groups 

Once you have arranged some sources on your tracks and you feel it is 
time to place them inside a group (either to tidy your composition or set 
the range of tracks an effect will be applied over), insert a video or audio 
group by using Insert>Video Group or Insert>Audio Group. 
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You then need to drag the appropriate track header into the group at the 
left of the Timeline. 

Hiding and revealing a group's tracks 

  You can click the Collapse button to hide the contents of the 
group on the Timeline, saving the equivalent height of two tracks in this 
case (because the group contains two tracks) to make more visible area 
for more recent edits. This organizational function does not harm your 
project, it merely keeps tracks hidden out of harm's way until you would 
like to reveal them again (by pressing the Expand button). Tracks within 
a group are often called children. Applying an effect to a group as 
described above, the group being the parent, affects its children. 

Applying Effects to Groups 

Video effects 

You can apply all of MoviePlus's video effects to a video group by 
dragging and dropping an effect thumbnail from the Effects pane onto 
the group header at the left of the Timeline. 

Video opacity 

You can adjust the opacity of a group by revealing its opacity 
envelope. This will allow you to fade the result of an affected section of 
video organized within a group, for instance, or to make a series of still 
image overlays appear translucent—without having to edit each source 
or track in an identical way. For more information about revealing and 
editing an opacity envelope, please see Opacity Envelopes on p. 74. 

Transforms—perspective, scaling, and motion 

You can apply transforms, such as perspective effects, resizing, or 
animated motion, to video groups. Such an effect would allow for the 
composite result of a group to be used as an inset video, for instance. To 
learn how to edit a transform envelope, please see Transforming Your 
Video on p. 90. 

Mix back—blending affected video with original unaffected video 

Mix back is a term used to describe the blending of video with effects 
(affected video) back with the unaffected original video. This is 
extremely useful, as most effects do not offer "opacity" (strength of 
visibility) of their own. As an example, the Threshold effect on its own 
has no setting which is "nearly visible"... the effect renders video as 
black and white only, and the adjustment available (in the Properties 
pane) determines how much of your video is white and how much is 
black. To blend such an affected video with the original: 
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• Use the Insert menu to insert an effects group (remember to 
first select the appropriate (affected) source, track or video 
group). 

• Add the effect and any others you wish included to the effects 
group by dragging and dro

 
pping them in the Key Frame View 

area, below the Timeline. 

• 

3, covering the use of an opacity envelope on an effects 
group. 

s! 

 
ee Adjusting Volume and Balance on p. 117 for more 

information. 

ideo in your project by 
applying it to the master video group. 

hould leave the Show Master Groups option unticked in the 
View menu. 

Copying and Pasting  

an 

 the 
opacity envelope of another video source by copy and paste.  

Click to the right of the effects group's header in the Timeline 
region to add a Key Frame, moving it up or down to affect the 
level of mix back. For more detail, please see Applying Effects 
on p. 12

Audio Groups 

Audio groups differ slightly in that they do not work with video effect
But you can add audio tracks to audio groups to adjust overall gain 
(volume) or pan (stereo balance). Click the group's Show/Hide 
Envelopes button to access the Volume and Pan envelopes. Envelopes 
allow for simple adjustments as well as introducing changing levels over
time; please s

Master Groups 

Master Groups are an option available in the View menu, i.e. they 
always exist but you can choose whether they are on view in your 
Timeline header region or not. There are two Master Groups, one for 
video and one for audio. The Master Groups each encapsulate all the 
video and audio of your project so you can adjust the master volume, for 
instance, by adjusting the volume envelope for the master audio group, 
or apply a final video effect to the entirety of the v

If there's no need to affect all the audio or all the video in one fell 
swoop, you s

For envelopes, effects or transitions 

An envelope, effect or transition can be copied by selecting its header 
and choosing Copy. When an envelope is copied to the clipboard, it c
be pasted to another object to replace the existing envelope of that 
object, e.g. an opacity envelope from one source will overwrite
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If an envelope or effect is copied and pasted from one source to another 
source further down the Timeline, the associated key frames will be 
offset so they are relative to the new source. Otherwise they will end up 
at the same absolute time they were before. 

Note that transitions can only be copied and pasted to replace another 
transition. 

Drag and Drop is fully supported in the copy and paste process. Select 
an envelope or and effect and drag to a new source. In addition, use the 
Control or Shift key to select multiple envelopes and effects and then 
drag them to other sources. 

For Keyframes 

Any selected key frame can be copied to the clipboard. Simply select a 
single key frame or multiple key frames with the Control key.  

When keyframes are on the clipboard, they can be pasted into any  
envelope, effect strip or transition strip of the same type they came 
from. They will be pasted at the current caret location. 

Copying between Sources, Tracks, Groups 

We’ve looked at copying envelopes and effects between sources. 
However, the flexibility of MoviePlus allows you to also copy between 
sources, tracks and groups at any time.     

Trimming and Splitting 

With audio or video clips, both duration and playback speed come into 
play. Most often, you'll want to shorten a clip without altering its 
playback speed—this is usually called trimming. For example, source 
media files seldom begin or end exactly where you'd like; there may be 
extra frames at the beginning or end, or you may want to use a short 
section from the middle of the file. The solution is to trim the media 
file—adjusting its in-point and/or out-point to include just the piece you 
want. 

When you trim a source, it takes up less space on the Timeline, and the 
movie as a whole gets shorter. You may need to adjust other sources to 
fill in the gaps this creates. 

You can also perform cuts just like a film editor using the Split 
command. 
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Simple trimming with mouse drag 

Trimming the start of a source 

 Position your mouse cursor over the left edge of the source object 
you want to trim so that it changes to the Set Start Time cursor, then 
click and hold your primary mouse button. Drag the mouse to the right 
to trim away the start of your source. 

Trimming the end of a source 

 Position your mouse cur sor over the right edge of the source object 
you want to trim so that it changes to the Set End Time cursor, then 
click and hold your primary mouse button. Drag the mouse to the left to 
trim away the end of your source. 

Note about dragging to trim 

If you drag the start of a source to the left, or the end of a source to the 
right, you are increasing its duration on the Timeline. By default 
MoviePlus will maintain the original play speed and loop the source (if it 
is a video), making playback loop from the original start or end time. 
This stretching of video, as opposed to trimming, is covered in 
Stretching and Speeding Up on p. 69. 

Trimming to a specific frame 

If you would like to perform an accurate trim while dragging, position 
your caret at the exact position you want to trim to, then drag the edge 
of your source to the caret—as you approach the caret the source will 
snap to it (unless Snapping is disabled). Trimming occurs before the 
visible frame, so if you want to trim at a scene break, ensure you 
position the caret so that the first frame of the new scene is visible.  

Fine tuning trimmed video in and out points 

Once a video is trimmed it has artificial start and end points because 
they are different to the original source media. To see your trimmed 
video as a fraction of your original video it helps to view the trimmed 
and original sources alongside each other. You can achieve this by 
revealing the source strip as discussed in Looping on p. 66. 

Trimming to a specific frame 

Accurately trimming the start of a source 

 Select a source, position your caret at the point you want to trim to 
and click the Set Start Point button (or press I on your keyboard, 
representing "in-point"). 
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Accurately trimming the end of a source 

 Select a source, position your caret at the point you want to trim to 
and click the Set End Point button (or press O on your keyboard, 
representing "out-point"). 

Splitting a source 

 Select the source you would like to split, use the ruler and/or seek 
controls to position the caret at the point you would like to make the 
split, then click the Split button or press S on your keyboard. You can 
perform multiple splits to create distinct sections of your sources for 
deletion. 
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Extending and Temporal Effects 

Looping 

When you are manipulating sources on your Timeline, it is extremely 
easy to make video and audio sources loop or repeat themselves. Like 
trimming, you will most probably find that looping, freeze-frames (static 
extensions), or the speeding up or slowing down of video and audio are 
common tasks. Other kinds of sources, such as text, colour and images 
can all have their duration changed but do not loop or repeat. 

Looping a video or audio source 

To make your video or audio sources begin repeating, select your source 
and change the Repeat Mode to Loop in Source properties. To set the 
number of loops, simply grab one end of the source on the Timeline 
using your mouse and drag it outwards, making the source object 
longer. If dragging the right-edge, the source will begin "playing" again 
after its original end point. If dragging the left-edge, the source will end 
and restart at its original start point. 

As your source is extended, you will see small yellow markers along the 
bottom of the source object; these indicate the repetitions or loops. The 
black triangles along the top of the source merely indicate the position of 
the "poster frame" previews. In the sample below, we've stretched the 
right edge of a source video until it is looped and will play fully five 
times. Note the "trim" cursor shown during this operation; we are 
effectively "untrimming" the video.  

 

Looping a trimmed source 

You may be asking yourself that if looping is effectively untrimming, 
won't a straightforward drag as described above actually untrim your 
trimmed sources, instead of making the shorter, trimmed source loop? 
Yes, a straightforward drag as described above would untrim your 
trimmed sources. It can be overcome so that trimmed sources can also 
easily repeat. 

To make trimmed sources loop, repeating the remaining video or audio 
only, hold Shift while dragging the edge of your source. 
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Seeing the whole picture using the source strip 

To gain a direct appreciation of the length of your source media files, the 
length of the source as it appears on the Timeline, and what is being 
repeated, you can reveal the source strip. Double-click on any source to 
display it in a strip of its own underneath the track it appears 
on.

  

In the example above, the displayed source strip allows for some fine 
editing. A 15 second video clip has been trimmed to approximately 4 
seconds in length by dragging both the left and right edges inwards (see 
Trimming and Splitting on p. 63 for more details). The section labelled 
"Trimmed source" represents the duration of the trimmed media—the 
shaded regions left and right of the trim region represent original video 
we could reintroduce by "untrimming" our clip. The right-edge of the 
trimmed source was then dragged to the right while holding Shift, 
otherwise we would indeed have untrimmed the trimmed clip; holding 
Shift while dragging to the right maintained the trim region, increased 
the duration, and kept the play speed normal. 

You do not need to reveal the source strip to be able to perform the loop 
operation, but it may help you see which section of a trimmed source is 
being repeated when working with trimmed video sources. 

Time shifting 

 You can change which section of your original video source is being 
played within the trimmed region, without altering the position of your 
trimmed source on the Timeline, by clicking where the special cursor is 
and dragging left or right. You can imagine that the trimmed region is a 
small window that can only "see" a small region of the landscape of your 
video. The drag we've described means you can move the landscape left 
or right to change your view, leaving the window where it is; this has the 
effect of shifting the trimmed video's in- and out-points relative to the 
original video source. 

 



MoviePlus 4.0 Companion | 68 4. Editing Video and Audio 

Static Extensions 

Also called freeze-frame, a static extension is a useful way to begin or 
end a clip. A static extension of the first frame could allow for a fade in 
or other transition, a zoom to give the subject emphasis, or a 
background against which titles can be overlaid. A static extension at the 
end of a clip similarly allows time for a transition, a background for 
credits etc. 

Some special editing effects may also call for a static extension, to allow 
you to freeze the action while overlaying a cool particle system special 
effect made with Serif's ImpactPlus, for example. 

Applying a static extension to your sources 

To make your video or audio sources extend, select your source and 
change the Repeat Mode to Static in Source properties. To freeze either 
the first or last frame, simply grab one end of the source on the Timeline 
using your mouse and drag it outwards, making the source object 
longer. If dragging the right-edge, the source will "freeze" the final 
frame. If dragging the left-edge, the source will freeze the first frame.  

As your source is extended, you will see a small yellow marker indicating 
the original start or end point of your source before your static extension 
was applied. The black triangles along the top of the source merely 
indicate the position of the "poster frame" previews. In the sample 
below, we've stretched the right edge of a source video until it is 
extended by 50%. Note the "trim" cursor shown during this operation; 
we are effectively "untrimming" the video.  

 

Because extensions like this (and looping/repeating) are like 
"untrimming" video, what happens when the video has already been 
trimmed, how do we stop the extension from untrimming the source? 

Extending a trimmed source 

To make trimmed sources extend, rather than untrim, when their edges 
are dragged, hold Shift during the mouse drag. Release the mouse 
button before releasing Shift to extend your trimmed clips. 
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Stretching and Speeding Up 

As with looping/repeating and "freeze frame" static extensions, 
simple drag operations on the Timeline can perform intricate editing 
operations. Being able to speed up or slow down the rate of play of your 
video and audio sources is another powerful editing function that 
MoviePlus is able to offer. 

When a video plays faster or slower, it has a shorter or longer duration, 
respectively. This means less space on your Timeline when played faster 
and vice versa. 

To increase or decrease the play rate, hold the Control key down and 
drag an edge of your video source inwards or outwards, respectively, i.e. 

.   

You can also use the Properties pane to adjust the Play speed, though 
this will affect the length of your source on the Timeline. 

 



MoviePlus 4.0 Companion | 70 4. Editing Video and Audio 

Fade and Transparency 

Transparency & Opacity 

Transparency and opacity are intrinsically linked, like different sides of 
the same coin. Opacity means a state of being opaque, you cannot see 
through a video or other source to those underneath it if it is totally 
opaque. By contrast of course, you can see through video that is 
partially or wholly transparent, or has regions that are partially or wholly 
transparent, with no opacity. MoviePlus generally refers to opacity rather 
than transparency, but you should keep both concepts in mind during 
your editing to help understand various features such as Chroma Key 
(blue screening) and masks. 

Let’s firstly take a look at different ways in which opacity can be used on 
whole sources, tracks, groups and effects in MoviePlus. A general level of 
opacity can be applied to: 

• allow you to "fade" video or images in and out of vision over 
other video sources. This uses an opacity envelope. 

• a whole video track, to make a collecti on of sources more or 
less visible, using an opacity slider. 

• 
e 

ion. This uses an opacity slider in a video 
group header. 

• 
header. 

A specifi

• ured background (also called matting, 
blue-screening or colour keying). This is achieved using a 

• Creating a limited region for an effect to be applied over, e.g. 
fect to a subject's face rather than the 

whole video, also using a mask. 

a group of tracks, so that the composite result of a collection of 
grouped tracks can be made less or more visible as part of th
overall composit

video effects (i.e., mix back to blend original with affected 
video). This uses an opacity slider in an effects group 

c region of transparency or opacity can be created for: 

Removing a solid-colo

Chroma Key effect. 

• Creating a cut-out region, using a mask. 

only applying a mosaic ef

• Cropping using a mask. 
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For a preface to the concepts involved in removing a specific regi
video, see 

on of 
 on p. 77. 

information on Opacity Envelopes and Chroma Key 
/Blue Screening) see p. 74 and 85, respectively. 

ovie. Of course the same operation with 
the fade in the other direction—fading in—is also extremely popular way 

sed to fade between two 
adjacent video sources (see Applying Transitions on p. 131). However, 

e transition, by default, is applied to the 
start or end of your video source, respectively. 

Where your project is simple in its composition, i.e. not composed from a 
rge number of video tracks/groups, there is a very simple way to fade 

your video in or out from a solid black background. 

Removing Backgrounds and Creating Cut-outs

For more 
(Matting

Fading 

Fading your video out to a background colour is a popular method of 
ending a scene or even the m

to start a movie or a scene. It's a simple and understated effect that 
doesn't go out of fashion! 

Fading in or out uses cross-fade transitions, as u

for fading in or out, a Cross-Fad

Simple fading from or to black 

On the lowest video track 

la

 

 

 

 

ft) shows a triangular 
transition handle on the left-hand side of the source. This handle can 

ion. 

These simple methods take advantage of existing transition functionality 
k 

 

To illustrate a fade-in, the video source (above le

be dragged to the right to create the fade in. The extent to which you 
drag the transition will set the fade-in durat

Conversely, if you wanted to fade out to black, drag a transition handle 
at the end of your video source to the left. 

present in MoviePlus. In addition, we also use MoviePlus’s default blac
background to full effect. 
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A fade from or to black by this method will only work on the bottom 

 video tracks 

 other video tracks, use one of the methods described 
below. 

o tracks or to fade to a different 

Addi

• 
t-hand side 

• Using a fade out as an example, drop the colour source adjacent to 
ag the colour source 
an automatic cross-fade 

video track in your Timeline composition. 

On other

To fade to black on

Fading to a colour 

To either fade to black on other vide
colour, use a Solid Colour Source. 

ng a colour source to your Timeline 

Click the Sources tab to display the Sources pane and select Solid 
Colour from the list at the left of the pane. From the righ
of the pane, drag a colour of your choosing onto your Timeline. 
Don't worry if the colour you want is not amongst the presets, it's 
very easy to change the colour of a colour source later. 

the video you want to fade out from then dr
over the end of your video source to create 
transition. 

 

 
 see the extent of the overlap. 

lap. 

Conversely, to fade in to your video from a solid colour, place the colour 
source to the left of a video source and drag it to the right to overlap 
your video source's left-hand end. 

The dashed line at the right end of the transition marks the point at
which the video source ends, so you can

To increase or decrease the duration of the transition, adjust the amount 
of overlap by dragging either end of the colour source, altering its 
duration and the extent of the over
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If the source you want to fade in to is already at the left edge of your 
Timeline, leaving no room for a new colour source at the beginning of 
the Timeline, you should move your video source to the right on the 
Timeline, creating some room at the start of your project. If you have 
already created a complex composition with multiple sources and 
tracks—so moving the first video source would disrupt the rest of your 
project—MoviePlus can move all of your later sources at the same time 
when a source is dragged. This automatic moving of sources is called 
Rippling (see p. 57 for more infomation).  

To extend the length of time the colour source is displayed before your 
video starts fading in, drag its left edge further to the left.  

Changing the colour of a colour source 

Click the colour source on your Timeline to select it. Its properties will be 
displayed in the Properties pane. 

Either...

Click the Colour sample in the Properties pane to open the Colour Picker 
and select a colour from the colour wheel. Select a specific tone from the 
square inside the colour wheel and click OK... 

or...

Click and drag the colour pickup pipette to the right of the Colour sample 
in the Properties pane. Move the pipette cursor over any part of the 
screen to select a colour, releasing the mouse button when you've 
located the colour you would like to use. 

Saving a colour for future use 

 When you have altered a colour source to meet your needs, you can 
save it amongst the presets in the Sources pane for future use by 
clicking the Add to Gallery button in the Properties pane.  

Right-click your new colour source in the Sources pane and choose 
Rename from the popup menu, type in a new name for your source and 
press Enter. You can now reuse this colour source by dragging and 
dropping it onto your Timeline. 
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Opacity Envelopes 

Envelopes in this context are not an item of stationery, they are a 
method of applying change to an object's properties over time. Imagine 
an envelope as a hidden "track" that runs along with each source, track, 
and group in your project and at specific times you determine how it 
changes via the properties. Between the specific times you specify 
envelope settings, MoviePlus calculates smooth changes to the 
properties.  

There are different types of envelopes that all work in very similar ways 
for controlling video opacity, video motion and resizing (transforms), 
audio volume, audio stereo pan, video effects and video transitions. 
Once you learn how to display and modify an envelope, you can apply 
the same principle to each and every different envelope. 

Displaying opacity envelopes 

To display an opacity envelope, choose from the options below: 

Sources 

 or  Click on a video, image, or colour source on your Timeline to 
select it. The button's appearance will be different depending on whether 
the envelope has been modified previously (straight if unmodified). If 
you cannot see the Key Frame View—thin strips along the bottom of the 
Timeline below a splitter bar—click the Show/Hide Envelopes button 
at the bottom-left of the Timeline. There are two types of envelope now 
shown in the Key Frame View below the Timeline splitter—opacity and 
transform envelopes. 

Video Tracks and Groups 

 or  Click the Show/Hide Envelopes button in the header 
section of a track or group. Either button type will reveal the opacity and 
transform envelopes for the track or group you clicked on. Adjustments 
to the opacity envelope, discussed below, will result in opacity changes 
to any source on the track or group. 

Adjustments to a video group's opacity envelope will result in opacity 
changes to the composite result of the group's contents. For example, if 
your group contains four tracks each with a transform envelope that 
makes each track fill just one quarter of the visible area, all four videos 
would simultaneously have their opacity adjusted when you modify their 
group's opacity envelope. Groups are also used when cropping or 
masking video, so you may want to adjust the group's opacity—rather 
than individual tracks or sources. 
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Effects groups 

Please see Applying Effects on p. 123. 

Editing opacity envelopes 

The instructions above show how to enable the Key Frame View, 
displaying the opacity and transform envelopes for a selected 
component. 

The Key Frame View 

 

Once the Key Frame View is enabled, you will be able to edit envelopes, 
causing change over time. 

What are Key Frames? 

Key Frames are the small grey circles that appear on the envelope strips. 
For tracks and groups there is a default Key Frame at the start of the 
Timeline, for selected sources the default Key Frame is at the same time 
as the start of the source, so when you move your source its envelope 
changes also move in synchronization. 

Key Frames store information about the property you are editing—
opacity in this case. Because opacity is such a simple property, 
MoviePlus is able to draw a line along the length of the envelope to 
describe whether the current opacity value is high, low, or any stage in 
between. It is possible to select and drag this line to move it up and 
down, although adding and editing Key Frames is often an easier way to 
work because this method is in common with other envelope-style 
changes to effects, transforms, and transitions. 
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Modifying the default Key Frame value 

To modify opacity for a selected Key Frame you can move it up and 
down within the envelope strip or just click the Key Frame to select it (it 
will turn red) then adjust the Opacity slider in the Properties pane. You 
can move Key Frames left and right along the envelope strip which has 
the effect of moving them earlier or later along the project Timeline. You 
can also set a selected Key Frame's time position in the Properties pane. 

 Tip: To increase the size of the envelope strip to make moving a Key Frame 
easier, click the Minimize/Restore button. Click it a second time to reduce the 
size of the envelope so it takes up less display space. 

Adding more Key Frames to cause change over time 

Clicking at additional points along an envelope's red line will add new 
Key Frames. You can then use the methods above—dragging the Key 
Frame up or down, or adjusting the Properties pane's values—to modify 
the opacity at the new point in time. MoviePlus will draw the rate of 
change of opacity as a line between the Key Frames. The illustration 
below shows a default (100% opacity) Key Frame at the start of the 
selected source and a second (0% opacity) Key Frame a second later. 
MoviePlus will adjust opacity from 100% to 0% at an even (linear) rate 
between these two Key Frames. 

 

Altering the rate of change between Key Frame values 

In the example above, a right-click on the first Key Frame will allow you 
to adjust the rate of change of opacity towards the second value. The 
options are described as mathematical functions with useful illustrative 
curve types in the right-click menu. The curves between Key Frames 
allow the opacity change to start and end quickly, or more usefully to 
start and end slowly, but there are other variants. 
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Placing Key Frames at specific time points 

A click along your envelope will allow you to add Key Frames at any time 
along your Timeline, but if you want to position your Key Frame at a 
specific moment, perhaps a specific frame, you should first position your 
caret using the Preview and Seek controls, then click and drag your Key 
Frame to the caret. A single-click on an existing Key Frame will make the 
caret jump to your Key Frame time, so you can see the result of your 
imminent edit in the Preview pane. 

Other ways of adjusting opacity 

If you want to make a simple adjustment to opacity without affecting 
change over time, you can use the opacity slider in the Timeline's header 
section for a track, video group, or effects group. 

There's also simpler ways of performing straightforward fading of video 
fully in and out of vision than using an opacity envelope—please see 
Fading on p. 71. 

Removing Backgrounds and Creating Cut-outs 

There are a number of reasons you might want to "remove" a region of 
your video: 

• To isolate a foreground subject in order to place them against a 
different background, e.g. blue-screening such as used for movie 
special effects and daily favourites like weather presenting. 

• To cut out a hole in a video, e.g. a billboard advertising area or 
sports stadium big s

 
creen, in order to place a video of your own in 

the cut out region. 

•  face 
eir privacy but leave the remainder of the video 

unaffected. 

• 
side to form a 

montage, popularised by comic book hero movies. 

To limit the extent of an effect, e.g. to just mosaic someone's
to respect th

To crop your movie, e.g. leave just a rectangular or other-shaped 
portion of your video and discard the remainder, perhaps leaving 
room for other cropped videos on screen to sit along
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There are also a number of reasons why video cut-outs might be used in 
MoviePlus, i.e. 

• The cutting out of regular shapes and cropping of video for 
masking. 

• The removal of a solid-coloured background by using a  
reening, matting, 

colour keying and colour separation overlays. 

Masking 

 
u can 

sed 

rds 

 a 

 image or video would display where the 
screen-shaped cut out is). 

th 

 

elf 
olid-

her colours become 
white in the mask, opaque in the resulting video. 

y 

n 
video group above the unaffected copy to compose the 

following: 

Chroma 
Key effect, also called blue-screening/green-sc

Masks are a way of using an image (or simple video) to "cut out" a 
shape from a video, leaving transparency around the subject, effectively
removing a background to give focus to a foreground element. Yo
also use masks for irregular cropping, cropping with soft edges, 
animated cropping, and multiple picture-in-picture effects (populari
by comic-book superhero movies). Cropping using masks leaves a 
rectangular or other-shaped portion of the video on screen and disca
the rest. Masks can remove a foreground element to reveal another 
video or image source through the cut-out region (e.g., you can create
mask which cuts a hole in a picture, perhaps in the shape of a sports 
stadium big-screen, so your

Masks as used in MoviePlus are best created as transparent images wi
a white region to indicate the shape of underlying video to keep; the 
white region is like the inside shape of a cookie cutter, the transparent 
region is discarded like the outlying pastry around your cutter. You can 
use images that contain a mixture of different colours and transparent 
regions for advanced masking, more information will be included below. 
You may use video rather than an image as a mask if it has suitable dark
and light regions to act as transparent and opaque areas. If you have a 
solid region of colour that you wish to "cut out", you can remove it using 
the Chroma Key effect (commonly known as blue-screening), which its
builds a black and white video mask based on the detection of a s
coloured background in your video source... the detected evenly-
coloured region becomes transparent, whereas all ot

Masks are very versatile tool for modifying the look of your video—
having two copies of a video source, for instance, can allow for one cop
to have an effect and mask applied, to limit the region over which the 
effect applies. The two tracks containing the affected copy and mask ca
be placed in a 
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Original video or 
image 

Mask applied to 
copy of original 
video or image, with 
an effect applied 
(mosaic in this 
example) 

Resulting 
composition only has 
a specific (mask-
shaped) region 
affected by the 
mosaic effect 

 

Masks and video groups 

Before you go ahead and add a mask to your Timeline, it's useful to 
know in advance how masks and the organization of your video tracks 
work hand in hand. Masks need to occupy a track of their own and they 
have an affect on underlying video compositions... the masks' white 
regions determine which regions of underlying video sources you see—
the mask sits on top of other video and acts as a virtual cookie cutter. To 
restrict the depth to which the cookie cutter actually cuts (i.e., to restrict 
how many tracks below the mask are affected by it), you need to include 
the mask and the video source in a video group. If your mask and 
underlying tracks to gain transparency are not within a group, the 
cutting effect of the mask will extend through all underlying tracks. 

Here's an illustration of the effect of using a video group to manage a 
mask. Each example uses the same video and image sources, the same 
number of tracks (even with the same names), but the first example has 
no track organization; the second places the mask and the underlying 
image in a group: 
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Timeline organization; upper 
track set to Mask blend mode

   
 

Resulting video 
composition

 

All the video tracks are at the same 
level, so all lower tracks are 

affected by the mask. 

 

 

The mask cuts out 
the image of the 
little girl as well 
as the video of 
the city street, 

leaving a standard 
black background 

behind all the 
video and image 

sources. Both 
tracks are 
masked. 

 

Only the track containing the image 
of the girl is in the same group as 

the mask; 
here the Image track is masked but 

tracks outside the group are 
unaffected.  

 

 

This time the 
mask only cuts 

out content from 
the image of the 

little girl. The 
underlying video, 

outside of the 
video group, is 

unaffected by the 
masking 

operation! 

 

Adding a mask to your video 

Some masks are included with your MoviePlus installation, for custom 
requirements you can create your own mask images using a bitmap 
(photo) editing program such as Serif PhotoPlus, although some 
illustration programs like Serif's DrawPlus would also be useful. 
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Ready-made masks in MoviePlus 

These images are generally white and transparent in order to create 
regions of visibility and transparency, (and translucency) in your video. 

To add a ready-made mask to your project: 

• Create a new video track to accommodate your mask image and 
move the new track above the other existing video tracks you would 
like to affect. Masks work in a special track mode so they should not 
be on the same video track as other types of sources. Tracks 
containing masks should be placed within a video group if you would 
like to limit the extent of their masking power. 

• Select the Explorer tab and click the  Samples button. This will 
display the available sample media files included with your 
MoviePlus install (normally found in C:\Program 
Files\Serif\MoviePlus\4.0\Samples\). 

• Select the  
lar 

 

e white shape in the 
mask will represent a visible region of video. 

 

Masks folder in the folder view (MoviePlus Studio Effects 
DVD needs to be installed) at the left and choose either the Regu
or Widescreen folder to suit the kind of project you are working 
with.  If you're not sure which to choose, click the Regular folder to
see the collection of masks. From the range available at the right 
side of the pane, drag and drop a mask on to the new video track 
you created in your Timeline. Remember that th

• Click the  Blend Mode button on your new video track contain
the black and white mask i

ing 
mage and select Mask from the list of 

video blend modes. 

 of 

 a 
video group and you have additional video sources below the group. 

Masks of your own 

ons 
e 

regions of colour to mix a mask and overlay within a single image. 

 
ideo you would like to crop, and set that track's 

blend mode to Mask. 

Video tracks containing sources below the mask will now have an area
visible video as created by the white regions of the mask image. The 
transparent region will draw as black unless your mask track is within

You can create and use images of your own to cut away regions of your 
video and image sources. Your own masks do not need to be just regi
of white and transparency as the mask presets are, you can also us

To add your own masks to your project, browse to their saved location 
using the Explorer pane, drag your mask image onto a track of its own,
positioned above the v
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Creating a mask 
To create a mask it is recommended you use a bitmap (photo) editing 
program that fully supports transparency, such as Serif's PhotoPlus. 
You should aim to use white to create the region you wish to maintain in 
your video, and transparency for the areas you wish to cut away. Partial 
transparency is supported, so you can create regions of translucency as 
well as using a mask to create solid regions of opacity and transparency 
in your video. 

Remember to create your masks at a suitable size for your project, 
taking pixel aspect ratio into account. For the majority of output formats, 
MoviePlus creates non-square (rectangular) pixels at export time: your 
DVD video in PAL regions, for instance, is created at 720 pixels wide, but 
after pixel stretching (as carried out by DVD players and the MoviePlus 
Preview pane) the video is stretched to the equivalent of 787 pixel wide, 
655 pixels wide in the case of NTSC. The pixel aspect ratio for DVD PAL 
is 1.0926 and this is the factor by which the video is affected by 
stretching (mask images need to be wider than the project size by the 
same factor). To know how much your project will be stretched, in order 
to know how much wider (or narrower) to make your mask images, 
please see Advanced Export settings in the MoviePlus Online Help 
system. Once your masks are ready for use in MoviePlus you can always 
adjust their size and position using a Transform envelope, see below. 

Using colour in your masks 
Incorporating a colour other than white in your mask will mean your 
mask image performs two functions—the white and transparent regions 
will continue to create regions of opacity and transparency in underlying 
video, and any other colours will act like celluloid filters, colourising the 
underlying video. You can also achieve some interesting mask effects by 
choosing which luminance or colour component elements of an image 
will affect transparency, for instance selecting to isolate just the red 
components of an image to mask out underlying video. 

Adding your masks to your MoviePlus project 
When you have created and saved/exported your mask using a suitable 
photo-editing or illustration program, you can navigate to the folder 
containing the mask image using MoviePlus's Explorer pane. You can 
then drag your mask image onto a track in your Timeline. As with the 
preset masks, your own masks still need to occupy a track of their own, 
and that track must be set to use the Mask blend mode. Tracks 
underneath the mask will be affected by it within the constraints of a 
video group. 
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Moving and resizing your mask 

Where your mask does not quite match the area of video that you would 
like to make transparent, you can move or resize it for better results. 
You can also animate a mask so that it moves to match movement of a 
subject in an underlying video source, for instance to mosaic a face that 
moves slightly within the frame.  

Selecting the mask to modify its properties 

 Select the mask object on the Timeline with a single click and then 
click the Show/Hide Envelopes button at the bottom left of the 
Timeline area. This will open the Key Frame View if it is not already 
active and will display the Opacity and Transform envelopes for the 
selected source. The name of the object you are modifying is displayed 
at the bottom of the Key Frame View. 

Select the Key Frame at the left of the Transform envelope, just to the 
right of its Timeline header—it will turn red when selected and you will 
be able to see properties for this Key Frame in the Properties pane. 

Resizing a mask 

Hold Shift on your keyboard and, using a corner handle in the Preview 
pane, click and drag a handle to resize your mask. Do not hold Shift if 
you would like freeform adjustment of height and width; keep holding 
Shift until after you've released your mouse button if you would like your 
mask to maintain its original shape. 

Moving a mask 

While the Transform envelope's Key Frame is selected, click inside the 
video preview area of the Preview pane and drag your mouse to alter the 
mask's position. 

Animating a mask 

To animate a mask you will need more than one Key Frame in the 
Transform envelope. MoviePlus will automatically move the mask 
between the positions defined by Key Frames, so in an extended clip that 
requires some movement of a mask you may only need to define a few 
important positions at certain points along the Timeline, allowing 
MoviePlus to calculate the in-between steps. 
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Adding and modifying Transform Key Frames 

While your mask is selected and the Key Frame View is active, click at a 
point along the Timeline on the Transform envelope's strip where you 
would like to add another Key Frame. Modify the Key Frame's properties 
using either the Properties pane or by moving/resizing the selected 
object, using the Transform control now available in the Preview pane. 
Corner handles resize, side handles stretch or compress, clicking and 
dragging within the handles performs a move operation, clicking and 
dragging outside of the handles results in rotation. See Transforming 
Your Video on p. 90 for more detailed information. 

Cropping video and creating cropped picture-in-picture effects 

Cropping video in MoviePlus involves using a simple image overlay to 
describe which areas of your video should remain visible and which areas 
should become transparent. This is achieved using masks as described 
above. 

As white and transparent masks will retain some video and discard the 
rest, you can use such images to help create picture-in-picture effects or 
just to crop your video for other reasons. 

As an example, you can use a series of masks to create multiple picture-
in-picture video montages as shown below, or use masks in isolation for 
a single crop effect. In the sample below, three masks (each one on a 
track of its own in a video group with a second video track containing a 
video source) creates a simple and effective three-way screen split 
playing three concurrent videos. Of course you should try not to overuse 
such an effect as it may detract from the point you are trying to get 
across rather than help it. 
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Chroma Key (Matting/Blue Screening)  

Introduction 

This process enjoys a few names including colour keying, matting, blue-
screening, green-screening, and a colour separation overlay. It is a 
method of removing a colour (or a colour range) from one video or 
image to reveal another video or image behind it. The "removed" colour 
becomes transparent. MoviePlus achieves this transparency by using 
colour-detection routines to convert your video into a hidden black and 
white mask, used in behind-the-scenes processing, where white remains 
opaque but the selected colour range shows as black, which represents 
the transparent region. 

This process is commonly used for weather broadcasts and of course in 
many movie blockbusters. To start with, the foreground subject—a 
weather presenter for instance—is filmed against a solid-coloured and 
evenly-illuminated backdrop. Using MoviePlus (or expensive studio 
wizardry in the case of live TV weather slots), the solid coloured region 
of this video can be made transparent using a Chroma Key effect, 
revealing an underlying video. In the case of some weather presenting, 
the video "behind" the presenter shows a computer-generated weather 
map with animated symbols or weather systems. While Hollywood 
blockbusters are more usually associated with "blue screening", weather 
presenting's everyday appearance shows how widespread and useful the 
effect is! 

Applying the Chroma Key effect 

Effects in MoviePlus can be applied to individual video sources, whole 
tracks, or groups of tracks. While Chroma Key can also be applied to all 
three hierarchies, it is most commonly used with individual video sources 
in MoviePlus, as it is not usual for there to be multiple sources with the 
same background colour to be made transparent. 

Applying to a video source: 

Select the Effects pane, click the Chroma Key entry in the list at the 
left, then drag and drop the Chroma Key effect thumbnail from the right-
hand side of the pane onto a video source on your Timeline. The video 
source will show an orange lightning bolt at its left to denote that one or 
more effects have been applied to the source and the Key Frame View 
below the Timeline will show you the Chroma Key effect strip (and any 
other effects you also have applied to that video source). 
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Applying to a whole track: 

Select the Effects pane, click the Chroma Key entry in the list at the 
left, then drag and drop the Chroma Key effect thumbnail from the right-
hand side of the pane onto a track header at the left of your Timeline. 
The video track will show an orange lightning bolt at the left of the row 
of icons to denote that one or more effects have been applied to the 
track. 

Note that applying the Chroma Key effect to a track means that 
MoviePlus will try to "remove" a coloured region from every video source 
on that track. If you would just like to remove the background from a 
single video source, drag and drop the effect on to the source object, as 
described above. 

Applying to the composite result of a group of tracks: 

If you have organized some video tracks into a video group and wish to 
apply the Chroma Key effect to the result of your composition, select the 
Effects pane, click the Chroma Key entry in the list at the left, then 
drag and drop the Chroma Key effect thumbnail from the right-hand side 
of the pane onto a video group header at the left of your Timeline. The 
video group will show an orange lightning bolt at the left of the row of 
icons to denote that one or more effects have been applied to the group. 

Note that applying the Chroma Key effect to a group means that 
MoviePlus will try to "remove" a coloured region from the result of the 
arrangement of all video sources and tracks within the group. If you 
would just like to remove the background from a single video source, 
drag and drop the effect on to the source object, as described above.  

Changing Chroma Key Colour 

 The Chroma Key effect automatically tries to remove blue from your 
video; if you would like to select a different colour it is recommended 
that you first Mute the Chroma Key effect by clicking the Mute button in 
the effect's header at the left of the Timeline, use the draggable colour 
picker pipette in the Properties pane to select a new colour value from 
your preview, then un-mute the effect to see the results. The rest of 
your Timeline composition should now be visible through the transparent 
region of the Chroma Keyed source. 
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Chroma Key in action 

   

Simple blue-screen 
filming of a hand 
against a solid-
coloured 
background, a 
wooden frame with 
blue cloth stretched 
over it. 

Background video, 
placed on the track 
below the blue-
screen footage on 
the Timeline. 

The upper video 
source on the 
Timeline, the blue-
screen footage, has 
had a Chroma Key 
effect applied to it. 
Properties sliders were 
adjusted to remove all 
the blue. 

 

Settings in the Properties pane 

You are likely to have to fine-tune the Chroma Key effect to help the 
colour-detection processes figure out which bits of your video to make 
transparent. 

Show Mask 

Once you have applied the effect and selected a colour value to become 
transparent by using the colour picker pipette in the Properties pane, it's 
recommended that you check the Show Mask checkbox (also in the 
Properties pane). This will show you a black and white view of the 
transparent and opaque regions of your video effect. This behind-the-
scenes "mask" is created by the Chroma Key effect, the "removal of a 
solid colour" that the Chroma Key performs is carried out by making a 
black and white image for every frame of your video, the colour you are 
trying to remove becomes a black region in the mask while regions of 
other colour will be white in the mask. When the Show Mask box is 
checked, white areas denote opaque regions (not transparent) and black 
areas denote transparency (these regions are "removed" from the 
video). Viewing the mask will give you a definite idea of how well Adjust 
the Low, High and Blur sliders until you achieve the required transparent 
region. 

Low: 
The Low slider determines a lower threshold for colour detection. 
Anything in the video with brightness below this setting becomes 
transparent; when this slider is moved to the right, a wider range of 
darker tones will be included in the Chroma Key colour detection. 
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High: 
The High slider determines the upper threshold for colour detection. 
Anything in the video with brightness values above this setting become 
opaque; when this slider is moved to the right, a wider range of bright 
tones will be included in the Chroma Key colour detection. 

Blur: 
This blurs the shape of the transparent region generated by the Chroma 
Key effect (see the Show Mask section above), blurring the edge of the 
video against its background. 

Suppress Background: 

This option alters colour in the opaque regions of your Chroma Keyed 
video. Suppress Background would remove some colour elements from 
the foreground (unaffected) video. In the case of the most popular kind 
of Chroma Keying, blue screening, this option would remove blue tints 
from the foreground subject (e.g., blue tinges to hair, blue reflections on 
shiny skin etc). 

Changing the Chroma Key effect over time 

You can adjust the Chroma Key settings so that they change over time, 
perhaps to account for a change in lighting conditions that affects the 
colour you're trying to remove. Your Chroma Key effect can start by 
removing pale blue and slowly change to removing a stronger blue, for 
instance. 

To introduce change to your Chroma Key settings over time, reveal the 
Key Frame View for your source, track or group (depending what you've 
applied the effect to) by clicking the orange lightning bolt on the 
source/track/group. This will display the effects strips below the 
Timeline. You can then click at a point along the Chroma Key strip on the 
Timeline to add additional Key Frames, which can each have modified 
settings. MoviePlus will gradually blend from one Key Frame's settings to 
the next as your video is played. You can also affect the rate of change 
between Key Frames; for more information see Editing opacity 
envelopes on p. 75 where key frames are explained in more detail. 

Other considerations 

If your blue-screen (or other background colour) footage is not perfect 
for keying the solid colour out, you may also need to use a mask or 
some other effects. 
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The sample above shows that some heroic blue-screen footage used in 
the (optional purchase) MoviePlus Projects Guide DVD is not perfect, 
some of the background has not been easy to remove because of uneven 
background lighting. In this case the sample was finished by adding a 
mask to a track above the “Chroma Keyed” footage to cut out more of 
the video. The mask was a simple white and transparent image with a 
hero-shaped white area at the left side and transparency everywhere 
else, enough to cut out the regions that the Chroma Key could not. 

You can also consider using colour-correction effects prior to applying 
the Chroma Key in order to improve the quality of your solid-coloured 
background. Using multiple effects and choosing the order in which they 
are applied is discussed in Combining Effects on p. 127. 
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Transforms 

Transforming Your Video 

Transforms allow you to resize your video sources within the overall 
project size (which helps achieve picture-in-picture or picture-and-
picture effects), to add perspective, to scroll video, images, colour 
sources, and text in any direction, and to zoom and pan. 

The possibilities are almost endless, because not only can you transform 
individual video, image, colour and text sources, you can also transform 
entire video tracks and even collections of video tracks in video groups. 

The following examples of transforms show the application of perspective 
and “picture-in-picture” transforms, respectively. 

 
 

Using Transforms to produce 
Perspective  

Using Transforms to produce 
“picture-in-picture” effects. 

 

The use of the transforms, scaling and motion, is illustrated in the 
MoviePlus Online Help system. 
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Scaling (Resizing) and Rotating 
Being able to resize your video and images is an extremely handy 
feature! The impact of this is that you'll be able to zoom in or out, 
perhaps see around the resized video, image, or colour to what lies 
beneath, so this is often something performed on layered (multi-track) 
projects. 

If you notice black bars appearing in your video preview, see Media 
with black bars displayed on p. 28.  

Resizing your images, colours and video 

Resizing is a function of MoviePlus's transform envelope . If you've 
adjusted an opacity envelope, or introduced change to an effect or 
transition using Key Frames, you'll be familiar with some of the concepts 
involved. If not we'll introduce the key concepts here. 

Selecting the transform envelope 

When you are trying to transform a video/image/colour source, or a 
video track with multiple sources on it, or a video group containing 
multiple tracks, you will need to enable the Key Frame View to display 
envelopes. 

 Select a video, image or colour source, or a video track or group, 
with a single click of your mouse then click the Show/Hide Envelopes 
button at the bottom-left of the Timeline. This will enable the Key Frame 
View. 

Select the grey Key Frame in the Transform envelope as shown below; it 
will turn red when selected. 

 

Transforming using the mouse 

When a transform Key Frame is selected, you will notice transform 
handles in your Preview pane: 
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The tool highlighted at the top of the Preview pane indicates that you are 
currently performing a transform, and the "handles" around the outside 
of the video/text/colour/image, like the handle highlighted in the top-left 
corner of the preview, allow you to transform your source. 

Click and drag a corner handle to resize the video or image, holding 
Shift on the keyboard if you would like to maintain the aspect ratio (the 
rectangular shape) of your source during the resize. Drag inwards to 
reduce the video or image size; drag outwards to increase it. Hold Alt on 
your keyboard while dragging to resize your video component about its 
own centre. 

Click and drag inside the transform region to reposition your resized 
video—avoid clicking the small handle in the centre, it has a special 
purpose to do with rotation, discussed below. If your resized 
video/image is above other video or image sources, you will have just 
created a picture-in-picture effect! 
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Transforming using accurate values 

Rather than dragging the transform corner handles with your mouse to 
resize your video or image, while the transform Key Frame is selected 
you can adjust its properties in the Properties pane. You can, for 
instance, set the video/image size to be 25% of your project size as 
illustrated above by making the video 50% of its original width and 50% 
of its original height (set X Scale and Y Scale to 50%). 

Achieving Picture-in-Picture effects 

Making a video source (or a collection of sources on a track or in a 
group) smaller than the original size means that you can see underneath 
that part of your project to any underlying sources. The illustration 
above has a black background because there is no video, image, or 
colour source on a track below the transformed source. To achieve 
picture-in-picture effects, you need a multi-track project with layered 
video or image sources. 

Zooming in or out 

To achieve a zoom effect using a transform envelope, you will need to 
use multiple Key Frames—two is enough for basic zooms, each Key 
Frame set at a different time with a different set of transform properties. 
MoviePlus will smoothly calculate all the steps between the two Key 
Frames to achieve smooth zooming. 

Rotating your images, colours, and video 

Select a source, track or group then a Key Frame on its transform 
envelope. Within your Preview pane, position your mouse cursor outside 
the transform handles (still within the Preview pane). Note that the 
cursor will change to: 
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Click and drag in a gentle circle to rotate your video or image. Hold Shift 
on your keyboard to constrain rotation to 15° jumps. 

To introduce a "spin" to your transform, you will need to add multiple 
Key Frames to your transform envelope, each with different rotation 
property settings. You can of course set these values using the 
Properties pane as is possible for resize operations. 

Centre of rotation 

By default your rotation will make the source object spin about its own 
centre. You can move the centre of rotation to create an arc movement 
by clicking and dragging the central transform "handle". 

Working with sources, tracks and groups 

Sources 

You should select an individual source to apply a transform to if you 
want just one video or image to be resized/rotated/moved/skewed. You 
can copy and paste Key Frames from one source to another if you wish 
to use an identical transform for multiple sources, but bear in mind that 
if you have a collection of transformed sources you can still apply group 
transforms by modifying a video group's transform envelope. 

Tracks 

Apply a transform to a track if you want to affect all the image or video 
sources on that track. As each source is located at a different point in 
time along the project Timeline, a transform applied to the whole track is 
often only useful if the transform itself does not change over time, i.e. it 
has just one Key Frame. 
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Groups 

In general terms you should use groups where you want multiple 
sources and tracks treated as one video element. You can transform 
sources to make them of reduced size, then place their video tracks in a 
video group and apply additional transforms. 

Need more room in your Preview pane to carry out 
transforms? 

 If you are increasing the size of your video or rotating it using a 
transform, you might find that space becomes a bit tight in your Preview 
pane. Just click the Zoom out button in the Preview pane, making the 
preview and transform smaller. This applies to any kind of transform you 
are performing. 
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Source, Track, and Group Motion 
Like other envelopes, you can apply change over time—which in the case 
of transforms means video motion—by utilising more than one Key 
Frame along your transform envelope strip. 

Introducing change over time 

The key to motion, as opposed to manipulating sources with a fixed 
transform (size/rotation/skew), is for there to be some change in the 
transform settings over time. For there to be change between transform 
envelope Key Frame values, we need more than one transform envelope 
Key Frame!  

Adding Key Frames 

Clicking at additional points along an envelope's strip will add new Key 
Frames. Each Key Frame stores its own settings. You can use your 
mouse to transform your source(s), modifying the selected Key Frame's 
value using the transform handles in the Preview pane, or alter values 
directly (or accurately) using the Properties pane. MoviePlus will 
calculate all the step-by-step values between the transform envelope 
Key Frames to display a change in position or size over time! The further 
apart your Key Frames are, the slower the change between settings will 
occur. 

Selecting Key Frames 

You can modify Key Frame properties when a Key Frame is selected—
single click a grey (deselected) Key Frame and it will turn red (selected). 

Altering the rate of change between Key Frames! 

By default, where you have two Key Frames with different values, 
MoviePlus will gradually step from one range of settings to the next in a 
smooth manner—this is known as Linear interpolation. MoviePlus is 
interpolating (calculating) values between the Key Frames and the 
change is linear, i.e. half way between the values you will have 
encountered half the required amount of change. 

To alter the rate of change between Key Frames, select the first Key 
Frame (looking at altering the rate of change between a pair of Key 
Frames means one Key Frame will be first and another will be second), 
and choose a preset from the Interpolation drop-down in the 
Properties pane. You can also right-click on a Key Frame to alter the 
interpolation (or "curve type"), which also offers handy previews of the 
rates of change as curved or straight lines, like a graph or chart. 
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It's handy to be able to alter the rate of change, as in video production 
it's usually a good idea to aim for smoothness—sudden starts or ends to 
movement (as with other effects) is not always desirable as it can 
sometimes detract from the video. 

Practical examples 

These principles can apply to individual text/video/image or colour 
sources, or to entire video tracks and video groups. 

Spinning 

For full rotation(s) it is recommended that you introduce a new Key 
Frame for every 120° of rotation to ensure you don't encounter any 
accidental switching of rotation direction as your component spins. 

Add Key Frames at regular intervals, adjusting the rotation for each Key 
Frame, preferably using the Properties pane for accurate Key Frame 
positioning on the Timeline and accurate rotation values. 

Zooming 

Use at least two Key Frames (you will only need two for a simple zoom) 
with a different size value for each Key Frame. To zoom in on your 
video/text/colour or image, increase its size with the second Key Frame 
or decrease its size with the first Key Frame. To zoom out either 
increase its size for the first Key Frame or decrease its size for the 
second Key Frame. 

Scrolling (panning) 

Use at least two Key Frames, with different positional information in each 
Key Frame. You can achieve this by dragging the transform region in the 
Preview pane or by typing values in the Properties pane. For instance, to 
scroll a text item across your "screen" from right to left, the first Key 
Frame could have an X position value of 100% and the second Key 
Frame could have an X position value of -100%. 

Perspective 

Use two or more Key Frames with a different shape applied in each case. 
Hold Control while dragging transform handles in the Preview pane to 
modify perspective in a freeform way, or hold Control+Alt+Shift and 
drag a corner handle to constrain perspective to a more uniform 
adjustment. We’ll look at Perspective in a moment. 
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Combining different types of transforms 

Each Key Frame on a transform envelope stores full information about 
size, position, rotation, and any perspective or skewing.... so to combine 
a zoom and a pan, all you need to do is modify the size and position of 
your source/track/group with each Key Frame, you do not need (and 
cannot use) multiple transform envelopes for a single video component—
although you can possibly transform a video component in three ways, 
by modifying the source transform envelope, the video track transform 
envelope, and a video group's transform envelope. 
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Perspective 
Perspective is a function of MoviePlus's transform envelope. Each of 
the types of video source (images/videos/text/colour) plus video tracks 
and video groups has an opacity envelope and transform envelope that 
can be revealed by enabling the Key Frame View. 

If you need to have a refresh on selecting envelopes go to Selecting 
the transform envelope on p. 91. 

Adjust the transform envelope's settings 

Even perspective 

Hold Control+Alt+Shift at the left side of your keyboard then click and 
drag a transform corner handle in the Preview pane. Dragging a top 
corner handle downwards will have a corresponding mirrored affect on 
the position of the corner handle beneath it. Dragging a corner handle 
sideways will have a corresponding affect on the opposing corner handle 
at the other side of your video component. 

Optionally, once you have achieved a suitable amount of "compression" 
of your video at one end, release the mouse button and keyboard keys 
then drag one of the sides' middle handles inwards. 

     

Control+Alt+Shift drag of corner 
handle 

Drag of a middle handle 

Freeform perspective 

You can achieve interesting perspective effects by dragging individual 
handles rather than using the more coordinated perspective editing 
described above; simply hold Control while dragging a corner handle 
(below-left). Drag multiple corners to further transform your video! Use 
in conjunction with overlays for even more flexibility (below-right). 
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Control + Drag Freeform perspective on an 
overlay 

Skew 

As with the freeform perspective described above, holding Control gives 
you more transforming freedom: to skew your video, hold Control and 
drag a side's middle handle in the Preview pane. 
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Picture-in-Picture Effects 
Picture-in-Picture is a feature available thanks to transform envelopes. 

   

Use in conjunction 
with titling 

A four-in-one effect A four-in-one effect 
that rotates in time 

The samples shown above could all be described as picture-in-picture, 
although the term picture-and-picture is applicable where video or 
images do not "overlap". 

To achieve a picture-in-picture effect of any kind, you will by definition 
need more than one video, image, text or colour source playing at once, 
i.e. your project has multiple tracks each with a source at the same point 
on the Timeline, otherwise they cannot play at the same time! 

Simple picture-in-picture 

You can achieve this using the methods discussed in Scaling (Resizing) 
and Rotating on p. 91 (refreshed here with additional track layout 
information). 

Layout your tracks and sources as shown below: 

 

The source video on the top track has a transform envelope applied. The 
transform envelope's default Key Frame value is being modified by using 
the transform tool shown in the Preview pane. 
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Adjust the Key Frame settings 

Adjust the properties of your selected transform envelope Key Frame by 
either using the mouse in the Preview pane as shown above-right or by 
entering size and position values in the Properties pane. Resizing your 
video is mentioned in more detail in Scaling (Resizing) and Rotating 
on p. 91. With a single Key Frame, this transformed video would stay at 
the specified size and position without changing. 

Popular use of picture-in-picture 

Although a text overlay is not often thought of as picture-in-picture, the 
same principles apply to both concepts—one source sits on top of 
another with the upper source being resized and/or positioned using a 
transform envelope. So you can use picture-in-picture technology for: 

• A video replay 

• Text overlays like a flashing "Replay" logo 

• Video montages (often used to show events in brief) 

Picture-and-picture effects 

, 
e. 

ure components a swift process; the values used were as shown 
below: 

The example shows four video sources of equal size each occupying a 
different "position" in the available area. For this example it was 
achieved by organizing the sources each on to a track of their own so 
that they could be positioned one atop the other to play simultaneously
then each source had an adjustment made to its transform envelop
Typing size and position values into the Properties pane for each 
source's default Key Frame made the accurate position of the picture-
and-pict
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Video 
component

X Scale 
and Y 
Scale

X position 
and Y 
position

Top-left X: 50% 
Y: 50% 

X: -25% 
Y: -25% 

Top-right X: 50% 
Y: 50%  

X: 25%  
Y: -25% 

Bottom-left X: 50% 
Y: 50% 

X: -25% 
Y: 25% 

Bottom-right X: 50% 
Y: 50% 

X: 25% 
Y: 25% 

 
These values represent the shift in position in comparison to the overall 
project video size, so it is not necessary to calculate pixel-accurate 
positions for each project type. 

Using groups 

There may be occasions where you would like to transform a collection 
of sources or tracks, as in the sample below. 

 

Tracks containing the four sources have been dragged into a video group 
to achieve the rotation of all four sources simultaneously (above). In 
addition to each source having a transform applied, the group of four 
tracks also has a transform applied, scaling and rotating the composite 
result of the group. Each source can still have its own opacity, effects, 
and as mentioned transforms, and thereafter additional effects and 
envelopes can be applied to the tracks and groups. 
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 or  You can adjust track or group transform envelopes by 
clicking the  Show/Hide Envelopes button in the track or group header 
then modify the Key Frame values in the transform envelope. The 
button's appearance will be different depending on whether the envelope 
has been modified previously (straight if unmodified) 
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Blend Modes 
You can think of blend modes as different rules for merging overlapping 
video or image pixels together at the video track-level to create a 
resulting colour. In MoviePlus, you'll encounter blend modes as a track 
property. The video group, track or source opacity setting interacts with 
the track blend mode to produce varying results. 

The blend modes available in MoviePlus are described as follows: 

• Normal. The default blend mode. Blending of top source and 
underlying source pixels occurs only by varying the top source's 
opacity setting. If the top source's opacity setting is 100%, no 
blending occurs and only the top colour is visible. 

• he 

smooth blending of video tracks with other sources below them. 

•  

y in 
the upper source "knocks out" areas of the lower source. 

• 
 

 
e 

) 

• Dodge. Lightens the video using lightness values of the top 

 
t. 

• 
d bottom source at each pixel position, 

always producing a lighter value. Screening any colour with 

Cross-fade. This blend mode is used behind-the-scenes by t
cross-fade transition. As the opacity of the upper source 
decreases, the opacity of the lower source automatically 
increases. The two values are evenly opposed to allow for 

Mask. The pixels of the upper source are used to create areas
of colour, transparency and opacity in the underlying source. 
White in the upper source equates to opacity, transparenc

Multiply. The result is a combination of the top and bottom 
colour at each pixel position, always producing a darker value.
Multiplying any colour with black yields black. Multiplying any
colour with white leaves the colour unchanged. Successiv
multiplied colour applications (other than black or white
produce a progressively darker "magic marker" effect. 

source at each pixel position. Dodging with black has no effect. 

• Burn. Darkens the video using the lightness values of the top 
source at each pixel position. Burning with white has no effec

Screen. Like Multiply, but the result is a combination of the 
inverse of the top an

white yields white. Screening any colour with black leaves the 
colour unchanged. 
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• Lighten. The result is either the top or bottom pixel colour at 
each pixel position, depending which is lighter. Darker colours 
are replaced. 

• 
ending which is darker. Lighter colours 

are replaced. 

• 
ource. A nice 

colourising effect. 

• on of the saturation of the 
ource. No 

• 

 

• op 

s; if greater, it dodges. This tends to add soft 
highlights and shadows to the video. 

• 

e 

ith main colours and patterns from 

•  saturation of 
the top source with the lightness of the bottom source. Because 

e is 
inting monochrome or colour video 

sources, respectively. 

Darken. The result is either the top or bottom pixel colour at 
each pixel position, dep

Hue. The result is a combination of the hue of the top source 
with the lightness and saturation of the bottom s

Saturation. The result is a combinati
top source with the hue and lightness of the bottom s
change over greyscale (0% saturation) regions. 

Difference. The result is the difference between the top and 
bottom colour at each pixel position. 

• Exclusion. Similar to Difference, but a softer effect. 

Soft Light. Applies either Burn or Dodge, depending on the t
colour at each pixel position. If the top colour is less than 50% 
grey, it burn

Hard Light. Applies either Multiply or Screen blend modes, 
depending on the top colour at each pixel position. If the top is 
less than 50% grey, it multiplies; if greater, it screens. This 
tends to add soft highlights and shadows to the video. Compar
to Overlay. 

• Overlay. Applies either Multiply or Screen blend modes, 
depending on the bottom colour at each pixel position. If the 
bottom colour is less than 50% grey, it multiplies; if greater, it 
screens. This tends to preserve highlights and shadows from 
the bottom source along w
the top source. Compare to Hard Light. 

Colour. The result is a combination of the hue and

lightness values (greyscale levels) are preserved, this mod
useful for colouring or t
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• Luminance. The inverse of the Colour blend mode. The result 
is a combination of the lightness (luminance) of the top colour 

pplying a blend mode 

with the hue and saturation of the bottom colour. 

An illustration of each of the above blend modes is provided in the 
MoviePlus Online Help system. 

A

 To change the way a track blends its video content with the 
underlying video, click the Blend Mode button in the track's header. 
Aside from special "colour" effects, the blend mode is also used when 
cropping or cutting out video using masks. 
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Video Overlays 
You can "layer" all sorts of different kinds of sources on top of existing 
video, images, or background colours—this flexibility opens up a world of 
possibilities in your video production. 

Achieving an overlay 

 

Overlays, in basic terms, are two or more sources being displayed at 
once, one on top of the other (text on top of video in the example 
above). For the bottom source to still be visible despite having another 
source on top of it, the top source needs to: 

• to be smaller than the bottom source 

• have transparent regions 

• have reduced opacity 

 

 

age, such as a street sign, to sit in front of 
the billboard (see below). 

There may be more than one way you can achieve your effect—e.g., a 
picture of a billboard advertising poster displaying your video within the 
billboard area can be achieved by either placing your video above a 
billboard image and shaping the video to match the billboard area using
a transform envelope, or you can also cut out the billboard region of 
the image using a photo-editing program such as Serif's PhotoPlus 
(exported as a 32-bit PNG to maintain transparency) and place it on top
of your video, perhaps shaping your underlying video to approximately 
match the billboard region, again using a transform envelope. Both 
methods would have similar results; the second would allow some 
foreground objects in the im
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Top source made smaller 

When you add a source to the upper track so that it is displayed on top 
of other sources, it is likely to occlude them completely or almost 
completely, blocking out what's below so all you can see is the content of 
the top-most track. To resize your top source so you can see "around it" 
to underlying sources, use a transform envelope on the upper source 
or track. 

You can resize or reshape your source, you can deform with perspective 
as shown above and you can even animate the process. See 
Transforms on p. 90 and choose a type of transform to learn more. 

Top source has transparent regions 

Overlaid STV video 

Serif's ImpactPlus is an example of a program that can create video 
containing transparency—the STV file format, Serif Transparent Video, 
is a high-quality format based on a lossless 32-bit image format, which 
supports 256-levels of transparency in every frame and despite being 
compressed does not lose image quality when saved. When exported as 
STV, animations created using ImpactPlus can make for compelling 
effects in your movies, including smoke, fire, ethereal mists, sparkling 
fireworks and more. If you own Serif ImpactPlus, see its Online Help 
system or companion for information about exporting your scenes as 
video; remember to choose the STV format if you want your video to 
have a transparent background! 

When you add a STV video file to a track above existing video or images, 
you do not need to take any further action, MoviePlus will smoothly 
overlay the STV on top of the video, colour or image on the lower track, 
revealing underlying sources through the video's transparent region. 
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Overlaid text or images 

Text 
When text is applied to anything other than the bottom video track, it 
has a transparent background. This makes it very easy to overlay titles 
or scrolling credits on top of video or images in your project. To choose a 
coloured background, add a colour source to a track below your text. 

Images 
Images overlaid on tracks above other images or video can make for 
some fun projects (like the billboard composition, above). If the image 
on the top track has built-in transparency you will automatically be able 
to see through the transparent region to the underlying sources. 

 

Creating images with transparency is a straightforward task for an 
application like Serif PhotoPlus, pictured above, but you can also use 
some ready-made images as supplied on the (optional) MoviePlus 
Studio Effects DVD.  

Once installed, the overlay images will be available by clicking the  
Samples button in the Explorer pane and navigating to the Overlays 
folder. There are subfolders there for matching Regular and Widescreen 
overlay image formats to suit your different projects. The MoviePlus 
Studio Effects DVD needs to be installed to see the Overlays folder. 

You can if you wish resize or skew your underlying video or images to 
match a custom shape (roughly matching the overlay's transparent 
region) using a transform envelope. 
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Cropping or fading with masks 

You can "crop" overlays so that they do not fill the scene. See Masking 
on p. 78 for more details. 

Top source with reduced opacity 

There are a number of ways to reduce opacity of upper sources to 
partially reveal underlying sources—the quickest is to adjust overall track 
opacity using the Opacity slider in the track's header. 

 To adjust opacity of an individual source you can double-click it to 
expand its source strip and adjust the Opacity slider in the strip's 
header, or reveal the source's opacity envelope by clicking the 
Show/Hide Envelopes button at the bottom-left of the Timeline while 
the source is selected. An adjustment to the envelope is independent of 
the source or track's Opacity slider, and multiple Key Frame settings 
along an envelope also allow for opacity change over time. 
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Text and Titles 
Text sources in MoviePlus can be used as overlays, scrolling titles or 
credits, even masks so that you can create text-shaped video cut-outs. 

Adding text to your Timeline 

Text is one of the two kinds of sources available in the Sources pane—
an area dedicated to computer-generated sources (rather than the 
video/image/audio files available via the Explorer pane). Select Text 
from the two choices in the left side of the pane, then choose a text 
source from the right-hand pane, clicking and dragging it over a video 
track on your Timeline. 

 

Note that text has some special properties: when it is dropped on your 
Timeline, you might notice white text on a black background. These two 
colour choices are actually "automatic" rather than fixed as white and 
black. The black background is present automatically when there is no 
other image, colour source, or video underneath your text, the text is 
drawn white automatically. 

Editing text 

Using the presets available in the Text category of the Sources pane 
means you have a few easy starting points for your project text, but you 
may customise each text source to suit your needs if required. You can 
use the Edit Text pane to change the font (typeface), font size, 
paragraph alignment (left/centre/right) and colour. 
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The Edit Text pane 

 

 The Edit Text pane allows you to edit a selected text source 
(selected on the Timeline by clicking it). You can view the Edit Text pane 
by clicking the tab amongst your MoviePlus panes or by clicking the Edit 
Text button in the Properties pane when you have a text source 
selected. Click and drag inside the Edit Text pane with your mouse to 
select regions of text to replace or to apply formatting to. When 
selected, text can be replaced just by typing new text using your 
keyboard. 

Use the Return key to start new lines of text, and choose left, centre, or 
right justification for your text (select multiple lines first if you want to 
justify more than just the current line).  

Text over other sources 

 

To use your text as an overlay above your video, images, or an alternate 
background colour, you need to layer your sources on multiple tracks. 
The illustration above shows a two-track project—choose Video Track 
from the Insert menu to insert a new video track to your Timeline. Any 
text source can be added from the Sources pane (and edited in the Edit 
Text pane) to the empty upper video track by dragging and dropping. 
You can also use the same principle to add text over images or colour 
sources. The text will be overlaid over the video source. 
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Scrolling text 

Scrolling text is used to move your whole text block to a different part of 
the available video area, to scroll your text up, down or across the 
screen, and to create a custom text animation. 

Select the text source you want to scroll and take a look at the available 
options in the Properties pane. 

The Scrolling option offers a pull-down list with up, down, left and 
right choices. Each of these will cause your text to smoothly animate in 
the direction specified, starting and ending "off-screen". 

To slow down the scrolling, increase the duration of your text source on 
the Timeline. 

Custom animations 

 To create a non-standard scroll, pan or other animation, you can 
use a transform envelope. Transform envelopes can be modified for 
any text, colour, image or video source, as well as video tracks and 
collections of tracks in video groups. In short, you need to reveal the 
component's envelopes by clicking the Show/Hide Envelopes button at 
the bottom-left of the Timeline, then select the transform envelope's Key 
Frame and modify the transform using your mouse in the Preview pane 
or specific values in the Properties pane. Add multiple Key Frames with 
different properties specified for each to create video animation, 
scrolling, panning, etc.—for full details see Transforms on p. 90. 

Deciding on a Background 

Text, like other sources containing transparency, reveals a default black 
background when there is no other video, image or colour source 
underneath it. 

What is on display underneath your text depends on the structure of 
your Timeline: the screenshot in Text over other sources on p. 113 
shows a pair of tracks with text on top of a video source—in the 
composition of your project, this will mean the text is drawn on top of 
your video source as long as these two tracks are adjacent in this order. 
Drag the track headers up or down the Timeline to organize them to suit 
your needs. 

Choosing a background colour 

You can add a colour source to your Timeline to create a region of 
colour. The colour source's actual colour can be set using the Properties 
pane. A colour source would need to be on a track below your text 
source to act as a background. 
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Editing Your Audio 
Audio can play an essential part in any movie, and creative audio editing 
is an art in itself. Standard ingredients of a soundtrack might include: 

• Production sound as originally recorded (and later captured) “in 
sync” along with the video, e.g. camcorder footage of your last 
holiday 

• Theme music or background sound from a variety of sourc
often added as one or more longer 

 es, 
clips that run “under” 

spoken-word or foreground sound 

• ten serving as a 
commentary or a bridge between sections 

• ed for 

t just the 
ther audio... all are easily 

Here's a few tips concerning audio compression and recording. 

Voiceover passages recorded separately, of

Sound effects or single-shot audio events, perhaps add
emphasis (“sweetening”) or comic relief 

If you would like your movie to include more than basic production 
sound, allow yourself some time to do it right! Skillful sound editing is a 
combination of technique and judgment. Fortunately, MoviePlus makes 
the technical part straightforward. Getting sound to coincide properly 
with the visual track, to come in on cue and end (or fade out) a
right moment, to blend well with o
accomplished via the Timeline.  
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Audio Tips 

• Just as video files are compressed with video codecs, audio is 
compressed using audio codecs. The audio codec you choose 
will affect not only the size of the video, but the audio quality. 
MPEG Layer 3 (MP3) is an excellent audio codec with a high 
compression factor. Check Web sources for details on the many 
other alternatives. 

• If recording audio through your system’s sound card, check its 
control panel software to make sure the correct 

 

 
 

e 

ialog in MoviePlus—this is under the 
Audio Details section. 

• 

empty 

ctor to distribute a mono signal to both sides of a 
stereo input. 

• 

dio track over the silent footage 

input channel 
(for example, MIC or LINE IN) is selected, and to set a volume 
level for the input channel. Note that the input volume setting is
separate from the master (Windows) playback volume setting.
The input level will affect your recordings; the playback level 
will not. If you hear an echo, you may want to switch off th
card’s WAV output channel, or uncheck the Preview Audio 
button in the Capture d

For voice recording and many soundtrack situations, “Mono” is 
fine as a Channels setting. MoviePlus will monoize (combine) 
the left and right sides of the input signal. But when connecting 
your audio source, try to avoid feeding a mono signal to just 
one side of a sound card’s stereo jack; that will leave an 
channel (i.e. noise) on the other side, and the noise will 
degrade the signal somewhat. It’s sometimes advantageous to 
use a Y-conne

If you are adding silent video footage and want to avoid 
dropouts on your soundtrack, you have several options: 

• insert the new video source over an existing audio track 

• mix in some new audio creatively over the silent sections 

• stretch-repeat an existing au
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Adding and Combining Audio 

Whenever you add a video source with an audio component to the 
Timeline, e.g. an AVI file, the audio portion is automatically added to an 

o track. These two tracks still 
an unlink the audio at any time, 

for example to replace it with some other sound, e.g. a piece of music, 
ite song or soundtrack. This is possible by adding your 

mploy an external sound editing program to even out widely 
disparate levels prior to bringing the files into MoviePlus. 

 

ing this reference clip, adjust your volumes by adjusting the 
Gain source(s), track(s) or group(s) and 

es for a normal level. Setting a 
cons ell if a particular clip is too loud or 
t

Sim

audio track which accompanies the vide
maintain a linkage by default, but you c

maybe your favour
new audio file to the Timeline on a newly created Audio track. 

As the Audio track is treated in much the same way as a video track on 
the Timeline, with respect to adding and combining tracks, please see 
Arranging Sources on p. 53 for more information. 

Adjusting Volume and Balance 

Adjusting Volume 

Whether an audio clip plays separately or is blended with an overlapping 
clip on another track, setting the right volume level is critical. In 
general, try to record your original audio files at a consistent level. You 
can also e

As a rule, you will want all the sounds in your movie to maintain the
same peak level. At the start of a project, and in each editing session, 
it’s a good idea to play back a standard audio clip with suitable peak 
levels. Us

slider (see below) on your audio 
calibrate your speakers or headphon

istent baseline is the best way to t
oo soft. 

ple Volume Adjustment 

In MoviePlus, the volume adjustment on any audio source, track or 
group can be made by adjustment of the Gain slider , e.g. for a track 
header.  
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Move
decr

 the slider to the right to increase volume and to the left to 
 

n 
ade in 

ak, and ending levels and achieve 
smooth fade-ups and fade-downs. 

ease volume. Note that this is a simple adjustment that can only be
applied throughout the lifetime of the audio track playback. For a
individual audio source or group the volume adjustment can be m
the same manner. 

Volume Adjustment over Time  

For volume adjustment over time, any audio source, track or group on 
the Timeline provides a small strip illustrating the volume level over 
time, called the Volume envelope. By adjusting this envelope, you can 
set each audio clip’s starting, pe

 To adjust the volume levels of an audio source, track or group via 
the envelope, first select the object on the Timeline. Display the 

ope for source, track or group by clicking the Show / Hide 
lopes button. On the envelope's red horizontal line click your 
e button to produce a key frame (a red button) at the very start 

and end of your audio track. Add another two key frames just after the 
t and just before the end key frames. The Timeline allows you to 

drag each of these key frames left, right, up or down. This permits fade-
up and fade-down—drag the first and last key frames to the bottom of 

envel
Enve
mous

star

the line and the second and third key frames to the top of the strip. You 
should see something like this: 

 

s an abrupt “cut-in” at the start of the clip, with 
the sound instantly reaching its peak and ending as a “cut-out” just as 

one.  

r 
 you temporarily mute a sound effect, or switch off a 

particular Audio track.  

This audio envelope show

abruptly when it’s d

Muting 

You don’t have to delete a track from the Timeline to exclude it from 
playback. Switching off a particular Audio track can be extremely helpful 
when editing the mix. For example, you might want to see how you
movie plays back if
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 To exclude an audio track, select the track and click the Mute button 
 the track header. 

Adjusting Balance 

Adjusting the balance follows the same principles as adjusting volume. 
For simple adjustments, a Pan slider is available in the track header. For 
adjustments to the balance over time, use the Pan Envelope below the 
Volume envelope to add key frames. These key frames and their vertical 
and horizontal positioning across the Timeline will allow balance to 
change over time. 

in
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Applying Effects 
Effects can add variety and visual excitement to otherwise humdrum 
sections of a movie, or extend your repertoire of cinematic techniques. 
For example, you can apply a Diffuse Glow to brighten highlights or a 
Greyscale effect to turn a video clip into an old black-and-white film. 
Some effects, like Brightness/Contrast or Gamma, are designed to 
correct the original image; others, like Mosaic or Diffuse Glow, are 
simply special effects. The Effects tab gives you more than 20 effect 
presets—but the ability to create an unlimited number of your own 
effects is a major feature of MoviePlus.  

The supported special effect categories are described as follows (effects 
used for colour correction are described on p. 128): 

Chroma Key A method of removing a colour (or a colour 
range) from one video or image to reveal 
another video or image behind it. The 
"removed" colour becomes transparent. 

Colourize Offers an easy way to apply a colour wash to 
an image or video. 

Diffuse Glow This broadens highlights in the video by 
brightening gradually outward from existing 
highlights. 

Gaussian Blur The Gaussian Blur effect smoothes the image 
or video by averaging pixels. It's especially 
useful for removing a moiré (interference) 
pattern from scanned images and can help 
regions of visual interference from fine 
patterns. 

Gradient Map The Gradient Map adjustment is for 
remapping lightness information in the video 
to a new colour range. It makes for great 
"posterized" effects and is a quick substitute 
where a pop-art feel is being sought. 

Greyscale This effect turns your movie or images into 
shades of grey; monotones ranging from 
black through to white. 

Invert This effect inverts the colours in your video, 
in the same way that a photo and its 
negative or colour opposites of each other. 
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Mask The Mask effect is a useful way to convert a 
video or image into a more suitable mask by 
adjusting its lightness or other tonal values. 

Mosaic The Mosaic effect breaks the video or image 
into blocks of uniform colour for a tiled 
appearance. 

Threshold The Threshold effect creates a harsh duo-
tone black and white image, with no blend 
through shades of grey. 

Unsharp Mask Unlike many sharpening tools that affect the 
entire image, the Unsharp Mask effect works 
mainly at edges. It's excellent for improving 
image quality, especially with resized images 
or video. 

 

An effect can be applied equally to a source, track, group or master 
group by using the same method. Either a single or multiple effect can 
be applied at any one time—in fact, multiple effects can be applied by 
using their own Effects Group. 

Effects Groups 

While it is not necessary to use effects groups in many cases, they are 
necessary if you wish to blend affected and unaffected video, also called 
mix back. This can be achieved by manipulation of the Effect Group 
envelope. Working with envelopes is explained in detail in Opacity 
Envelopes on p. 74. The same principles can be applied to Effects 
Groups. 

To create an effects group, go to Insert>Video Effect Group when a 
track or source is selected. An Effect Group strip appears at the bottom 
of your Timeline. 

 

 or  Click the Show/Hide Envelopes button in the header 
section of an effects group. The button's appearance will be different 
depending on whether the effect group has been modified previously 
(straight if unmodified). Either button type will reveal the envelopes in 
the Key Frame View for the effect group you clicked on. 

 



MoviePlus 4.0 Companion | 125 5. Adding Effects and Transitions 

Applying Simple Effects 

Effects are available from one of MoviePlus's selection of panes, called 
the Effects pane. 

 

To apply a simple effect, point to the effect thumbnail for an animated 
preview in the Effects pane, then drag the chosen effect onto the 
Timeline’s video source, track or group. The effect will immediately be 
applied to your chosen object.  

Note that an effects strip has been added at the bottom of your Timeline, 
i.e. 

 

This shows that the Adjust HSL effect has been applied to an object. 

 Incidentally, you can switch on or off the effects strips in the header 
of your video source, track or group whenever you like. Use the Show / 
Hide Effects button. 

Simple effects are applied for the duration of the source, track or group. 
However, more subtle effects can be added by Applying Effects over 
Time (see p. 126). 

Customizing your Effects 

Any effect added to your project will have its own set of properties 
associated with it. These are highly customizable via the Properties 
Pane, just like any other object in MoviePlus. Try clicking the effect name 
in the header of the Effects strip and check its properties in the 
Properties Pane. 

The ability to customize effects by changing these property settings 
means that the presets supplied are merely a starting point for you to 
further create and save your own effects to your own requirements. 
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 A Save button on the Properties Pane lets you store your own 
settings to a new name in the Effects pane along with your existing 
presets. 

Applying Effects over Time 

While it's possible to apply an effect for the entire duration of a source, 
track or group, it may be more effective for effects to be applied more 
sparingly over a specific, perhaps shorter, time duration.  

It is possible to specify how an effect is applied along your Timeline by 
use of Key Frames at different points. These Key Frames describe how 
an effect's properties are to be applied at that point on the Timeline. 
During preview, as the caret passes over each key frame the video will 
use the effect properties of the last visited effect key frame. The effect 
can be faded-in, faded-out, toggled on or toggled off. 

Incidentally, key frames are explained in detail in Editing opacity 
envelopes on p. 75 where the application of the key frames is to 
change opacity but the principle is the same for effects, transitions, etc. 

Blending Effect with Original Video 

A series of effects can be blended with your original video source, track 
or group very simply. As blending involves the layering of one 
component on top of another (with varying degrees of opaqueness), a 
set of effects can equally be blended with our original video component. 

However, if you are applying a series of effects, the adjustment of each 
effect's opaqueness is not always possible. In fact, some effects don't 
possess their own opacity. To overcome this we can add our combination 
of effects into their own Effect Group, whose overall opacity can be 
adjusted independently. The Effects Group can be added to your video 
source, track or group by selecting Insert>Video Effect Group. Simply 
drag each separate effect onto the Effect Group header to add it to the 
group. 
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Three effects stored under an Effect Group associated with a video 
source are illustrated below: 

 

To increase the opacity, click on the grey key frame on the Effect Group 
strip and drag the key frame down to increase the opacity of the Effect 
Group, and hence the effects in the blended video output. The example 
applies a uniform level of effect opacity but more key frames can be 
added to alter effect opacity over time (see Applying Effects over 
Time on p. 126).  

Combining Effects 

Effects can be applied to a video source for two main reasons—you may 
want to fix a deficient video source or you may just want to add a 
"special effect". Either way, it's more than likely that you may want to 
combine both types of effects and to have them applied simultaneously.  

The same principles as those described in Adding and Arranging 
Tracks on p. 58 can be used when combining video effects, i.e. effects 
can be organized in the Timeline's header region in a vertical sequence, 
composed from the top downwards just like video and audio tracks.  

The order in which you apply your effects is not critical but typically any 
video "fixing" effects, such as adjusting hue, saturation or light, are 
applied first with any enhancing effects (Chroma key for blue screening) 
applied afterwards, e.g. 

 

NOTE: Use the eye icons on each effect to switch on or off the individual 
effects when working with complex combinations. This will give you more 
control and will lead to better results.  
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Colour Correction 

The Effects pane includes a wide variety of colour adjustment presets 
that you can apply to video sources. These adjustments—to brightness, 
contrast, hue, and so on—are usually carried out in order to improve a 
deficient video source.  

The adjustments are made by first of all applying an effect to a 
selected video source. In the resulting Key Frame View, the Effects strip 
will be displayed. By clicking on the key frame (a red button) on the 
Effects strip, the keyframe properties for that effect can be adjusted. 

 

For brightness and contrast, the keyframe properties pane would display 
Brightness and Contrast sliders that can be adjusted independently, i.e.  

 

In this case the brightness has been increased by 18.5%. Note that each 
effect will have its own set of properties for adjustment. 
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Let's take a look at the colour adjustment effect categories in turn. 

Adjust HSL Hue, Saturation, and Lightness (HSL) are components 
of a standard colour model that's used to identify 
colours. Generally speaking, Hue refers to the colour's 
tint—what most of us think of as rainbow or spectrum 
colours with name associations, like "blue" or 
"magenta." Saturation describes the colour's purity—a 
totally unsaturated video has only grays. Lightness is 
what we intuitively understand as relative darkness or 
lightness—ranging from full black at one end to full 
white at the other. Adjust HSL lets you alter these 
components independently. Experiment with the 
separate Hue, Saturation and Lightness sliders in the 
dialog accordingly. 

Brightness / 
Contrast

Brightness refers to overall lightness or darkness, while 
contrast describes the tonal range, or spread between 
lightest and darkest values. This is a "quick and dirty" 
way of correcting an video, e.g. one that was over-
exposed or under-exposed.  

Colour 
Balance

The Colour Balance adjustment lets you adjust colour 
balance for general colour correction in the video 
source. Adjust the Cyan / Red, Magenta / Green and 
Yellow / Blue sliders left or right to lower or raise each 
colour mix. 

The colours are paired together so moving the slider 
from the centre to the left increases the amount of 
cyan, moving from the centre to the right increases the 
amount or red. The same mechanism applies to the 
Magenta / Green and Yellow / Blue sliders. 

Gamma The Gamma adjustment lets you adjust the amount of 
mid-tone brightness in your video source. Think of 
midtones as the grey shading that lie between shadows 
and highlights present throughout your video source.  A 
single Gamma slider controls the midtone distribution 
curve for pixels, where a value of 1.00 is the nominal 
slope set prior to adjustment. Move the value to <1.00 
to lighten the mid-tones of your video or to >1.00 to 
darken them. The brightening should leave very dark 
and very light regions less affected than mid-tones. This 
can also be done via the Levels effect. 

Levels The Levels adjustment lets you emphasise mid-tone 
lightness regions in each or all of the three primary 
video colours, red, green, and blue. 
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The key frame properties dialog displays a set of "in" 
and "out" sliders to represent input and output, 
respectively (input and output means pixel values 
"before" and "after" any adjustment is applied.  

To increase image contrast, narrow the spread between 
low and high input values by raising and/or lowering the 
Low In and High In value, respectively. Setting the Low 
In value tells the adjustment filter to "locate any pixels 
that are initially this dark (or darker) and set their 
lightness to that of the Low Out value." The High In 
value works the same way, but by remapping the 
lightest initial pixels to the High Out value.  

To reduce image contrast, you could narrow the spread 
between low and high output values. This will mean 
your resulting image will not have pure black and/or 
white pixels. To adjust the midtone values, raise or 
lower the Gamma value. See Gamma Colour Correction 
above. 

As a general guideline, colour correction is normally carried out on video 
sources, as most deficiencies will be inherited from the recording of the 
source (e.g., over-exposure, poor weather conditions, etc.) 
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Applying Transitions 
Any time one piece of video ends and another begins, a transition takes 
place. In its simplest form, the transition is simply a cut: in less than the 
blink of an eye, the last frame of a video clip is replaced by the first 
frame of a second video clip. In MoviePlus, the term “transition” applies 
to a more gradual way of switching from one clip to another. If you 
overlap the two clips slightly on separate tracks, you can then apply a 
time-based change between them. 

 

For example, you can dissolve (Cross-Fade) between one track and the 
other, or apply a variety of patterned wipes that use a moving edge or 
outline. Transitions such as Iris Wipe, Cross-Blur and Zoom & Spin 
are very popular in movie editing and are, of course, fully supported in 
MoviePlus. 

Applying Simple Transitions 

Transitions are available from one of MoviePlus's selection of panes, 
called the Transitions pane. 

 

Transitions are easy to accomplish. In general, first ensure that the 
video sources are placed on the same video track, one after the other 
with no gap. By then selecting the second video source and dragging its 
start over the end of the first video source you create a transition region, 
indicated as a box.  
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In this case a Cross-Fade is added by default—if you didn't see this 
region you may have to select the Auto-Transitions button. Try a video 
preview to check your transition. 

 To change a transition, just select one from the Transitions pane. A 
series of presets are available, all stored under different transition 
categories. Drag the selected thumbnail on top of the existing transition 
region to swap the old transition for the new one. Note how the 
transition name has changed and the Show / Hide Transitions button 
becomes enabled in the bottom left of the Timeline.  

As with other objects, you can also change the transition duration by 
dragging the left or right-hand end of the transition region to stretch or 
shrink it, and adjust its properties more accurately in the Properties 
pane, i.e. you can fine-tune the transition duration, interpolation and 
more transition-specific key frame properties. 

Simple transitions are generally applied over the overlap duration. 
However, more subtle transitions can be made by Applying Transitions 
over Time. 

Remember that each transition takes time to happen—so make sure the 
video in the overlap region is not part of the main action. If you expect 
to use transitions, it’s a good idea to allow a couple of seconds of non-
essential material at the start and end of clips when you initially capture 
them. 

Auto Transitions 

 MoviePlus by default will automatically create a cross-fade transition 
when you drag a source over another source (cross-fade for video and 
images, fade for audio). If you do not want MoviePlus to automatically 
create transitions, you can disable this feature using the Auto 
Transitions button on the Editing toolbar. 

Snapping 

 If snapping is enabled with the Snapping button, the transition will 
conveniently fit into the overlap region. If snapping is disabled, or you 
drag the transition to an overlapping area between tracks, it will adopt a 
default overlap time as set in Tools>Options>Editing. 
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Customizing your Transitions 

Just like effects, transitions added to your project will have their own set 
of properties associated with them. These are highly customizable via 
the Properties Pane, just like any other object in MoviePlus. Try right-
clicking on the transition region and check its properties in the Properties 
Pane. 

The ability to customize transitions by changing these property settings 
means that the presets supplied are merely a starting point for you to 
further create and save your own transitions to your own requirements. 

 A Save button on the Properties Pane lets you store your own 
settings to a new name in the Transitions pane along with your existing 
presets. 

Applying Transitions over Time 

The main difference between adjusting effects over time and adjusting 
transitions over time is that any change to the transition can only take 
place in the duration of the transition rather than over a whole video 
source or track.  

 It is possible to change transitions over time by applying key 
frames. Any selected transition has its own Transition strip in Key Frame 
View. This view is shown by clicking the Show / Hide Transitions 
button at the bottom left of the Timeline. As for effects, the strip allows 
key frames to be place along its length which describe how a transition's 
properties are to be applied along the transition's lifetime, i.e. 

 

The transition and key frame properties are accessible by right-clicking 
on the key frame and selecting the properties option.  

During video preview, as the caret passes over each key frame the video 
will effect change over time between the last visited key frame and the 
next key frame on the Timeline. The transition can be interpolated 
linearly or can adopt different types of quadratic or cubic algorithms to 
effect different rates of change. 
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This is best described if we use an example—an unusual “spinning” linear 
wipe between two video clips. To do this it is necessary to vary the angle 
of a Linear Wipe transition over a 5-second period. The angle will vary 
over time between 90° (start) and 360° (end). This is configured in the 
Key Frame properties for the key frames at the start and end of the 
transition. 

The video preview will show the transition as follows: 

  

After 1 second After 2 seconds After 3 seconds 

Incidentally, key frames are explained in detail in Editing opacity 
envelopes on p. 75 where the application of the key frames is to 
change opacity but the principle is the same for effects, transitions, etc. 
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Sharing Your Movies 
There are a number of ways you can share your movie once you've 
edited it with MoviePlus... the project might look fantastic in your 
Preview pane, but there's an upper limit to how many people can crowd 
around your monitor and watch your preview, so you'll need to export 
your movie in a standard distributable format to allow others to share 
the experience! 

The considerations you'll face when deciding how to share your 
MoviePlus creations are the same for all video editors—the most 
important is "what device will the video be watched on and how am I 
going to deliver the video to the intended viewers?" This double-
barrelled question, once answered, will help determine how you should 
export your movie for best results. 
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Viewing on a computer 

Delivery via the Internet 

The Internet has been promising to offer widespread video content for 
some time and the rise of domestic broadband connections makes this 
closer to reality. You can include videos on your own Web space for your 
site's visitors to download; raw video is still too large to download in any 
reasonable time and too large to store on typical computers so the video 
must be compressed at export time. Broadband connections come in 
many speeds and flavours—and are not available to all—so you may like 
to consider whether you should offer two versions of your video to allow 
for different connection speeds or just make your video suitable for 
everyone by creating it with as small a file size as possible.  

A small file size is best achieved by exporting your file having adjusted 
some important settings: 

• set a small size (320x240 pixels or lower) 

• use video compression (a codec) 

• reduce the video's frame rate (number of pictures per second) 

ives 

 

hly 

ze, 

 compression and quality control 
to the audio accompanying your video. 

 
rt to 

r project as a video file when you are happy with your 
settings. 

Modern MPEG-4 codecs (such as those offered by Microsoft or derivat
of the original MPEG-4 format including DivX® and Xvid) offer a very 
good balance between file size and quality. For a 320x240 video with 25
frames per second you can typically achieve excellent quality using an 
MPEG-4 codec with under 800kbps (kilobits per second) of data, roug
100KB per second. There's no magic wand that can make excellent 
quality video occupy a very small file size, you will always need to 
compromise, swinging towards quality or towards a very small file si
not both. Video sized and compressed as described above occupies 
roughly 6MB per minute of footage, perhaps 1/60th the size of good 
quality DVD video. You can apply similar

To adjust these export settings and make a small compressed video file 
for the Internet you should choose Video for Windows (*.avi) as the 
file type and select the Multimedia template on the Basic tab, then on 
the Advanced tab set the video size (Width and Height), Frame rate 
and Codec. You should also adjust the codec Properties or the Quality
slider (if available) to help manage the video's file size. Click Expo
export you
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Delivery on a CD 

You can choose to export to AVI format or WMV (Windows Media Video). 
The latter is naturally best supported by Windows PCs so is less suitable 
if your intended recipients are not running Windows PCs. AVI formats 
can contain many different types of compressed video and there is little 
guarantee that your chosen compressor is available as a decompressor 
on the viewer's PC, unless you choose a common standard format 
included with Windows such as Cinepak by Radius or Intel Indeo 4.5. 

For Windows users 

If you know you are distributing your movie to Windows PC owners, 
there is an excellent chance that they will have a recent version of 
Windows Media Player installed. MoviePlus offers WMV (Windows Media 
Video) export with templates for differing file size and quality presets. 
WMV makes it easy because you don't have to worry about "codecs", but 
viewers do generally need Windows Media Player to be present to play 
the video. Although Windows Media Player is normally required, it is 
possible that PC or Mac owners are using alternate media playing 
software that supports WMV files, such as the popular cross-platform 
(and free, at the time of writing this) VLC Media Player 
(http://www.videolan.org/vlc/). 
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Export as File 
There are many different reasons for exporting your movie as a file, but 
they all share the need or wish to get other people viewing your video 
masterpiece. Crowds around your own computer screen using the 
MoviePlus Preview pane to watch your video just aren't practical! 
Whether your driving force is to attain a small file size to share a little 
video by email or over the Internet, MoviePlus can export your projects 
in a suitable format to help you achieve your goal. 

Your basic choice of sharing format as well as any necessary "fine 
tuning" settings will help decide how best to export your project. 
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File types 

MoviePlus exports three basic kinds of video file and two types of audio 
file. Here's a table showing what these formats can be used for: 

Export 
format 

Type What is it and what is it useful for? 

AVI Video 

Windows "Audio Video Interleave" file, for 
playback on a computer. Supports different 
types of video and audio compression. AVIs 
are mainly for viewing on a computer, but 
some types of AVI can also be played on 
modern DVD players supporting compressed 
"MPEG-4" and similar files. 

MPG Video 

An acronym for "Motion Picture Experts 
Group", MPEG format video is compressed 
and widely supported by computers and DVD 
players. MPEG-1 files are better supported by 
computers and are also used to make Video 
CDs; newer MPEG-2 files are often higher 
quality and are typically used to make SVCDs 
& DVDs. 

WMV Video 

WMV stands for Windows Media Video and is 
best supported on PCs running Windows 
Media Player, although some other software 
even on other platforms can play WMV video. 

WAV 
Audio 
only 

A Windows Waveform sound file, commonly 
supported on other platforms. WAVs normally 
(but not always) contain uncompressed 
stereo audio. 

WMA 
Audio 
only 

Windows Media Audio, a compressed format 
making smaller files, designed for playing 
with Windows Media Player but now also 
supported by many hardware MP3 players. 

   
Next we'll examine some popular usage for file exports and describe the 
best basic settings to use in each case. 
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Export Procedure 

Standard 

• Click the Export to File button on the Standard toolbar, or choose 
the File>Export Movie>To File menu item. 

• Select your chosen export type from the  
. 

 Popular Output Formats (below) to choose your 
export option. 

• 

rted 
at and you will be shown a progress bar 

during this process. 

See Advanced Settings on p. 148 for more detailed information. 

File type and Template 
drop-down list according to the type of output format you require
Use the table in

Specify a name for file in the filename box, clicking Browse and 
selecting a new location if you first wish to choose an alternate drive 
or folder to store your file. When you are happy with your filename, 
export type, and export template, you can set an export quality and 
then click Export. Your project will then be composed and conve
into the specified form
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Popular Output Formats 

Reason for 
Export 

File Type Template1 Supporting 
Notes 

DVD-compliant 
file for later use 
in a DVD-
authoring 
program 

MPEG Video 
(*.mpg) 

DVD PAL, 
DVD NTSC, 
DVD PAL 
Widescreen, 
DVD NTSC 
Widescreen 

MoviePlus can 
export your MPEG 
for authoring on 
a DVD-authoring 
program. If you 
would like to add 
menu and 
chapter features 
to use this 
method and then 
use an 
application such 
as Sonic MyDVD 
to author your 
menus and burn 
your disc. 

SVCD-compliant 
file for later use 
in a disc-
authoring 
program 

MPEG Video 
(*.mpg) 

SVCD PAL, 
SVCD NTSC, 
SVCD PAL 
Widescreen, 
SVCD NTSC 
Widescreen 

MoviePlus can 
export a file in 
readiness of you 
writing a Super 
Video CD (SVCD) 
with menus and 
other advanced 
features in 
another 
application. 

VCD-compliant 
file for later use 
in a disc-
authoring 
program 

MPEG Video 
(*.mpg) 

VCD PAL, 
VCD NTSC, 
VCD PAL 
Widescreen, 
VCD NTSC 
Widescreen 

MoviePlus can 
also export a 
video file in 
readiness for 
burning to a 
Video CD (VCD) 
in another 
application.  

general-purpose 
use 
(high 
compatibility; 
low quality) 

MPEG Video 
(*.mpg) 

MPEG-1 MPEG-1 files are 
widely supported 
so they are a 
good choice for 
short snippets of 
video for general 
consumption. 
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They can be 
written to CD or 
made available 
for download via 
the Internet. The 
format does not 
need special 
decompression 
software 
(codecs). 

general-purpose 
use 
(low 
compatibility; 
high quality) 

MPEG Video 
(*.mpg) 

MPEG-2 MPEG-2 files are 
quite widely 
supported but 
they generally 
require 
specialised 
software to 
enable playback. 
This is because 
MPEG-2 decoding 
comes at a price, 
so it is not often 
supported by free 
media playing 
software. This 
format does 
support high-
quality video so is 
still preferred for 
some uses above 
and beyond 
general-purpose 
MPEG-1 video. 

Internet ready Windows 
Media audio 
and video 
(*.wmv) 

Any2 Take advantage 
of the widely 
distributed WMV 
format and its 
inherent 
streaming 
capabilities, 
optimised for 
viewing in the 
popular Windows 
Media Player. The 
format does not 
require any 
specific codec. 
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For CD 
distribution 
(to Windows PC) 

Windows 
Media audio 
and video 
(*.wmv) 

Any2 As for Internet 
ready above. 

For CD 
distribution  
(to non-Windows 
PC)  

MPEG Video 
(*.mpg) or 
Video for 
Windows 
(*.avi) 

 The type of file 
you export for 
distribution on 
CD is dependent 
on how you want 
people to use the 
CD, how they will 
view the video 
you are 
distributing.  

Writing movie 
back to a DV 
camera 

Video for 
Windows 
(*.avi) 

DV PAL, 
DV NTSC, 
DV PAL 
Widescreen, 
DV NTSC 
Widescreen 

The DV video 
format is used 
extensively by 
digital video 
cameras, so 
many video 
sources exist in 
this format 
before being 
edited. You can 
export your 
project as a DV 
file for future 
editing or for 
writing to a 
camera later. 

NOTE: To 
maintain 
compliance with 
the DV standard, 
it is not possible 
to modify the 
Advanced 
settings for the 
standard DV 
export templates, 
but if you wish to 
fine-tune your 
export you can 
copy a DV 
template in the 
Advanced tab and 
make changes to 
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the new 
template. 

Audio export Waveform 
audio (*.wav) 

32 kHz Stereo, 
44.1 kHz Stereo, 
48 kHz Stereo 

You may find 
occasion where it 
is useful to 
export just the 
audio from your 
project. 
MoviePlus will 
compose all of 
your tracks and 
editing operations 
to generate a 
single audio 
output in mono3 
or stereo. 

44.1 kHz is the 
standard for CD-
quality audio, 44 
kHz is the 
modern standard 
for DVD movies 
and other digital 
audio formats. 
You can alter the 
compression 
format (select a 
codec), switch 
between mono 
and stereo 
output, and alter 
the sample 
frequency. Lower 
sample 
frequencies can 
be used for low-
fidelity audio, 
such as speech, 
and are suitable 
where you are 
trying to reduce 
the audio file's 
size. 

 

1 If you are not sure whether to choose a PAL or NTSC template, see 
below. 
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2 Template choices reflect the throughput (i.e., connection speed) that 
you can serve to your intended audience on your WWW site—the 
templates are listed in the order of low- to high-speed Internet 
connections, giving increasing levels of video quality. 

3 For Mono, use the Advanced tab to create a new template and change 
the Channels option to Mono. 

Export Quality 

The Export Quality setting will perform additional video and audio 
processing as the quality increases. Choose Good quality or higher for 
high-standard export processing, choose Draft or Preview for test 
purposes. 

Exports at Best quality take a long time for most formats so be prepared 
for a high-quality export to be quite slow. If your video is intended for 
general viewing by friends and family you can set a lower export quality. 
Draft and Preview settings are good as tests; with Normal, Good or 
High quality you will enjoy great results and the export will take notably 
less time than at Best quality.  

NTSC and PAL 

Whether you choose a PAL or NTSC template should depend on whether 
you intend for the video to be viewed in a PAL region or NTSC region. 
NTSC is the broadcast and recording standard used mainly in North and 
South American continents, plus parts of eastern Asia including Japan 
and South Korea. For example, if you wish to create a file suitable for 
use in the USA you should choose a suitable NTSC DVD export template. 
Choose a Widescreen variant of your selected template if your source 
footage or project is already in Widescreen format. PAL is used widely 
throughout Europe, Africa, the Middle East, Asia, and Oceania. If you 
wish to create a PAL video you should choose a suitable PAL video export 
template. 

The export progress box 

During export, you will see a progress bar displaying the progress made 
through rendering your project and encoding it to the selected output 
format. Upon completion, you can click Open to play the resulting video 
in your default media player software, click Open Folder to view the 
folder containing your export in Windows Explorer, or click Close to close 
the progress box and return to MoviePlus. 

Note that if you click Cancel to abort the export process, MoviePlus will 
quickly finish the segment of video being encoded and will leave you a 
functioning but incomplete video file. You may wish to Open Folder and 
delete the video if you do not wish to keep it. 
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Advanced Settings 

Templates 

The list of templates changes according to the type of file export you 
have chosen: for AVI exports, there are templates for DV and Multimedia 
AVIs; for MPG you have choices encompassing VCD, SVCD, DVD and 
multimedia MPGs. You can change your selected template by selecting 
another from this list; the change will also be reflected in the Basic tab 
of the Export dialog, as this setting is available from both locations. In 
order to maintain compatibility with some video formats, some 
templates do not allow modification of their settings—for this reason you 
can make a copy of a template to further modify (see below for more 
information). 

Copying, Renaming, Deleting Templates 

You can create your own templates based on existing entries in the 
Templates list. You may wish to create a few different "multimedia" 
templates to save time in changing settings when you export your 
projects, or perhaps modify an existing DV or DVD template to enhance 
quality or adjust another setting. 

Choose a template to modify then click the Copy button. Type in a 
suitable name for your template, such as "Optimised DivX Internet AVI 
160x120". Make adjustments to the template settings to suit your needs. 

Once a template has been created in this way, you can later rename or 
delete it using the Rename and Delete buttons. 

Start/End Time 

Rather than exporting your entire project, you can specify a Start time 
and End time to export just part of your project. 

Quality 

This setting matches that offered in the Basic tab of the Export dialog. 
You can determine what kind of processing is carried out during the 
export of your project by choosing one of six preset quality settings. 

Video Details 

Width and Height, given in pixels, determine the screen size of the final 
movie. DV and DVD movies are 720 wide by 576 high for the PAL format 
or 480 high for the NTSC format, but movies can range down to tiny 
sizes suitable for animations on the Internet. Try and keep the pixel 
sizes divisible by 16 for good compatibility with different video formats—
some AVI codecs for instance are particular about the size of the video 
they are able to encode. 
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Pixel aspect ratio determines whether pixels are squashed, stretched, 
or left in their native (square) format as needed to achieve a particular 
movie screen size. You should use the setting automatically included 
with the template but if you wish to modify the pixel aspect ratio, use a 
ratio written as a decimal number near 1.0; lower than 1.0 is squashed, 
larger than 1.0 is stretched—e.g. for DVD PAL Widescreen compliance 
use 1.4568. 

Frame rate (in frames per second or fps) of source material is typically 
determined by the broadcast television standard in use, i.e. NTSC or 
PAL. NTSC generally uses 29.97 or 24 frames per second, the PAL 
standard is 25. For general purpose video you should still conform to the 
standard in your region, but you can reduce the frame rate if you wish to 
optimise the file size of your video for Internet download. 

Interlacing: Interlaced video (such as an analogue TV signal) builds 
each frame by splitting alternate lines from two separate scans of the 
picture area. The first or upper lines (or "field") contains the odd 
scanlines; the second or "lower" contains the even scanlines. (To 
visualize this, imagine that each of your hands is a separate video field, 
then interlace your fingers.) Non-interlaced ("no fields") or progressive 
digital video uses just one scan per frame. 

The Codec list shows video compressor/decompressors available on your 
system. For information about choosing a codec, please see A Guide to 
Codecs on p. 155. The Codec Properties button will allow you to fine-
tune the export settings for the particular codec you have chosen, 
providing that the codec manufacturer offers a properties window for 
their codec. 

Adjust the Quality setting (if available) for best results when you've 
selected a particular codec. Moving the slider to the right will increase 
export quality (and the time taken to export the project). This slider, 
unlike the basic quality setting, can affect the size of your movie as more 
video data is used per second of video to achieve a higher quality result. 

Audio Details  

Uncheck Export Audio to export the movie without an audio 
component. In most cases this will reduce the file size, so uncheck it if 
you don't need (or don't have) a soundtrack. 

Select the number of Channels to record. Mono means that just one 
audio stream is included, with no difference between left and right 
speakers when played back through a stereo device. Don't use "Stereo" 
unless necessary—two channels means a larger file size. 
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Bits per sample and Sample frequency together determine the 
amount of bandwidth allocated to each audio channel, which again 
translates directly to file size. As a rule, use "8-bit" for voice only, 16-bit 
for all richer audio. The higher the frequency range you select, the more 
sound will be sampled—so choose a number consistent with the sound 
quality you need to preserve. 44.1KHz is the CD-audio standard. 

The Codec list shows audio compressor/decompressors available on 
your system. Change the setting if you have a specific reason for doing 
so. 

Select a Format (if available) for best results when you've selected a 
particular codec. 

Advanced Settings  

If necessary, adjust settings for the type of AVI video file you want to 
capture. 

Check Version 1 AVI to export an AVI file which is compatible with 
older software (but cannot be larger than 2GB in size). Leave the box 
unchecked to export an OpenDML (AVI version 2.0) compatible file that 
can be any size. 

Adjust the Interleave rate slider (or enter a specific value in 
milliseconds) for faster or slower interleaving of audio and video data. 
Smaller values mean larger file sizes but more rapid cueing and startup 
when the file is played back (for example, in Media Player). 

 



MoviePlus 4.0 Companion | 151 6. Completing the Production 

Export to Camera (Print to Tape)  
The DV video format is used extensively by digital video cameras, many 
video sources exist in this format before being edited. Although 
MoviePlus can export your project to many types of video format, you 
can choose to export as DV to a connected DV camera or export your 
project as a DV file for later writing to a DV camera. Even exporting 
directly to your DV camera is a two-step process as MoviePlus first 
creates a suitable DV file before transferring it to your DV camera. 

To export to camera (also called print to tape): 

Step one 

• Select the File > Export Movie > To Camera menu item. 

A DV AVI file will be exported from MoviePlus before it is sent to your 
camera, to provide a smoother export and transfer process. 

• Specify a name for the file in the Filename box, clicking  
ou first wish to choose an alternate drive 

or folder to store your file. 

• 
. For 

information about choosing PAL or NTSC variants, see p. 147. 

• dio 

• When you are happy with your filename and DV template choice, 

 
 a progress bar 

during this process. When the export is complete MoviePlus will allow 
you to transfer the DV file to a connected DV camera. 

Browse and 
selecting a new location if y

Select a DV PAL or DV NTSC template from the Template drop-
down list that suits your needs. Choose a Widescreen template if 
your source footage or project settings are already Widescreen

The export Quality setting will perform additional video and au
processing as the quality increases. For information about the 
processing taking place, please see the MoviePlus Online Help 
system. Choose Good quality or higher for high-standard export 
processing, choose Draft or Preview for test purposes. 

you can set an export quality and then click Export. 

Your project's sources, tracks, groups, transitions and effects will then
be composed into a DV video file and you will be shown
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Step two 

• Once the first stage of exporting is complete, click the Exporting 
dialog's Continue button.  

• To view the movie as it w ill play back on your camera, select the 
Preview on Device tab. 

• 
suitable in-point on the tape. Place your camera in Stop mode. 

• 

sh 

bt, it's better to set the delay slightly too 

 To begin recording, click Write to Device.  

 

On the Write to Device tab, use the control buttons to locate a 

Adjust the Write Delay value if necessary to insert a timed pause 
before MoviePlus begins feeding data to the camera. A DV camera 
may be digital, but it's also mechanical and different transport 
mechanisms have different response times. A few tests will establi
exactly how long your camera takes to start recording once it's 
activated. (When in dou
long than too short.) 

•
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General Capture information 

The DV format 

"DV" stands for digital video, and while this is a term that can 
encompass all video data stored on a computer or other digital media, 
when written as DV it is normally referring to a specific format of video 
as now used in most digital video cameras. DV was developed as a high-
quality consumer digital video format by a consortium of companies 
including Sony, Panasonic, JVC and Philips.  

For DV and Mini DV video sources, MoviePlus will always capture your 
footage in its native format to maintain as much quality as possible 
during the capture and editing phases of your project. As a modern 
method of storing video data, DV offers higher resolution and three 
times more colour information when compared to analogue VHS and S-
VHS video, storing even more colour information than the NTSC 
broadcast standard. DV cameras also record audio in a digital format 
that rivals CD quality. 

DV occupies a fair amount of hard drive space on computers, 
significantly less than uncompressed video though, and it is suitable for 
converting into DVD-quality output. As a video format it is compressed 
with an approximate 5:1 ratio, meaning it occupies roughly one-fifth of 
the amount of hard drive space as uncompressed video of the same 
quality. While you can capture uncompressed video from analogue 
sources, DV video from modern DV devices maintains a good level of 
detail while taking up less hard drive space than uncompressed footage. 

MoviePlus is optimised for working with 'DV' video sources. 

Other video sources 

You can also capture video footage from analogue sources such as VCRs 
and simple live video sources such as Web cams, although for devices 
such as video cassette recorders you will need a capture card. A 
capture card receives the analogue video information from your video 
device and converts it into a digital format suitable for editing and 
playing on computers. In addition to the video being supplied by the 
capture card in its chosen format, you can choose to save the media in a 
format of your choosing during the capture process, but it is 
recommended that you capture at as high a quality as possible without 
further compressing your video or audio data. For some analogue or Web 
cam captures you may need to have a separate audio input to capture 
audio at the same time as your video. 
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Troubleshooting 

Although MoviePlus is optimised for modern systems with special 
processor instruction sets (MMX, SSE and SSE2), some slower systems 
may encounter 'dropped frames' during video capture. To rule out some 
system inefficiencies to improve video capture, please see Performance 
Notes on p. 167. 
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Capturing Audio from CD 
To capture audio from an audio CD, select the Tools > Capture From 
CD menu item. 

The Capture CD dialog 

 

This image shows in-progress capture of digital audio from a CD-ROM 
drive. Track 1 is being captured from the disc in drive D and there is 
sufficient of free space for the resulting .WAV audio file to be stored. A 
typical 6 minute audio track will occupy about 60MB of hard drive space 
when the audio is saved as a .WAV with no compression. 

The procedure to follow:  

Choose a CD drive and track then preview your audio 

In the Device pull-down, select the CD drive containing the audio CD 
you would like to capture from, then select the track number you wish to 
capture. 

Click Play to preview the track to make sure you will be capturing the 
intended audio and that the volume levels seems good. If your audio 
levels metre has sustained periods "in the red" then you should adjust 
the Volume setting in the Audio Details > Control section of the 
dialog. 
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Important Note: To be able to capture CD audio, the CD audio input 
needs to be enabled in your sound card's "mixer". Try double-clicking 
the Volume icon in your Windows system tray (next to the clock) to 
view your mixer settings. If you are running Windows XP you may also 
need to disable Digital CD Playback via your Device Manager>CD 
device Properties window>Properties tab as a troubleshooting step if 
your capture contains no audio. 

Set a suitable file storage location 

As mentioned above, a typical 4-minute audio track will occupy 40MB of 
hard drive space, a full audio CD could be over 700MB when captured, so 
ensure you have enough room on the drive you choose to save your 
captured audio to. Click the Browse button to choose a target location 
for your captured audio and specify a name for the file in Prefix. 

Choose an appropriate capture format 

You should capture at CD quality (Stereo, 16-bit, 44100Hz) to maintain 
the best sound quality during the editing of your movie project. If you 
would like your audio be more compact (take up less drive space) than 
CD audio, this is a task you can best defer to the end of your project, 
when exporting your project. 

If you still wish to capture a smaller file size, you can choose an audio 
compressor in the Audio Details > Format section of this dialog. Select 
a compressor from the Codec list and adjust the Quality slider if it is 
available. 

Record 

Click the Record button then click the Play button underneath your 
drive and track choice to begin the capture.  

When you are happy that the required track has been captured, click the 
Stop button. You can begin recording again to capture subsequent 
tracks; MoviePlus will name each captured file with an incremented 
number suffix. 

Keep an eye on the CPU usage during the capture process, if it reaches 
maximum levels it may result in "choppy" sounding audio. 
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Close the Capture module and return to MoviePlus 

 When you've finished capturing your audio, click the Close button to 
return to MoviePlus. In the Explorer pane, click the Capture button to 
navigate to the default folder for captured video, then drag your chosen 
source(s) onto your Timeline. 

Capture settings in detail 

Basic Settings 

Select the Source if you have more than one available audio source. 
Input means the physical line where the audio signal is arriving. This 
should typically be set to CD Audio. 

Click the Browse button to locate a specific destination folder for the 
captured file(s). Note: You can set the default Capture folder using the 
Folders tab of the Tools>Options dialog.... MoviePlus automatically 
numbers new capture files sequentially upward within the designated 
folder, preceded by the Prefix you enter here. 

Audio Details  

Uncheck Preview audio to disable audio preview. Depending on your 
sound card setup, this may eliminate echo through your speakers. 

The Input and Source drop-down lists match those offered in the Basic 
Settings section described above. 

Click the Source button to access device-specific settings offered by the 
device manufacturer. These may include input mixer options. 

Click the Format button to access device-specific audio settings offered 
by the device manufacturer. These may include audio format and quality 
options. 

Audio Details > Format 

Select the number of Channels to record. Two channels (stereo) means 
a larger file size and is only necessary if your source contains stereo 
audio to start with. The vast majority of audio CDs are stereo. 
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Bits per sample and Sample frequency together determine the 
amount of bandwidth allocated to each audio channel, which again 
translates directly to file size. As a rule, use 8-bit for voice only, 16-bit 
for all "richer" audio and music... sample frequency is to audio what 
"dots per inch" is to imaging—it translates most simply as "resolution". 
The higher the frequency range you select, the greater the "amount" of 
sound will be sampled each second. Choose a number consistent with 
the sound quality you need to store—44100Hz represents CD-quality 
sound sampling, 48000Hz is the new standard for digital audio (used for 
DVD videos and more). 

The Codec list shows audio compressor/decompressors available on 
your system. Change the setting if you have a specific reason for doing 
so. 

Adjust the Quality slider (if available) for best results when you've 
selected a particular codec. As is the case for video capture, it is best to 
capture at the highest quality and to defer any efforts to reduce file size 
to the export operation after you have edited your movie. 

Audio Details > Control 

Adjust the settings for the audio input device here. 

Check Mono to combine ("monoize") both sides of the input signal. 

Check Loudness for a lower-frequency equalization boost. 

Adjust Volume, Balance, Treble, and Bass sliders (or enter a specific 
value) to improve incoming audio quality. Use the volume level meters 
(from -90 to 0 dB) as a guide and remember to preview your 
adjustments by clicking Play before you capture. 

Advanced Settings 

Advanced Settings > Capture Device Pin Configuration 

Click the button to adjust settings for the input device, if troubleshooting 
problems with the Control setting (see above). This is an advanced 
setting that may be helpful if your audio capture does not work correctly 
within MoviePlus. 
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A Guide to Codecs 
If you have made or played an AVI video file in the past, you have—
knowingly or otherwise—used something called a Compressor / 
DECompressor (CODEC). A codec is a solution to a problem; the problem 
being that uncompressed broadcast-quality video is very large as a 
computer file, it occupies 20 Megabytes of data per second—excessive 
for delivery via the Internet and for reasonable hard drive storage. 

The basics 

AVI stands for Audio Video Interleave and it is a common and flexible PC 
video format that has gained wide support on other computing 
platforms, too. AVI files are like containers for any kind of video 
interleaved with any kind of audio, unlike fixed file formats such as those 
used by DVD which only support very strict video/audio specifications. 

If AVI video can be of almost any flavour, how can someone make a 
video in a format that everyone can watch? The answer is that there's no 
truly universal AVI format, anyone who wants to watch an AVI needs to 
have the right codec installed, one that matches or is compatible with 
the codec used to create (compress) the AVI file. No single media player 
has all codecs included with it, as some require licensing fees and new 
codecs are always under development, so additional or new codecs can 
typically be downloaded or purchased. While there is no single universal 
AVI format—except maybe the simple "uncompressed" video format 
mentioned above, which can occupy gigabytes of drive space in a trice—
most PCs have an installed copy of Windows Media Player or an 
equivalent that automatically supports quite a wide range of types of 
video. 
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t . 

Other terminology 

You may encounter some new words in this section, we'll make a brief 
introduction of some technical terms here: 

AVI - has been introduced, a PC-based video file. 

Bitrate - the amount of data per second of video. DVDs are typically 
between 4 and 10 Megabits per second (up to 75MB per minute of 
DVD video), a low-quality and small video for download via the 
Internet may only be a few hundred bits per seconds. 

Codec - we have covered already; a compressor/decompressor, a 
video-squeezing "interpreter". 

DV - "Digital video" both as a generic term for video stored on a 
digital medium and as a specific term describing 720x576 (or 
720x480) DV AVI video captured by DV devices. The DV format was 
developed by a consortium of companies including Sony, Panasonic, 
JVC and Philips for consumer devices. 

MPEG - A compression format developed by the Motion Picture 
Experts Group. MPEG-1 is used for Video CDs, MPEG-2 is used for 
SVCDs and DVDs, MPEG 3 is more commonly known as MP3, and 
MPEG-4 is used for both audio and video compression. 

MPEG-4 - A modern compression format suitable for many AVI files. 

What codec should I use when making my AVIs? 

Your choice of codec should depend very much on what it is you intend 
to do with the video you are creating. If you are aiming to present your 
video on a television, you need to choose a different format when 
compared to presenting the video for download via the Internet. In the 
case of television, you would need a good quality and quite high 
resolution output format, whereas for Internet delivery it would be best 
to focus on the compression to achieve a small file size for speedier 
download. We'll explore some scenarios below. 

Before you expor  your final version..
Some AVI codecs heavily compress the video data, sometimes while 
retaining decent video quality, but such heavy compression takes a fair 
amount of processing power during editing or playback. For this reason it 
is worthwhile choosing a format like DV. DV retains good quality during 
the capture and editing process but creates quite large files, so you 
could consider an alternative choice for your final export and just use DV 
throughout the capture and editing phases of your project. You can write 
DV video back to a DV camera if you wish, also called printing to tape. 
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Video for viewing using a television and DVD player 
Having said that your intended use should define the choice of codec, it's 
important to point out that many videos are still intended for viewing on 
a television, in which case you should be considering a video format that 
is supported by DVD players—MPEG rather than AVI. Some DVD players 
do support a limited number of AVI formats, usually based around 
MPEG-4 video and its derivatives (including DivX®, Xvid, and Microsoft's 
MPEG-4 v1, v2, v3 codecs), but most only play MPEG video in Video CD, 
Super Video CD or DVD formats. For those players that do support it; 
MPEG-4 video and its derivatives are well known for combining good 
quality video with compact file sizes and this format is often referred to 
as the MP3 of the video world. Essentially, if your intent is playing your 
video on a television, MPEG-2 is still the preferred format in the majority 
of cases and is used by digital cable and satellite broadcast companies. 
Once you have created your MPEG-2 video, you would need to author a 
DVD video disc using an appropriate program. 

When sharing video with other Windows-based PC users
In addition to AVI and MPEG video, MoviePlus 4 supports the creation of 
WMV, Windows Media Video. This format is supported by the Windows 
Media Player included on most PCs so this is a suitable format for sharing 
your video with other Windows users, without the worry that they may 
not have the codec required to support your AVI file. Despite the word 
Windows in its name, this format is also supported by some cross-
platform media players such as the free VideoLan Client, so WMV files 
can in fact be played on Windows, Mac OS X, Be OS, and different 
flavours of Linux. 

Creating an AVI file for Internet download 
When choosing a video format for sharing your video with other 
Windows users, bear in mind which method of delivery you will be using. 
If your file is on CD, a common format such as MPEG-1 for small videos 
or even MPEG-2 for full-screen video will be widely supported. When 
creating AVIs and choosing a codec, a high-bitrate DivX or Xvid-encoded 
file will produce a welcome mix of picture quality and file size but not 
quite everyone has a compatible codec installed. For delivery via the 
Internet, a more widespread MPEG-4 codec, such as Microsoft's MPEG-4 
v3, would be recommended and you should also consider creating the 
video at a small size somewhere between 160x120 to a maximum of 
352x288 pixels. Many codecs require that your video's size be divisible 
by a factor of 16, please bear this in mind when sizing your export. 
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A Guide to Interlacing 

An example of a video's technical make up 

When we watch a video on a PC or television, we are usually blissfully 
unaware of the technical specifications of the video we are looking at, we 
can just sit back and enjoy the view. That's how it should be! When you 
are creating and editing movies of your own, you may need a grasp of 
some technical settings, although MoviePlus is geared to make as much 
of the technicality as possible something managed behind-the-scenes, by 
using preset export settings and auto-detection of the specification of 
video sources used in your projects. 

In the case of PCs, the type of video and the video frame rate etc. is all 
normally understood and successfully processed by a media player. For 
digital video recording, TV broadcast, and DVD standards, the video data 
is organized somewhat differently according to differing international 
standards. The player, camera, or television, sometimes in conjunction 
with a set-top box, processes the data to create the picture we see. 

Interlacing... what is it? 

When we look at a piece of video on a PC screen and on a TV, they 
probably look much the same to our eyes; they both appear as a 
rectangular picture. It's therefore pretty straightforward to understand 
how we can usefully describe that picture inside MoviePlus as so many 
pixels wide by so many pixels high. But in the case of TV there's an 
important complication which MoviePlus normally looks after for you—
interlacing. 

We just mentioned how rectangular pictures are made up of row after 
row of pixels. On the PC screen, all of the pixels from each still picture 
from your video are displayed simultaneously, creating a rapid series of 
still pictures which your brain tells you is moving. 

The majority of televisions, on the other hand, display pictures on your 
screen in a slightly different way. When TV systems were first designed, 
there was simply no way to broadcast pictures exactly as captured by 
the cameras—the technology simply wasn't up to it. One of the clever 
tricks they used was to throw away any information that wasn't crucial 
to the eye. That legacy is still with us today, and so rather than carry 25 
or 30 complete pictures per second to your TV screen (depending on 
whether you have PAL or NTSC in your region), they broadcast 50 (or 
60) half-pictures, or fields, per second. 
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Consecutive pairs of fields fit together (or interlace) to make a complete 
picture, because the first field of each pair contains the "pixels" for an 
odd numbered row in the rectangular picture, and the next one contains 
the matching information for the even numbered rows. When displayed 
sequentially, and processed by your eye and brain, you see complete 
moving pictures—even though the amount of information transmitted is 
much reduced. And because of the higher repetition rate, 50 half 
pictures vs. 25 full pictures, the result is relatively flicker free. 

Tricks like that are exactly what the MPEG (and other) compression 
schemes depend on—only naturally after 60 years of development we're 
much, much cleverer at it now. 

If you pause an interlaced video during draft-quality playback in 
MoviePlus, you may notice the visible difference between odd and even 
lines because they come from different frames in your project (normally 
about 0.04 of a second apart). These lines should not be apparent when 
playing DV or DVD interlaced video on a television, or progressive (full 
frame) video on a PC. 

What do I need to do now? 

"Nothing" is the usual answer! If you are using typical video sources and 
are exporting your project to a known standard, you really don't need to 
worry about interlacing settings at all. 

MoviePlus should detect the method of interlacing used in your captured 
video or existing video files, and will "deinterlace" where necessary while 
creating your project. Deinterlacing is the process of making full video 
frames from the correct set of odd or even lines of interlaced video. As 
an aside, a video with full frames, with no odd/even line weaving, is 
called progressive or non-interlaced video. MoviePlus creates 
progressive video frames when required in order to correctly apply 
effects and transitions, and will subsequently split (and remix) the video 
into differing odd and even lines again at export time (if your chosen 
export format requires any interlacing). All of this happens 
automatically, so you don't normally need to do anything! 
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Why do I need to know what interlacing is? 

You only really need to know what interlacing is if you see poor export 
results due to MoviePlus having misdetected your source video's 
interlacing method. You only need to adjust interlacing settings if you 
are working with a video source (an existing video file) for which 
MoviePlus has incorrectly determined the correct interlacing settings. 
This should, in theory, be very rare but may prevent the need to 
recapture digital video, for instance. 

MoviePlus might mistakenly determine the interlacing settings if the 
video file has been created incorrectly in the first place, or if the file is 
somehow wrong in its declaration of which field, odd or even horizontal 
lines, should be displayed first. You can choose, for a selected video file, 
whether MoviePlus should display both fields simultaneously (progressive 
video), to display the upper field first or the lower field first. Experiment 
with these settings in the Properties pane when you have a video source 
selected on the Timeline if your high-quality preview shows some 
unwanted edge-effects where there is motion. 

You can also change the method that MoviePlus uses to "undo" the 
effects of video interlacing, the method used to deinterlace and make 
full-frame progressive video. The deinterlace method setting is available 
via the Advanced... button on the Properties pane when you have a 
video source selected in your Timeline. The available methods of 
deinterlacing are: 

Blend Fields - takes 50% of each field and merges them, often 
resulting in some ghosting or motion blur. This is not often the best 
method to choose as the motion blur isn't often a desired end result; for 
sections of video with no or little subject motion, this produces high-
quality full frames. 

Field Interpolate - discards one set of fields and builds a full image by 
looking closely at the remaining fields, creating a matching set to fill in 
the empty lines (interpolating). Although half the data has been 
discarded, this is the default method for MoviePlus as it normally 
produces good results. 

Field Median - again discards half the video data and in rebuilding the 
missing lines it takes the median (middle) from a range of lines including 
the scan line above (in the same field set), the scan line below (in the 
same field set) and the same scan line (from the alternate field set). This 
method maintains a good deal of horizontal detail but may result in some 
edge-noise where there is motion. 
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Performance Notes 
While MoviePlus has been engineered from the ground up to provide a 
fast working environment, video editing is still a task that demands a 
great deal from a typical computer. The amount of data being moved 
between the system's hard drive, memory, and processor (and back 
again) can be immense, stretching the capabilities of many PCs. At the 
same time the system processor (CPU) has to perform the additional 
task of visual effects processing and composing your edited clips into a 
resulting movie. 

Improving system performance 

If you are experiencing stuttering playback of your video project or 
dropped frames during video capture, there may be some changes you 
can make to MoviePlus or your system to improve your playback or 
video-editing performance. They include but are not limited to: 

Checking the MoviePlus preview quality and size 

 If your preview playback is stuttering, you may wish to reduce the 
quality of the preview to improve performance. Click the Render 
Quality button at the top-right of the Video Preview pane and select a 
lower quality, or do the same via the Preview>Render Quality menu 
flyout. You can also reduce the size of your preview (zoom out) by 
clicking the Zoom Out button or choosing the same option from the 
Preview menu. Your exported movie will not be affected by your 
preview quality. 

If your PC is equipped with multiple graphics cards and you enjoy 
previewing your movie in full-screen view, remember to preview on the 
monitor whose graphics card is of the highest specification. 
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Disabling Anti-Virus on-access scanning/live protection 

Many anti-virus programs offer a live virus-checking service running in 
the background, often called auto-protect, active shield service, or on-
access scanning. This increases the level of security offered by your PC 
as all files being accessed are checked for viruses instead of waiting for a 
full system scan once a week to know you're safe, but this of course 
does slow down disk access for other programs. Temporarily disable 
auto-protect or on-access scanning to improve overall disk performance 
while using MoviePlus, but don't uninstall your security software, don't 
wholly remove it from your PC! It's worth noting that if your system does 
become infected by a virus, trojan horse (a malicious program that often 
offers remote access to your PC), or spyware and malware (malicious 
data-tracking or key-logging programs), your system's performance will 
also be compromised—sometimes severely—and you may also be 
perpetuating the spread of such software to other computer users. It is 
therefore important to use virus and spyware removal software (and a 
security firewall if you are amongst the majority of PC users who connect 
to the Internet). You can obtain freeware security solutions via sites such 
as C|Net's popular Download.com. 

Enabling DMA Mode for improved hard drive performance 

DMA (Direct Memory Access) mode in this context allows hard disks to 
transfer data using less of the system processor's power, typically a 
proportional reduction of 40% in CPU usage with the exact same 
hardware. To enable DMA mode (or check that it is enabled) see 
Microsoft's how-to guide for Windows XP at: 

http://www.microsoft.com/whdc/device/storage/ide-dma.mspx

This details the use of the Device Manager in the System Control Panel. 
For Windows 9x users, the steps to follow are similar but a DMA 
checkbox is available in the disk device's Properties window rather than 
the driver controller's Properties window. 

Disabling write-behind caching 

Write-behind caching is a Windows feature that monitors a number of 
small file edits and rather than writing them in real-time instead stores 
them up and writes them in bulk. Disabling this Windows feature for the 
drive used for video capture may improve capture performance. For 
Windows XP and 2000, write-behind caching is an option on a disk 
drive's device Properties page, accessible via the Device Manager. For 
Windows 9x, it is an option on the Troubleshooting tab of the File 
System Properties dialog (accessible via the System Control 
Panel>Performance tab>Advanced Settings... File System button). 

http://www.microsoft.com/whdc/device/storage/ide-dma.mspx
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Disk defragmentation 

When files are written to your hard drive, they occupy the necessary 
amount of space on the disk and are subsequently caged in to their 
space by newer data. As changes are made to your "caged-in" files, new 
data is written as new file fragments elsewhere on your drive, hence the 
need for a drive to be "defragmented". This defragmentation process 
reunites all a file's segments back into one piece, so the hard drive does 
less work when reading a file, and the "clean space" area of the drive is 
neater and faster to write to. Some "defrag" software will also move 
frequently-modified files to the end of the drive and frequently-accessed 
files to the beginning to improve performance. A defragmented drive or 
dedicated empty drive is preferred for video-editing work. 

You can defragment your drive using a built-in Windows tool, normally 
available in the drive's Properties >Tools tab; right-click a drive in 
Windows Explorer and choose Properties to access this dialog. 

Windows swap file location 

If you are a power user familiar with the Windows swap file or virtual 
memory settings, you may like to consider moving your swap file 
location to a drive other than the one used to store or process your 
video. This may help improve performance when Windows is using your 
virtual memory in complex compositions or exports. 

Optional system changes 

For Windows XP, two standard services can sap a proportion of a 
system's speed. Unfortunately, these services can also be quite useful so 
it is not recommended that you disable them unless you understand the 
consequences. They are System Restore (a service that keeps track of 
system changes and allows you to roll-back your system to a previous 
state) and the Indexing Service (a service that tracks file usage and 
speeds up file searches). Microsoft's System Restore and Indexing 
Service articles may help you better understand these processes and 
how to manage them. 



MoviePlus 4.0 Companion | 170 7. Technical Tips 

 

PC technologies 

While it may not be necessary to upgrade a computer in order to run 
MoviePlus, there are some affordable technologies that you may wish to 
consider in the event of a new PC purchase or upgrade, if your video 
editing warrants the attention. These include: 

A GOOD modern processor 

MoviePlus is programmed to take advantage of the capabilities of 
modern processors. Specifically, MoviePlus is optimised for processors 
with MMX, SSE and SSE2 processor instruction sets. Pentium 4 or 
higher processors from Intel support SSE2, as do AMD Athlon 64 
processors. MoviePlus is also optimised for HyperThreaded processing 
and multiple processors; at the time of writing this, HyperThreading is 
an Intel Pentium 4 feature. It is sometimes the case that budget 
processors, such as Celeron or Duron/Sempron chips, have fewer 
processor features compared to their full-priced counterparts and this 
may be more notable when using an intensive application like MoviePlus. 

To find out if your current processor supports all the modern speed-
enhancing instruction sets including SSE2, use the free CPU-Z tool from 
www.cpuid.com.  

Fast hard drives and RAID Arrays 

There have historically been some expensive hard drives that are sold as 
"AV drives", suitable for high performance audio and video work. They 
have good data throughput speeds so can read and write audio and 
video files efficiently. You can, if you wish, consider a high performance 
drive when you next make a PC purchase, but in modern PCs it is 
possible to achieve better-than-normal hard drive access and data 
throughput speeds with standard hard drives by using what is termed a 
RAID configuration or RAID array (or just RAID). RAID stands for 
Redundant Array of Inexpensive Disks (sometimes Independent rather 
than Inexpensive) and was first introduced in the late 80s as a way to 
use regular hard disks to attain fault tolerance or performance exceeding 
that of a Single Large Expensive Drive (SLED).  

A striped RAID pair—a pair of hard drives working in unison to share 
the load of data throughput—is a favoured method of inexpensively 
improving hard disk performance for data-intensive processes like video 
editing, but unlike other RAID configurations there's no data backup built 
in to this setup. This striped type of RAID configuration is also called 
RAID 0; neither of the drives are actually redundant so this newer 
configuration is outside the original five numbered (RAID 1 to RAID 5) 
types. The striped drives appear to your operating system as a single 
drive with a single drive letter by default, but in reality the data is split 
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by a "RAID controller", half the data being written to each drive 
simultaneously. Striped RAID capability is often a standard feature of 
modern PCs although it is not always enabled or populated with a pair of 
matched hard drives. If not built-in to the system's motherboard, a RAID 
controller can be purchased separately and added to a PC, occupying a 
spare expansion slot. 

Mirrored RAID configurations, properly called RAID 1, also use a 
matched pair of drives and the system also writes data to each drive 
simultaneously, but rather than half the data being on each drive as with 
a striped RAID pair, all data is written to each drive; they are exact 
copies of each other. When it comes to reading that data, both drives 
can work together to transfer the data to the system quicker than if 
there was just one drive performing this task. Mirrored drives offer a 
level of data backup in the event of one of the drives failing, which is 
better than RAID 0, but two drives working together in a mirrored RAID 
1 configuration do not double the capacity, unlike RAID 0. Two 120GB 
drives in RAID 0 (striped) offer 240GB storage with half the data on 
each, two 120GB drives in a RAID 1 configuration (mirrored) offer just 
120GB storage, each drive containing all the data. Both methods of 
using two drives with a RAID controller in place of the usual single drive 
offer faster system performance. 
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